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About this document

The products IBM® WebSphere® Business Integration Server Express and IBM®
WebSphere® Business Integration Server Express Plus are made up of the
following components: InterChange Server Express, the associated Toolset Express,
CollaborationFoundation, and a set of software integration adapters. The tools in
Toolset Express help you to create, modify, and manage business processes. You
can choose from among the prepackaged adapters for your business processes that
span applications. The standard processess template--CollaborationFoundation--
allows you to quickly create customized processes.

The adapter supplies integration connectivity for leading e-business technologies,
enterprise applications, legacy, and mainframe systems. The product set includes
tools and templates for customizing, creating, and managing components for
business process integration.

This document describes the installation, configuration, business object
development, and troubleshooting for the IBM WebSphere Business Integration
Server Express and Express Plus Adapter for Healthcare Data Protocols.

Except where noted, all the information in this guide applies to both IBM
WebSphere Business Integration Server Express and IBM WebSphere Business
Integration Server Express Plus. The term "WebSphere Business Integration Server
Express” and its variants refer to both products.

Audience

This document is for consultants, developers, and system administrators who
support and manage the WebSphere business integration system at customer sites.

Prerequisites for this document

Users of this document should be familiar with

* the WebSphere Business Integration Server Express system
* business object development

* the WebSphere MQ application

¢ the Healthcare data protocols

Related documents

© Copyright IBM Corp. 2004, 2005

The complete set of documentation available with this product describes the
features and components common to all WebSphere Business Integration Server
Express installations, and includes reference material on specific components.

This document contains many references to other documents: the WebSphere
Business Integration Server Express Installation Guide for Windows, for Linux, or for
i5/0S and the System Implementation Guide. If you choose to print this document,
you may want to print these documents as well.

You can download, install, and view the documentation at the following site:

http:/ /www.ibm.com/websphere/wbiserverexpress/infocenter



Typographic conventions

vi

This document uses the following conventions:

courier font

bold
italic, italic
blue text

ProductDir

[]

/i \

%Stext% and $text

Indicates a literal value, such as a command name, filename,
information that you type, or information that the system
prints on the screen.

Indicates a new term the first time that it appears.

Indicates a variable name or a cross-reference.

Blue text, which is visible only when you view the manual
online, indicates a cross-reference hyperlink. Click any blue
text to jump to the object of the reference.

Represents the directory where the IBM WebSphere Business
Integration Server Express and Express Plus adapter product
is installed. The CROSSWORLDS environment variable
contains the ProductDir directory path for Server Express.
The default for Windows is IBM\ WebSphereServer\, the
default for Linux is IBM/WebSphereServer/, and the default
for i5/0S is QIBM/ProdData/WBIServerd4/.

In a syntax line, curly braces surround a set of options from
which you must choose one and only one.

In a syntax line, square brackets surround an optional
parameter.

In a syntax line, ellipses indicate a repetition of the previous
parameter. For example, option[,...] means that you can
enter multiple, comma-separated options.

In a naming convention, angle brackets surround individual
elements of a name to distinguish them from each other, as
in <server_name><connector_name>tmp.10g.

In this document, backslashes (\) are used as the convention
for directory paths. For Linux and i5/0S installations,
substitute slashes (/) for backslashes. All product pathnames
are relative to the directory where the product is installed on
your system.

Text within percent (%) signs indicates the value of the
Windows text system variable or user variable. The
equivalent notation in a Linux environment is $text,
indicating the value of the text Linux environment variable.
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New in this release

New in release 1.1

This is the first release of this guide.
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Chapter 1. Overview

+ [“Connector architecture’]

* [“Application-connector communication method” on page 3|

* |“Event handling” on page 4|

+ [“Guaranteed event delivery” on page §|

* [“Business object requests” on page 8§

* [“Message processing” on page §|

“Error handling” on page 13
g pag

* [“Tracing” on page 13|

The connector for the Healthcare datahandlers, Healthcare Level Seven (HL7) and
National Council for Drug Control programs (NCPDP) message standard, is a
runtime component of the WebSphere Business Integration Server Express Adapter
for Healthcare Data Protocols. Both HL7 and NCPDP message standards refer to
other well-defined standards, such as various ISO and ANSI standards. The
connector allows the integration broke, InterChange Server Express, to exchange
business objects with healthcare-enabled business processes.

Connectors consist of an application-specific component and the connector
framework. The application-specific component contains code tailored to a
particular application. The connector framework, whose code is common to all
connectors, acts as an intermediary between InterChange Server Express and the
application-specific component. The connector framework provides the following
services between InterChange Server Express and the application-specific
component:

* Receives and sends business objects
¢ Manages the exchange of startup and administrative messages

This document contains information about the application-specific component and
connector framework. It refers to both of these components as the connector.

For more information about the relationship of the integration broker to the
connector, see the System Administration Guide or the System Implementation Guide.

All WebSphere Business Integration Server Express integration adapters operate
with the integration broker, InterChange Server Express.

The connector for the healthcare data protocol allows InterChange Server Express
to exchange business objects with applications that send or receive data in the form
of HL7/NCPDP messages.

Connector architecture

The connector allows WebSphere business processes to asynchronously exchange
business objects with applications that issue or receive healthcare (HL7/NCPDP)
data protocol messages when changes to data occur.

As shown in |[Figure 1} the connector interacts with several components whose

collective purpose is to bridge the world of WebSphere business objects with that
of healthcare messages.

© Copyright IBM Corp. 2004, 2005 1



IBM WebSphere Integration
Broker (Processes)

Connector for

Healthcare
Data Handler

/ Healthcare
(HL7/NCPDP)

outgoing ‘( incoming
messages messages
MQSeries Output Queue | MQSeries Input Queue

e

MQ Channels

Figure 1. Healthcare data handler architecture

The healthcare environment is made up of various components that are described
below.

Connector for Healthcare

The connector for healthcare is metadata-driven. Message routing and format
conversion are initiated by an event polling technique. The connector retrieves
WebSphere MQ messages from queues, calls the healthcare data handler to convert
messages to their corresponding business objects, and then delivers the objects to
the corresponding business processes. In the opposite direction, the connector
receives business objects from the integration broker, InterChange Server Express,
converts them into healthcare messages using the same data handler, and then
delivers the messages to an WebSphere MQ queue.

The type of business object and verb used in processing a message are based on
the metadata in the Format field of the WebSphere MQ message header. You
construct a meta-object to store the business object name and verb to associate with
the WebSphere MQ message header Format field text.

You can optionally construct a dynamic meta-object that is added as a child to the
business object passed to the connector. The child meta-object values override
those specified in the static meta-object that is specified for the connector as a
whole. If the child meta-object is not defined or does not define a required
conversion property, the connector, by default, examines the static meta-object for

2 Adapter for Healthcare Data Protocols User Guide



the value. You can specify one or more dynamic child meta-objects instead of, or to
supplement, a single static connector meta-object.

The connector can poll multiple input queues, polling each in a round-robin
manner and retrieving a configurable number of messages from each queue. For
each message retrieved during polling, the connector adds a dynamic child
meta-object (if specified in the business object). The child meta-object values can
direct the connector to populate attributes with the format of the message as well
as with the name of the input queue from which the message was retrieved.

When a message is retrieved from the input queue, the connector looks up the
business object name associated with the FORMAT text field. The message, along
with the business object name, is then passed to the data handler. If a business
object is successfully populated with message content, the connector checks to see
if it a collaboration subscribes to it, and then delivers it to the integration broker
using the gotApplEvents() method.

Healthcare data handler

The connector calls the heathcare data handler to convert business objects into
HL7/NCPDP messages and vice versa.

WebSphere MQ

The connector for the Healthcare data handler uses an MQ implementation of the
JavaTM Message Service (JMS), an API for accessing enterprise-messaging systems.
This makes possible interaction with incoming and outgoing WebSphere MQ event
queues.

MQ channels

The WebSphere MQ event queues exchange messages with the WebSphere MQ
Interface. The software integrates WebSphere MQ messaging capabilities with
HL7/NCPDP message types, performing delivery, acknowledgement, queue
management, timestamping, and other functions.

Application-connector communication method

The connector makes use of IBM’s WebSphere MQ implementation of the Java
Message Service (JMS). The JMS is an open-standard API for accessing
enterprise-messaging systems. It is designed to allow business applications to
asynchronously send and receive business data and events.

Message request
illustrates a message request communication.

1. The connector framework receives a business object representing an healthcare
message from the integration broker.

2. The connector passes the business object to the data handler.

3. The data handler converts the healthcare business object into an
HL7/NCPDP-compliant message.

4. The connector dispatches the HL7/NCPDP-compliant message to the
WebSphere MQ output queue.

5. The JMS layer makes the appropriate calls to open a queue session and routes
the message to the MQ Series input queue.

Chapter 1. Overview 3



In-progress queue
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Healthcare
Business
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Connector
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2 HL7/NCPDP
message

Healthcare 3
data handler

Figure 2. Application-connector communication method: Message request

Event delivery

illustrates the message return communication.

1. The polling method retrieves the next applicable message from the WebSphere
MQ input queue.

2. The data handler converts the message into a business object.

3. The HL7 data handler receives the business object and sets the verb in it to the
default verb specified in the data handler-specific meta-object.

4. The connector then determines whether the business object is subscribed to by
the integration broker. If so, the connector framework delivers the business
object to the integration broker, and the message is removed from the
in-progress queue.

Event handling

For event notification, the connector detects an event written to a queue by an
application, rather than by a database trigger, when messages are stored in the
WebSphere MQ queue.

Retrieval

The connector uses a polling method to poll the WebSphere MQ input queue at
regular intervals for messages. When the connector finds a message, it retrieves it
from the WebSphere MQ input queue and examines it to determine its format. If
the format has been defined in the connector’s static or child meta-objects, the
connector uses the data handler to generate an appropriate business object with a
verb.

4 Adapter for Healthcare Data Protocols User Guide



In-progress queue

The connector processes messages by first opening a transactional session to the
WebSphere MQ queue. This transactional approach allows for a small chance that a
business object could be delivered to a business process twice due to the connector
successfully submitting the business object but failing to commit the transaction in
the queue. To avoid this problem, the connector moves all messages to an
in-progress queue. There, the message is held until processing is complete. If the
connector shuts down unexpectedly during processing, the message remains in the
in-progress queue instead of being reinstated to the original WebSphere MQ queue.

Note: Transactional sessions with a JMS service provider require that every
requested action on a queue be performed and committed before events are
removed from the queue. Accordingly, when the connector retrieves a
message from the queue, it does not commit to the retrieval until: 1) The
message has been converted to a business object; 2) the business object is
delivered to the integration broker, and 3) a return value is received.

Synchronous acknowledgment

To support applications that require feedback on the requests they issue, the
connector for healthcare can issue report messages to the applications detailing the
outcome of their requests once they have been processed.

To achieve this, the connector posts the business data for such requests
synchronously to the integration broker. If the business object is successfully
processed, the connector sends a report back to the requesting application
including the return code from the integration broker and any business object
changes. If the connector or the integration broker fails to process the business
object, the connector sends a report containing the appropriate error code and error
message.

In either case, an application that sends a request to the connector for Healthcare is
notified of its outcome.

If the connector for healthcare receives any messages requesting positive or
negative acknowledgment reports (PAN or NAN), it posts the content of the
message synchronously to the integration broker and then incorporates the return
code and modified business data in to a report message that is sent back to the
requesting application.

shows the required structure of messages sent to the connector to be
processed synchronously.

Table 1. Required structure of synchronous WebSphere MQ messages

MQMD Field (message Supported values (multiple values
descriptor) Description should be OR’d)
MessageType Message type DATAGRAM

Chapter 1. Overview 5



Table 1. Required structure of synchronous WebSphere MQ messages (continued)

MQMD Field (message Supported values (multiple values
descriptor) Description should be OR’d)
Report Options for You can specify one or both of the
report message following:
requested * MQRO_PAN The connector sends a report

message if the business object can be
successfully processed.

* MQRO_NANThe connector sends a report
message if an error occurred while
processing the business object.

You can specify one of the following to
control how the correlation ID of the
report message is to be set:

+ MQRO_COPY_MSG_ID_TO_CORREL IDThe
connector copies the message ID of the
request message to the correlation ID of
the report. This is the default action.

e MQRO_PASS _CORREL_IDThe connector
copies the correlation ID of the request
message to the correlation ID of the

report.
ReplyToQueue Name of reply The name of the queue to which the
queue report message should be sent.
ReplyToQueueManager Name of queue The name of the queue manager to which
manager the report message should be sent.
Message Body A serialized business object in a format

compatible with the data handler
configured for the connector.

Upon receipt of a message as described in [Table 1f the connector:

1. Reconstructs the business object in the message body using the configured data
handler.

2. Looks up the business process specified for the business object and verb in the
static metadata object.

3. Posts the business object synchronously to the specified process.

4. Generates a report encapsulating the result of the processing and any business
object changes or error messages.

5. Sends the report to the queue specified in the replyToQueue and
replyToQueueManager fields of the request.

shows the structure of the report that is sent to the requesting application
from the connector.

Table 2. Structure of the report returned to the requesting application

Supported values (multiple values should
MQMD field Description be OR’d)

MessageType Message type REPORT

6 Adapter for Healthcare Data Protocols User Guide



Table 2. Structure of the report returned to the requesting application (continued)

Supported values (multiple values should
MQMD field Description be OR’d)

feedback Type of report One of the following:

* MQRO_PAN If the business object is
successfully processed.

* MQRO_NANIf the connector or the
integration broker encountered an error
while processing the request.

Message Body If the business object is successfully
processed, the connector populates the
message body with the business object
returned by the integration broker. This
default behavior can be overridden by
setting the DoNotReportBusObj property to
true in the static metadata object.

If the request could not be processed, the
connector populates the message body
with the error message generated by the
connector or the integration broker.

Recovery

Upon initialization, the connector checks the in-progress queue for messages that
have not been completely processed, presumably due to a connector shutdown.
The connector configuration property InDoubtEvents allows you to specify one of
four options for handling recovery of such messages: fail on startup, reprocess,
ignore, or log error.

Fail on startup

With the fail on startup option, if the connector finds messages in the in-progress
queue during initialization, it logs an error and immediately shuts down. It is the
responsibility of the user or system administrator to examine the message and take
appropriate action, either to delete these messages entirely or move them to a
different queue.

Reprocess

With the reprocessing option, if the connector finds any messages in the
in-progress queue during initialization, it processes these messages first during
subsequent polls. When all messages in the in-progress queue have been
processed, the connector begins processing messages from the input queue.

Ignore
With the ignore option, if the connector finds any messages in the in-progress
queue during initialization, the connector ignores them but does not shut down.

Log error
With the log error option, if the connector finds any messages in the in-progress
queue during initialization, it logs an error but does not shut down.

Archiving

If the connector property ArchiveQueue is specified and identifies a valid queue,
the connector places copies of all successfully processed messages in the archive
queue. If ArchiveQueue is undefined, messages are discarded after processing.

Chapter 1. Overview 7



Guaranteed event delivery

The guaranteed-event-delivery feature enables the connector framework to ensure
that events are never lost and never sent twice between the connector’s event
store, the JMS event store, and the destination’s JMS queue. To become
JMS-enabled, you must configure the connectorDeliveryTransport standard
property to JMS. Thus configured, the connector uses the JMS transport and all
subsequent communication between the connector and the integration broker
occurs through this transport. The JMS transport ensures that the messages are
eventually delivered to their destination. Its role is to ensure that once a
transactional queue session starts, the messages are cached there until a commit is
issued; if a failure occurs or a rollback is issued, the messages are discarded.

Note: Without use of the guaranteed-event-delivery feature, a small window of
possible failure exists between the time that the connector publishes an
event (when the connector calls the gotApplEvent() method within its
pollForEvents() method) and the time it updates the event store by deleting
the event record (or perhaps updating it with an “event posted” status). If a
failure occurs in this window, the event has been sent but its event record
remains in the event store with an “in progress” status. When the connector
restarts, it finds this event record still in the event store and sends it,
resulting in the event being sent twice.

You can configure the guaranteed-event-delivery feature for a JMS-enabled
connector with, or without, a JMS event store. To configure the connector for
guaranteed event delivery, see [“Enabling guaranteed event delivery” on page 23]

If connector framework cannot deliver the business object to the integration broker,
the object is placed on a FaultQueue (instead of UnsubscribedQueue and
ErrorQueue) and generates a status indicator and a description of the problem.
FaultQueue messages are written in MQRFH?2 format.

Business object requests

Business object requests are processed when the integration broker issues a
business object. Using the healthcare data handler, and depending on the
requirements specified in the subscription meta-object, the connector can transform
HL7 and NCPDP objects before issuing them.

Message processing

The connector processes business objects passed to it by the integration broker
based on the verb for each business object. The connector uses business object
handlers to process the business objects that the connector supports.The business
object handlers contain methods that interact with an application and that
transform business object requests into application operations.

The connector supports the following business object verbs:
* Create
* Retrieve

Create

Processing of business objects with create depends on whether the objects are
issued asynchronously or synchronously.

8 Adapter for Healthcare Data Protocols User Guide



Asynchronous delivery

This is the default delivery mode for business objects with Create verbs. A message
is created from the business object using a data handler and then written to the
output queue. If the message is delivered, the connector returns BON_SUCCESS,
else BON_FAIL.

Note: The connector has no way of verifying whether the message is received or if
action has been taken.

Synchronous acknowledgment

If a replyToQueue has been defined in the connector properties and a
responseTimeout exists in the conversion properties for the business object, the
connector issues a request in synchronous mode. The connector then waits for a
response to verify that appropriate action was taken by the receiving application.

For WebSphere MQ, the connector initially issues a message with a header as
shown in [Table 3l

Table 3. Request Message Descriptor Header (MQMD)

Field

Format

MessageType
Report

ReplyToQueue

Persistence
Expiry

Description Value

Format name Output format as defined in the conversion properties and
truncated to 8 characters to meet IBM requirements (example:
MQSTR).

Message type MQMT_DATAGRAM®

Options for report message When a response message is expected, this field is populated as
requested. follows:

MQRO_PAN® to indicate that a positive-action report is required if
processing is successful.

MQRO_NAN® to indicate that a negative-action report is required if
processing fails.

MQRO_COPY_MSG_ID TO CORREL_ID® to indicate that the correlation
ID of the report generated should equal the message ID of the
request originally issued.

Name of reply queue When a response message is expected, this field is populated
with the value of connector property ReplyToQueue.

Message persistence MQPER_PERSISTENT?

Message lifetime MQEI_UNLIMITED*

@ Indicates constant defined by IBM.

The message header described in[Table 3|is followed by the message body. The
message body is a business object that has been serialized using the data handler.

The Report field is set to indicate that both positive and negative action reports are
expected from the receiving application. The thread that issued the message waits
for a response message that indicates whether the receiving application was able to
process the request.

When an application receives a synchronous request from the connector, it
processes the business object and issues a report message as described in
[Table 5| and [Table 6|

Chapter 1. Overview 9



Table 4. Response Message Descriptor Header (MQMD)

Field Description Value
Format Format name Input format of busObj as defined in the conversion properties.
MessageType Message type MQMT_REPORT®

@ Indicates constant defined by IBM.

Table 5. Population of response message

Verb Feedback field Message body
Create SUCCESS VALCHANGE (Optional) A serialized business object reflecting
changes.
VALDUPES FAIL (Optional) An error message.

Table 6. Feedback codes and response values

Equivalent WebSphere business integration system

WebSphere MQ feedback code response”

MQFB_PAN or MQFB_APPL_FIRST SUCCESS

MQFB_NAN or MQFB_APPL FIRST + 1 FAIL

MQFB_APPL_FIRST + 2 VALCHANGE

MQFB_APPL_FIRST + 3 VALDUPES

MQFB_APPL_FIRST + 4 MULTIPLE_HITS

MQFB_APPL_FIRST + 5 Not applicable

MQFB_APPL_FIRST + 6 Not applicable

MQFB_APPL_FIRST + 7 UNABLE_TO_LOGIN

MQFB_APPL_FIRST + 8 APP_RESPONSE_TIMEOUT (results in immediate

termination of connector)

MQFB_NONE What the connector receives if no feedback code is
specified in the response message

@ See the connector development guide for details.

If the business object can be processed, the application creates a report message
with the feedback field set to MQFB_PAN (or a specific WebSphere business
integration system value). Optionally the application populates the message body
with a serialized business object containing any changes. If the business object
cannot be processed, the application creates a report message with the feedback
field set to MQFB_NAN (or a specific WebSphere business integration system value)
and then optionally includes an error message in the message body. In either case,
the application sets the correlationID field of the message to the messagelD of the
connector message and issues it to the queue specified by the ReplyTo field.

Upon retrieval of a response message, the connector by default matches the
correlationID of the response to the messageID of a request message. The
connector then notifies the thread that issued the request. Depending on the
feedback field of the response, the connector either expects a business object or an
error message in the message body. If a business object was expected but the
message body is not populated, the connector simply returns the same business
object that was originally issued by the integration broker for the Request
operation. If an error message was expected but the message body is not
populated, a generic error message is returned to the integration broker along with
the response code. However, you can also use a message selector to identify, filter
and otherwise control how the adapter identifies the response message for a given
request. This message selector capability is a JMS feature. It applies to synchronous
request processing only and is described below.

10 Adapter for Healthcare Data Protocols User Guide



Filtering response messages using a message selector: Upon receiving a business
object for synchronous request processing, the connector checks for the presence of
a response_selector string in the application-specific information of the verb. If
the response_selector is undefined, the connector identifies response messages
using the correlation ID as described above.

If response_selector is defined, the connector expects a name-value pair with the
following syntax:

response_selector=JMSCorrelationID LIKE ’selectorstring’

The message selectorstring must uniquely identify a response and its values be
enclosed in single quotes as shown in the example below:

response_selector=JMSCorrelationID LIKE 'Oshkosh'

In the above example, after issuing the request message, the adapter would
monitor the ReplyToQueue for a response message with a correlationID equal to
"Oshkosh.” The adapter would retrieve the first message that matches this message
selector and then dispatch it as the response.

Optionally, the adapter performs run-time substitutions enabling you to generate
unique message selectors for each request. Instead of a message selector, you
specify a placeholder in the form of an integer surrounded by curly braces, for
example: ' {1}"'. You then follow with a colon and a list of comma-separated
attributes to use for the substitution. The integer in the placeholder acts as an
index to the attribute to use for the substitution. For example, the following
message selector:

response_selector=JMSCorrelationID LIKE '{1}': MyDynamicMO.CorrelationID

would inform the adapter to replace {1} with the value of the first attribute
following the selector (in this case the attribute named Correlationld of the
child-object named MyDynamicMO. If attribute CorrelationID had a value of 123ABC,
the adapter would generate and use a message selector created with the following
criteria:

JMSCorrelation LIKE '123ABC'
to identify the response message.
You can also specify multiple substitutions such as the following:

response_selector=Primaryld LIKE '{1}' AND AddressId LIKE '{2}'
PrimaryId, Address[4].AddressId

In this example, the adapter would substitute {1} with the value of attribute
PrimaryId from the top-level business object and {2} with the value of AddressId
from the 5th position of child container object Address. With this approach, you
can reference any attribute in the business object and meta-object in the response
message selector. For more information on how deep retrieval is performed using
Address[4] .AddressId, see JCDK API manual (getAttribute method)

An error is reported at run-time when any of the following occurs:
* If you specify a non-integer value between the '{}' symbols

Chapter 1. Overview 11



* If you specify an index for which no attribute is defined
* If the attribute specified does not exist in the business or meta-object
e If the syntax of the attribute path is incorrect

For example, if you include the literal value "{" or ’} in the message selector, you
can use '{{" or "{}" respectively. You can also place these characters in the attribute
value, in which case the first "{" is not needed. Consider the following example
using the escape character: response_selector=JMSCorrelation LIKE '{1}' and
CompanyName="A{{P': MyDynamicMO.CorrelationID

The connector would resolve this message selector as follows:

JMSCorrelationID LIKE '123ABC' and CompanyName='A{P'
When the connector encounters special characters such as "{’, ’}’, " or ’;’ in
attribute values, they are inserted directly into the query string. This allows you to
include special characters in a query string that also serve as application-specific
information delimiters.

The next example illustrates how a literal string substitution is extracted from the
attribute value:

response_selector=JMSCorrelation LIKE '{1}' and CompanyName='A{{P':
MyDynamicMO.CorrelationID

If MyDynamicM0.CorrelationID contained the value {A:B}C;D, the connector would
resolve the message selector as follows: JMSCorrelationID LIKE '{A:B}C;D' and
CompanyName="A{P'

For more information on the response selector code, see JMS 1.0.1 specifications.

Creating custom feedback codes: You can extend the WebSphere MQ feedback
codes to override default interpretations shown in by specifying the
connector property FeedbackCodeMappingMO. This property allows you to create
a meta-object in which all WebSphere business integration system-specific return
status values are mapped to the WebSphere MQ feedback codes. The return status
assigned (using the meta-object) to a feedback code is passed to the integration
broker. For more information, see [“FeedbackCodeMappingMO” on page 20}

Retrieve

Business objects with the Retrieve verb support synchronous delivery only. The
connector processes business objects with this verb as it does for the synchronous
delivery defined for create. However, when using a Retrieve verb, the
responseTimeout and replyToQueue are required. Furthermore, the message body
must be populated with a serialized business object to complete the transaction.

shows the response messages for these verbs.

Table 7. Population of response message

Verb Feedback field Message body

Retrieve FAIL (Optional) An error message.
FAIL_RETRIEVE_BY_CONTENT
MULTIPLE_HITS SUCCESS A serialized business object.
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Error handling

All error messages generated by the connector are stored in a message file named
BIA_HealthcareConnector.txt. (The name of the file is determined by the
LogFileName standard connector configuration property.) Each error has an error
number followed by the error message:

Message number

Message text

The connector handles specific errors as described in the following sections.

Application timeout

The error message ABON_APPRESPONSETIMEOUT is returned when:

¢ The connector cannot establish a connection to the JMS service provider during
message retrieval.

¢ The connector successfully converts a business object to a message but cannot
deliver it to the outgoing queue due to connection loss.

* The connector issues a message but times out waiting for a response from a
business object whose conversion property TimeoutFatal is equal to True.

* The connector receives a response message with a return code equal to
APP_RESPONSE_TIMEOUT or UNABLE_TO_LOGIN.

Unsubscribed business object

The connector delivers a message to the queue specified by the UnsubscribedQueue

property if:

¢ The connector retrieves a message that is associated with an unsubscribed
business object.

* The connector retrieves a message but cannot associate the text in the Format
field with a business object name.

Note: If the UnsubscribedQueue is not defined, unsubscribed messages are
discarded.

Data handler conversion

If the data handler fails to convert a message to a business object, or if a
processing error occurs that is specific to the business object (as opposed to the
JMS provider), the message is delivered to the queue specified by ErrorQueue. If
ErrorQueue is not defined, messages that cannot be processed due to errors are
discarded.

If the data handler fails to convert a business object to a message, BON_FAIL is
returned.

Tracing

Tracing is an optional debugging feature you can turn on to closely follow
connector behavior. Trace messages, by default, are written to STDOUT. See the
connector configuration properties in [Chapter 2, “Configuring the connector,” on|

page 15, for more on configuring trace messages. For more information on tracing,

including how to enable and set it, see the Connector Development Guide.
What follows is recommended content for connector trace messages.
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Level 0

Level 1

Level 2

Level 3

Level 4

Level 5

This level is used for trace messages that identify the connector
version.

Use this level for trace messages that provide key information on
each business object processed or record each time a polling thread
detects a new message in an input queue.

Use this level for trace messages that log each time a business
object is posted to the integration broker, either from
gotApplEvent () or executeCollaboration().

Use this level for trace messages that provide information
regarding message-to-business-object and business-object-to-
message conversions or provide information about the delivery of
the message to the output queue.

Use this level for trace messages that identify when the connector
enters or exits a function.

Use this level for trace messages that indicate connector
initialization, represent statements executed in the application,
indicate whenever a message is taken off of or put onto a queue,
or record business object dumps.
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Chapter 2. Configuring the connector
.

[‘Installed file structures” on page 16|

* [“Connector configuration” on page 17

[“Enabling guaranteed event delivery” on page 23|

[“Meta-object attributes configuration” on page 27|

[“Startup file configuration” on page 42|

[‘Starting the connector” on page 45|

* |“Stopping the connector” on page 46|

This chapter describes how to install and configure the connector and how to
configure the message queues to work with the connector.

Compatibility

The adapter framework that an adapter uses must be compatible with the version
of the integration broker with which the adapter is communicating. Version 1.1 of
the Adapter for Healthcare Data Protocols is supported on the following adapter
framework and integration broker:

* Adapter framework: WebSphere Business Integration Adapter Framework,
versions 2.1, 2.2, 2.3.x, 2.4., and 2.6

* Integration broker:
— InterChange Server Express

See the Release Notes for any exceptions.
Note: For instructions on installing the integration broker and its prerequisites, see

the WebSphere Business Integration Server Express Installation Guide for Linux,
for Windows, or for i5/0S.

Prerequisites

Prerequisite software

The following software must be installed before installing and configuring the
Adapter for Healthcare Data Protocols:

— All operating system environments require the Java compiler (IBM JDK 1.4.2
for Windows 2003) for compiling custom adapters

— Linux:
Red Hat Linux AS 3.0 Update 1, Intel (IA32)
SuSE Linux 8.1, ES, SP3, Intel (IA32)
SuSE Linux ES 9.0, Intel (IA32)

Note: The TMTP (Tivoli Monitoring for Transaction Performance) component
of the WebSphere Business Integration Adapter FrameworkV2.6 is not
supported on Linux Red Hat.

- Windows:
Windows XP with Service Pack 1A, for WebSphere Business Integration
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Adapter Framework (administrative tools only)
Windows 2003 (Standard Edition or Enterprise Edition)

— 0OS/400 V5R2 and i5/0S V5R3:

i5/0S refers to OS/400 and i5/0S unless explictly stated.

Installing the adapter and related files

For information on installing WebSphere Business Integration Server Express
adapter products, refer to the WebSphere Business Integration Server Express
installation guide for Windows, for Linux, or for i5/0S. The guide is located in the
WebSphere Business Integration Server Express Adapters Infocenter at the
following site: http:/ /www.ibm.com/websphere/wbiserverexpress/infocenter.

Installed file structures

The following subsections describe the file stuctures used by the connector on a

Windows, Linux, and i5/0S system.

Installed Windows File Structure

The table below describes the file structure used by the connector as installed in a

Windows machine.

Table 8. Files installed with the connector - Windows

Directory

Installed files

ProductDir\bin\Data\ App

Healthcare_HL7_ConnectorTemplate and
Healthcare_NCPDP_ConnectorTemplate - The
connector’s configuration file templates

ProductDir\connectors\Healthcare

BIA_CWHealthcare jar--The main connector code
BIA_CWHealthcareDatahandlerjar - the
datahandler code for healthcare
start_Healthcare.bat--The connector startup batch
file

start_Healthcare_service.bat

ProductDir\connectors\messages
\BIA_Healthcareconnector.txt

BIA_healthcareConnector.txt—The connector
message file, containing error messages and codes

ProductDir\connectors\healthcare
\start_healthcare_service.bat

The startup script for the connector service.

ProductDir\connectors\Healthcare
\dependencies\hl7\BIA_HL7I18N.cfg
ProductDir\connectors\Healthcare
\dependencies\hl7\BIA_HL7MTEventMap.cfg

The healthcare configuration files.

Installed Linux File Structure

The table below describes the file structure used by the connector as installed on a

Linux machine.

Table 9. Files installed with the connector - Linux

Directory

Installed files

ProductDir/bin/Data/App

Healthcare_HL7_ConnectorTemplate and
Healthcare_NCPDP_ConnectorTemplate--The
connector’s configuration file templates

ProductDir /connectors/Healthcare

BIA_CWHealthcare jar--The main connector code
BIA_CWHealthcareDataHandler.jar
start_Healthcare.sh--The connector startup shell
file
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Table 9. Files installed with the connector - Linux (continued)

Directory Installed files

ProductDir/connectors/messages BIA_HealthcareConnector.txt—The connector
/BIA_HealthcareConnector.txt message file, containing error messages and codes
ProductDir/connectors/Healthcare Configuration file

/dependencies/h17/BIA_HL7MTEventMap.cfg

ProductDir/connectors/Healthcare Configuration file
/dependencies/h17/BIA HL7118N.cfg

ProductDir/connectors/Healthcare/ The Healthcare data handler
BIA_CWHealthcareDataHandler.jar

Installed i5/0S File Structure

The table below describes the file structure used by the connector as installed on
an i5/0OS machine.

Table 10. Files installed with the connector - i5/0S

Directory Installed files

ProductDir/connectors/Healthcare BIA_CWHealthcare jar--The main connector code
start_healthcare.sh--The connector startup shell file

ProductDir /connectors/messages BIA_healthcareConnector.txt—The connector

/BIA_HealthcareConnector.txt message file, containing error messages and codes

ProductDir/repository/Healthcare Configuration file

/dependencies/BIA_HL7MTEventMap.cfg

ProductDir/connectors/Healthcare/ Configuration file
dependencies/h17/BIA_HL7I18N.cfg/

ProductDir/connectors/Healthcare/ The Healthcare data handler
BIA_CWHealthcareDataHandler.jar

Connector configuration

Connectors have two types of configuration properties: standard configuration
properties and connector-specific configuration properties. You must set the values
of these properties before running the connector. Use one of the following tools to
set a connector’s configuration properties:

* Connector Configurator Express—Access to this tool is from the System
Manager.

Standard connector properties

Standard configuration properties provide information that all connectors use. See
[Appendix A, “Standard configuration properties for connectors,” on page 83| for
documentation of these properties.

Connector-specific properties

Connector-specific configuration properties provide information needed by the
connector at runtime. Connector-specific properties also provide a way of changing
static information or logic within the connector without having to recode and
rebuild the agent.

Note: Always check the values WebSphere MQ provides because they may be

incorrect or unknown. If the provided values are incorrect, specify them
explicitly.
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able 11| lists the connector-specific configuration properties for the connector for
heathcare. See the sections that follow for explanations of the properties.

Table 11. Connector-specific configuration properties

Name Possible values Default value Required
“ ApplicationPassword” on page| Login password No
19
“ApplicationUserID” on page 19| Login user ID No
“ ArchiveQueue” on page 19| Queue to which copies of queue://Crosshorlds. No

successfully processed messages are  QueueManager/MQCONN.

sent
“BOPref” on page 19| Business object preference HL7 Yes
“Channel” on page 19| MQ server connector channel Yes
“ClassName” on page 20) Data handler class name com.ibm.adapters. No

datahandlers.hl17.
HL7DataHandler

“ConfigurationMetaObject” on|  Name of configuration meta-object Yes
page 20|
“Component delimiter” on page| User defined A
D
“DataHandlerConfigMO” on| Data handler meta-object MO_DataHandler  Default Yes
page 20|
“DataHandlerMimeType” on| MIME type of file HL7 No
page 20|
“DefaultVerb” on page 20| Any verb supported by the Create

connector.
“Dummy string” on page 20 User defined
“ErrorQueue” on page 20| Queue for unprocessed messages queue://crossworlds. No

Queue.manager/
MQCONN.ERROR

[“Field delimiter” on page 21| Default field delimiter for all The default value is " 1"
types.
“HostName” on page 21| WebSphere MQ server The default is "1". No
“InDoubtEvents” on page 21| FailOnStartup Reprocess Ignore Reprocess No
LogError
[“InputQueue” on page 21| Poll queues queue://CrossWorlds. Yes
QueueManager/MQCONN. IN
[‘InProgressQueue” on page 22|  In-progress event queue queue://Crosshorlds. No
QueueManager/
MQCONN. IN_PROGRESS
[“PollQuantity” on page 22| Number of messages to retrieve from 1 No

each queue specified in the
InputQueue property

[“Port” on page 22| Port established for the WebSphere No
MQ listener

[“ReplyToQueue” on page 22| Queue to which response messages  queue://Crosshorlds. No
are delivered when the connector QueueManager/
issues requests MQCONN.REPLYTO
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Table 11. Connector-specific configuration properties (continued)

Name Possible values Default value Required
[“Representation” on page 23| Header or message object parsing. Can be one of the
following:"Simplified” or
"Native”
Simplified signifies the use of a
parsing method which
provides fine object represent
only to message headers.
Native signifies the use of
parsing method, which
provides fine object represent
to the whole message.
“Repetition delimiter” on page| User defined The default value is "~"
D
“Subcomponent delimiter” on|  User defined The default value is "&"
page 23
“UnsubscribedQueue” on page] Queue to which unsubscribed queue://Crosshorlds. No
23] messages are sent QueueManager/
MQCONN . UNSUBSCRIBE
[“UseDefaults” on page 23] true or false false

ApplicationPassword
Password used with the ApplicationUserID to log in to WebSphere MQ.

Default = None.

If the ApplicationPassword is left blank or removed, the connector uses the default
password provided by WebSphere MQ.

ApplicationUserID
User ID used with the ApplicationPassword to log in to WebSphere MQ.

Default=None.

If the ApplicationUserlID is left blank or removed, the connector uses the default
user ID provided by WebSphere MQ.

ArchiveQueue
Queue to which copies of successfully processed messages are sent.

Default = queue://crossworlds.Queue.manager/MQCONN.ARCHIVE

BOPref

Business object preferences prefix. The default is HL7.

Channel

MQ server connector channel through which the connector communicates with
WebSphere MQ.

Default=None.

If the value of Channel is left blank or the property is removed, the connector uses
the default server channel provided by WebSphere MQ.
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ClassName
Data handler class to use when converting messages to and from business objects.

Default = com.ibm.adapters.DataHandlers.h17.HL7DataHandler

Component delimiter
The default component delimiter for all flights. The default is "/".

ConfigurationMetaObject

Name of static meta-object containing configuration information for the connector.

Default = none.

DataHandlerConfigMO

Meta-object passed to data handler to provide configuration information.

Default = M0_DataHandler Default

DataHandlerMimeType
Allows you to request a data handler based on a particular MIME type.

Default = HL7
DefaultVerb

Specifies the verb to be set within an incoming business object, if it has not been
set by the data handler during polling.

Default= Create

Dummy string
The dummy string.

ErrorQueue
Queue to which messages that could not be processed are sent.

Default = queue://crossworlds.Queue.manager/MQCONN.ERROR
FeedbackCodeMappingMO

Allows you to override and reassign the default feedback codes used to
synchronously acknowledge receipt of messages to the integration broker. This
property enables you to specify a meta-object in which each attribute name is
understood to represent a feedback code. The corresponding value of the feedback
code is the return status that is passed to the integration broker. For a listing of the
default feedback codes, see |[’Synchronous acknowledgment” on page 5/ The
connector accepts the following attribute values representing WebSphere
MQ-specific feedback codes:

* MQFB_APPL_FIRST

* MQFB_APPL_FIRST_OFFSET_N where N is an integer (interpreted as the value of
MQFB_APPL_FIRST + N)

The connector accepts the following WebSphere business integration
system-specific status codes as attribute values in the meta-object:

* SUCCESS
* FAIL
* APP_RESPONSE_TIMEOUT
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MULTIPLE_HITS

* UNABLE_TO_LOGIN
VALCHANGE
VALDUPES

able 12| shows a sample meta-object.
P ]

Table 12. Sample feedback code meta-object attributes

Attribute Name Default Value
MQFB_APPL_FIRST SUCCESS
MQFB_APPL_FIRST + 1 FAIL
MQFB_APPL_FIRST + 2 UNABLE_TO_LOGIN

Default = none.

Field delimiter
The default delimiter for all types. The default is "|" the pipe symbol.

HostName
The name of the server hosting WebSphere MQ.

Default=None.

If the HostName is left blank or removed, the connector allows WebSphere MQ to
determine the host.

InDoubtEvents

Specifies how to handle in-progress events that are not fully processed due to
unexpected connector shutdown. Choose one of four actions to take if events are
found in the in-progress queue during initialization:

» FailOnStartup. Log an error and immediately shut down.

* Reprocess. Process the remaining events first, then process messages in the
input queue.

* Ignore. Disregard any messages in the in-progress queue.

* LogError. Log an error but do not shut down.

Default = Reprocess.

InputQueue
Specifies the message queues that the connector polls for new messages. See the
MQSA documentation to configure the WebSphere MQ queues.

The connector accepts multiple semicolon-delimited queue names. For example, to
poll the queues MyQueueA, MyQueueB, and MyQueueC, the value for connector
configuration property InputQueue is: MyQueueA;MyQueueB;MyQueueC.

The connector polls the queues in a round-robin manner and retrieves up to
pollQuantity number of messages from each queue. For example, pollQuantity
equals 2, and MyQueueA contains 2 messages, MyQueueB contains 1 message and
MyQueueC contains 5 messages.

With pollQuanity set to 2, the connector retrieves at most 2 messages from each
queue per call to pollForEvents. For the first cycle (1 of 2), the connector retrieves
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the first message from each of MyQueueA, MyQueueB, and MyQueueC. That completes
the first round of polling. The connector starts a second round of polling (2 of 2)
and retrieves one message each from MyQueueA and MyQueueC—it skips MqQueueB
because that queue is now empty. After polling all queues twice, the call to the
method pollForEvents is complete. The sequence of message retrieval is:

1 message from MyQueueA
1 message from MyQueueB
1 message from MyQueueC
1 message from MyQueueA
Skip MyQueueB because it is empty

ook wn =

1 message from MyQueueC

Default = queue://crossworlds.Queue.manager/MQCONN.IN

InProgressQueue

Message queue where messages are held during processing. You can configure the
connector to operate without this queue by using System Manager to remove the
default InProgressQueue name from the connector-specific properties. Doing so
prompts a warning at startup that event delivery may be compromised if the
connector is shut down while are events pending.

Default= queue://crossworlds.Queue.manager/MQCONN.IN_PROGRESS

118N
Specifies the path name of the BIA_HL7I18N.cfg file
..\Healthcare\dependencies\h17\BIA_HL7I18N.cfg

MTEventMap
This configuration contains a map of (Message X event type) -> Message structure.
The file is located at ...\Healthcare\dependencies\h17\HL7MTEventMap.cfg.

PollQuantity

Number of messages to retrieve from each queue specified in the InputQueue
property during a pollForEvents scan.

Default =1

Port
Port established for the WebSphere MQ listener.

Default=None.

If the value of Port is left blank or the property is removed, the connector allows
WebSphere MQ to determine the correct port.

Repetition delimiter
Default repetition delimiter for all types. The default is

ReplyToQueue
Queue to which response messages are delivered when the connector issues

requests.

Default = queue://crossworlds.Queue.manager/MQCONN.REPLYTO
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Representation

Representation determines how the message is parsed, either "Simplified" or
"Native.” Simplified parses so that it represents only the message header. Native
parses so that the entire message is represented. The default is "Simplified.”

Subcomponent delimiter
Default subcomponent delimiter. The default is :&."

UnsubscribedQueue
Queue to which messages about business objects that are not subscribed to are
sent.

Default =Default sub component delimiter for all types
queue://crossworlds.Queue.manager/MQCONN.UNSUBSCRIBED

UseDefaults

On a Create operation, if UseDefaults is set to true, the connector checks whether
a valid value or a default value is provided for each isRequired business object
attribute. If a value is provided, the Create operation succeeds. If the parameter is
set to false, the connector checks only for a valid value and causes the Create
operation to fail if it is not provided. The default is false.

Enabling guaranteed event delivery

You can configure the guaranteed-event-delivery feature for a JMS-enabled
connector in one of the following ways:
¢ If the connector uses a JMS event store (implemented as a JMS source queue),

the connector framework can manage the JMS event store. For more information,
see [“Guaranteed event delivery for connectors with JMS event stores.”|

e If the connector uses a non-JMS event store (for example, implemented as a
JDBC table, Email mailbox, or flat files), the connector framework can use a JMS
monitor queue to ensure that no duplicate events occur. For more information,
see [“Guaranteed event delivery for connectors with non-JMS event stores” on|

|Eage 25.|

Guaranteed event delivery for connectors with JMS event
stores

If the ]MS-enabled connector uses JMS queues to implement its event store, the
connector framework can act as a "container” and manage the JMS event store (the
JMS source queue). In a single JMS transaction, the connector can remove a
message from a source queue and place it on the destination queue. This section
provides the following information about use of the guaranteed-event-delivery
feature for a JMS-enabled connector that has a JMS event store:

* |“Enabling the feature for connectors with JMS event stores”|

+ [“Effect on event polling” on page 25|

Enabling the feature for connectors with JMS event stores
To enable the guaranteed-event-delivery feature for a J]MS-enabled connector that
has a iMS event store, set the connector configuration properties to values shown

in [Table 13

Chapter 2. Configuring the connector 23



Table 13. Guaranteed-event-delivery connector properties for a connector with a JMS event

store

Connector property Value

DeliveryTransport JMS

ContainerManagedEvents | JMS

Pol1Quantity The number of events to processing in a single poll of the event store
SourceQueue Name of the JMS source queue (event store) which the connector framework

polls and from which it retrieves events for processing

Note: The source queue and other JMS queues should be part of the same
queue manager. If the connector’s application generates events that are
stored in a different queue manager, you must define a remote queue
definition on the remote queue manager. WebSphere MQ can then transfer
the events from the remote queue to the queue manager that the
JMS-enabled connector uses for transmission to the integration broker. For
information on how to configure a remote queue definition, see your IBM
WebSphere MQ documentation.

In addition to configuring the connector, you must also configure the data handler
that converts between the event in the JMS store and a business object. This
data-handler information consists of the connector configuration properties that

able 14 summarizes.

Table 14. Data-handler properties for guaranteed event delivery

Data-handler property Value Required?
MimeType The MIME type that the data handler handles. | Yes
This MIME type identifies which data handler
to call.
DHClass The full name of the Java class that Yes
implements
the data handler
DataHandlerConfigMOName |The name of the top-level meta-object that Optional
associates MIME types and their data handlers

Note: The data-handler configuration properties reside in the connector
configuration file with the other connector configuration properties.

If you configure a connector that has a JMS event store to use guaranteed event
delivery, you must set the connector properties as described in and

To set these connector configuration properties, use the Connector
Configurator Express tool. Connector Configurator Express displays the connector
properties in [Table 13| on its Standard Properties tab. It displays the connector
properties in [Table 14| on its Data Handler tab.

Note: Connector Configurator Express activates the fields on its Data Handler tab
only when the DeliveryTransport connector configuration property is set to
JMS and ContainerManagedEvents is set to JMS.

For information on Connector Configurator Express, see |[Appendix B, “Connector]
[Configurator Express,” on page 103
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Effect on event polling

If a connector uses guaranteed event delivery by setting ContainedManagedEvents
to JMS, it behaves slightly differently from a connector that does not use this
feature. To provide container-managed events, the connector framework takes the
following steps to poll the event store:

1. Start a JMS transaction.
2. Read a JMS message from the event store.

The event store is implemented as a JMS source queue. The JMS message
contains an event record. The name of the JMS source queue is obtained from
the SourceQueue connector configuration property.

3. Call the data handler to convert the event to a business object.
The connector framework calls the data handler that has been configured with
the properties in [Table 14 on page 24

4. Send the resulting message to the JMS destination queue.
For InterChange Server Express, the message sent to the J]MS destination queue
is the business object.

5. Commit the JMS transaction.

When the JMS transaction commits, the message is written to the JMS
destination queue and removed from the JMS source queue in the same
transaction.

6. Repeat step through in a loop. The Pol1Quantity connector property
determines the number of repetitions in this loop.

Important: A connector that sets the ContainerManagedEvents property is set to JMS
does not call the pol1ForEvents() method to perform event polling. If
the connector’s base class includes a pol1ForEvents() method, this
method is not invoked.

Guaranteed event delivery for connectors with non-JMS event
stores

If the ]MS-enabled connector uses a non-JMS solution to implement its event store
(such as a JDBC event table, Email mailbox, or flat files), the connector framework
can use duplicate event elimination to ensure that duplicate events do not occur.
This section provides the following information about use of the
guaranteed-event-delivery feature with a J]MS-enabled connector that has a
non-JMS event store:

+ [“Enabling the feature for connectors with non-JMS event stores”]

» |“Effect on event polling”|

Enabling the feature for connectors with non-JMS event stores: To enable the
guaranteed-event-delivery feature for a JMS-enabled connector that has a non-JMS
event store, you must set the connector configuration properties to values shown

in [Table 15

Table 15. Guaranteed-event-delivery connector properties for a connector with a non-JMS
event store

Connector property Value

DeliveryTransport JMS

DuplicateEventETlimination |true

MonitorQueue Name of the JMS monitor queue, in which the connector
framework stores the ObjectEventld of processed business
objects
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If you configure a connector to use guaranteed event delivery, you must set the
connector properties as described in [Table 15| To set these connector configuration

properties, use the Connector Configurator Express tool. It displays these connector
properties on its Standard Properties tab. For information on Connector
Configurator Express, see [Appendix B, “Connector Configurator Express,” on page
103.

Effect on event polling: If a connector uses guaranteed event delivery by setting
DuplicateEventElimination to true, it behaves slightly differently from a connector
that does not use this feature. To provide the duplicate event elimination, the
connector framework uses a JMS monitor queue to track a business object. The
name of the JMS monitor queue is obtained from the MonitorQueue connector
configuration property.

After the connector framework receives the business object from the
application-specific component (through a call to gotAppl1Event() in the
pol1ForEvents() method), it must determine if the current business object
(received from gotApplEvents()) represents a duplicate event. To make this
determination, the connector framework retrieves the business object from the JMS
monitor queue and compares its ObjectEventld with the ObjectEventld of the
current business object:

* If these two ObjectEventlds are the same, the current business object represents a
duplicate event. In this case, the connector framework ignores the event that the
current business object represents; it does not send this event to the integration
broker.

¢ If these ObjectEventlds are not the same, the business object does not represent a
duplicate event. In this case, the connector framework copies the current
business object to the JMS monitor queue and then delivers it to the JMS
delivery queue, all as part of the same JMS transaction. The name of the JMS
delivery queue is obtained from the DeliveryQueue connector configuration
property. Control returns to the connector’s pol1ForEvents() method, after the
call to the gotApplEvent () method.

For a JMS-enabled connector to support duplicate event elimination, you must
make sure that the connector’s pol1ForEvents () method includes the following
steps:

* When you create a business object from an event record retrieved from the
non-JMS event store, save the event record’s unique event identifier as the
business object’s ObjectEventld attribute.

The application generates this event identifier to uniquely identify the event
record in the event store. If the connector goes down after the event has been
sent to the integration broker but before this event record’s status can be
changed, this event record remains in the event store with an In-Progress status.
When the connector comes back up, it should recover any In-Progress events.
When the connector resumes polling, it generates a business object for the event
record that still remains in the event store. However, because both the business
object that was already sent and the new one have the same event record as
their ObjectEventlds, the connector framework can recognize the new business
object as a duplicate and not send it to the integration broker.

* During connector recovery, make sure that you process In-Progress events before
the connector begins polling for new events.

Unless the connector changes any In-Progress events to Ready-for-Poll status
when it starts up, the polling method does not pick up the event record for
reprocessing.
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Meta-object attributes configuration

The connector for HL7 can recognize and read two kinds of meta-objects:
* Static connector meta-object
* Dynamic child meta-object

The attribute values of the dynamic child meta-object duplicate and override those
of the static meta-object.

Static meta-object

The static meta-object consists of a list of conversion properties defined for
different business objects. To define the conversion properties for a business object,
first create a string attribute and name it using the syntax busObj_verb. For
example, to define the conversion properties for a Customer object with the verb
Create, create an attribute named HL7_MTADT_A03_Create. In the application-specific
text of the attribute, you specify the actual conversion properties.

Additionally, a reserved attribute named Default can be defined in the meta-object.
When this attribute is present, its properties act as default values for all business
object conversion properties.

Note: If a static meta-object is not specified, the connector cannot map a given
message format to a specific business object type during polling. When this
is the case, the connector passes the message text to the configured data
handler without specifying a business object. If the data handler cannot
create a business object based on the text alone, the connector reports an
error indicating that this message format is unrecognized.

describes the meta-object properties.

Table 16. Static meta-object properties

Property name Description

CollaborationName The collaboration name must be specified in the application-specific
text of the attribute for the business object/verb combination. For
example, if you expect to handle synchronous requests for the business
object Customer with the Create verb, the static metadata object must
contain an attribute named HL7_MTnnn_Verb, where nnn is the HL7
message type, for example, HL7_MTADT_A03_Create. The
HL7_MTADT_AO3_Create attribute must contain application-specific text
that includes a name-value pair. For example,
CollaborationName=MyCustomerProcessingCollab. See the
[“Application-specific information” on page 28| section for syntax
details. Failure to do this results in runtime errors when the connector
attempts to synchronously process a request involving the Customer
business object.

Note: This property is available only for synchronous requests.

DoNotReportBusObj  Optionally, you can include the DoNotReportBusObj property. By setting
this property to true, all PAN report messages issued have a blank
message body. This is recommended when you want to confirm that a
request has been successfully processed but does not need notification
of changes to the business object. This does not affect NAN reports. If
this property is not found in the static meta-object, the connector
defaults to false and populates the message report with the business
object.

Note: This property is available only for synchronous requests.
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Table 16. Static meta-object properties (continued)

Property name Description

InputFormat The input format is the message format to associate with the given
business object. When a message is retrieved and is in this format, it is
converted to the given business object if possible. If this format is not
specified for a business object, the connector does not handle
subscription deliveries for the given business object.

OutputFormat The output format is set on messages created from the given business
object. If a value for the OutputFormat property is not specified, the
input format is used, if available. An OutputFormat property value
defined in a dynamic child meta-object overrides the value defined in
the static meta-object.

InputQueue The input queue that the connector polls to detect new messages. You
can use connector-specific properties to configure multiple
InputQueues and optionally map different data handlers to each
queue.

OutputQueue The output queue is the queue to which messages derived from the
given business object are delivered. An OutputQueue property value
defined in a dynamic child meta-object overrides the value defined in
the static meta-object.

ResponseTimeout The length of time in milliseconds to wait for a response before timing
out. The connector returns SUCCESS immediately without waiting for a
response if this property is undefined or has a value less than zero. A
ResponseTimeout property value defined in a dynamic child
meta-object overrides the value defined in the static meta-object.

TimeoutFatal If this property is defined and has a value of true, the connector
returns APP_RESPONSE_TIMEOUT when a response is not received within
the time specified by ResponseTimeout. All other threads waiting for
response messages immediately return APP_RESPONSE_TIMEOUT to the
integration broker. This causes the integration broker to terminate the
connection to the connector. A TimeoutFatal property defined in a
dynamic child meta-object overrides the value defined in the static
meta-object.

Note: The InputQueue property in the connector-specific properties defines which
queues the adapter polls. This is the only property that the adapter uses to
determine which queues to poll. In the static MO, the InputQueue property
and the InputFormat property can serve as criteria for the adapter to map a
given message to a specific business object. This feature is not used by the
adapter for healthcare data protocols.

Application-specific information
The application-specific information is structured in name-value pair format,
separated by semicolons. For example:

InputFormat=0RDER_IN;OutputFormat=0RDER_OUT

You can use application-specific information to map a data handler to an input
queue.

Mapping data handlers to InputQueues

You can use the InputQueue property in the application-specific information of the
static meta-object to associate a data handler with an input queue. This feature is
useful when dealing with multiple trading partners who have different formats
and conversion requirements. To do so you must:
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1. Use connector-specific properties (see [“InputQueue” on page 21) to configure
one or more input queues.

2. For each input queue, specify the queue manager and input queue name as
well as data handler class name and mime type in the application-specific
information.

For example, the following attribute in a static meta-object associates a data

handler with an InputQueue named CompReceipts:

[Attribute]

Name = HL7_MTADT_AO3 Create

Type = String

Cardinality = 1

MaxLength = 1

IsKey = false

IsForeignKey = false

IsRequired = false

AppSpecificInfo = InputQueue=//queue.manager/CompReceipts;
DataHandlerClassName=com.crossworlds.

DataHandlers.HL7.disposition_notification;
DataHandlerMimeType=message/

disposition_notification

IsRequiredServerBound = false

[End]

Overloading input formats

When retrieving a message, the connector normally matches the input format to
one specific business object and verb combination. The connector then passes the
business object name and the contents of the message to the data handler. This
allows the data handler to verify that the message contents correspond to the
business object that the user expects.

If, however, the same input format is defined for more than one business object,
the connector cannot determine which business object the data represents before
passing it to the data handler. In such cases, the connector passes the message
contents only to the data handler and then looks up conversion properties based
on the business object that is generated. Accordingly, the data handler must
determine the business object based on the message content alone.

If the verb on the generated business object is not set, the connector searches for
conversion properties defined for this business object with any verb. If only one set
of conversion properties is found, the connector assigns the specified verb. If more
properties are found, the connector fails the message because it is unable to
distinguish among the verbs.

Static configuration meta object
A static configuration meta-object is specific to MQ connectivity. It provides the
following services:

* Defines the output queue

* Defines the verb upon the retrevial of a message from the input queue for each
BO. This BO_Verb association with an input message is specified on the attribute
name.

* Specifies the format of data from both input queue and output queue fo reach
BO. This information is specified in the ASI Property.
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Table 17. Where IK=Is key, FK=Foreign key, IR=Is required, C=Cardinality, ML=Maximum
length, and Def=Default

Attribute
Name Type |[IK [FK |IR C ML Def ASI Comment
Default String | Yes [No |Yes 1 1 OutputQueue Output
=queue: queue
//crossworlds | defnition
.queue.
manager/
MQCONN. OUT
HL7 String |[No |No |No 1 7 Create |InputFormat
_Message =MQSTR;
_Create QutputFormat
=MQSTR
Object No No 1 Reserved
Event for
ID system
use

A sample static meta-object

The static meta-object shown below configures the connector to convert
HL7_MTADT_AO3 business objects using verbs Create and Retrieve. Note that attribute
Default is defined in the meta-object. The connector uses the conversion properties
of this attribute:

QutputQueue=CustomerQueuel;ResponseTimeout=5000;
TimeoutFatal=true

as default values for all other conversion properties. Thus, unless specified
otherwise by an attribute or overridden by a dynamic child meta-object value, the
connector issues all business objects to queue CustomerQueuel and then waits for a
response message. If a response does not arrive within 5000 milliseconds, the
connector terminates immediately.

Business object with verb create: Attribute HL7_MTADT_A03_Create indicates to the
connector that any messages of format NEW should be converted to a business
object with the verb Create. Because an output format is not defined, the connector
sends messages representing this object-verb combination using the format defined
for input (in this case NEW).

Business object with verb retrieve: Attribute HL7_MTADT_A03_Retrieve specifies
that business objects with verb Retrieve should be sent as messages with format
RETRIEVE. Note that the default response time has been overridden so that the
connector can wait up 10000 milliseconds before timing out (it still terminates if a
response is not received).

[ReposCopy]

Version = 3.0.0
Repositories = 1cHyILNuPTc=
[End]
[BusinessObjectDefinition]
Name = Sample MO

Version = 3.0.0

[Attribute]
Name = Default
Type = String
Cardinality =1
MaxLength = 1
IsKey = true
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IsForeignKey = false

IsRequired = false

AppSpecificInfo = OutputQueue=queue://crossworlds.queue.manager/MQCONN.OUT;
ResponseTimeout=5000;TimeoutFatal=true

IsRequiredServerBound = false

[End]

[Attribute]

Name = HL7 MTADT_AO3 Create

Type = String

Cardinality = 1

MaxLength =1

IsKey = false

IsForeignKey = false

IsRequired = false

AppSpecificInfo = InputFormat=NEW

IsRequiredServerBound = false

[End]

[Attribute]

Name = HL7_MTADT_AO3_Retrieve

Type = String

Cardinality =1

MaxLength =1

IsKey = false

IsForeignKey = false

IsRequired = false

AppSpecificInfo = OutputFormat=RETRIEVE;ResponseTimeout=10000

IsRequiredServerBound = false

[End]

[Attribute]

Name = ObjectEventId

Type = String

MaxLength = 255

IsKey = false

IsForeignkKey = false

IsRequired = false

IsRequiredServerBound = false

[End]

[Verb]
Name = Create
[End]

[Verb]
Name = Retrieve
[End]

[End]

Dynamic child meta-object

If it is difficult or unfeasible to specify the necessary metadata through a static
meta-object, the connector can optionally accept metadata specified at runtime for
each business object instance.

The connector recognizes and reads conversion properties from a dynamic
meta-object that is added as a child to the top-level business object passed to the
connector. The attribute values of the dynamic child meta-object duplicate the
conversion properties that you can specify via the static meta-object that is used to
configure the connector.

Because dynamic child meta object properties override those found in static
meta-objects, if you specify a dynamic child meta-object, you need not include a
connector property that specifies the static meta-object. Accordingly, you can use
either a dynamic child meta-object or a static meta-object, or both.
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able 18| shows sample static meta-object properties for business object
HL7_MTADT_AO3_Create. Note that the application-specific text consists of
semicolon-delimited name-value pairs

Table 18. Static meta-object structure for HL7_MTADT_A03_Create

Attribute name Application-specific text

HL7_MTADT_AQ03_Create InputFormat=0RDER_IN;
OutputFormat=0RDER_OUT; OutputQueue=QueueA;
ResponseTimeout=10000;
TimeoutFatal=False

able 19| shows a sample dynamic child meta-object for business object
HL7_MT_Create.

Table 19. Dynamic child meta-object Structure for HL7_MTADT_A03_Create

Property name Value
OutputFormat ORDER_OUT
QutputQueue QueueA
ResponseTimeout 10000
TimeoutFatal False

The connector checks the application-specific text of the top-level business object
received to determine whether tag cw_mo_conn specifies a child meta-object. If so,
the dynamic child meta-object values override those specified in the static
meta-object.

Population of the dynamic child meta-object during polling
In order to provide the integration broker with more information regarding
messages retrieved during polling, the connector populates specific attributes of
the dynamic meta-object, if already defined for the business object created.

Table |Table 20| shows how a dynamic child meta-object might be structured for

polling.

Table 20. JMS dynamic child meta-object structure for polling
Property name Sample value

InputFormat ORDER_IN

InputQueue MYInputQueue

OutputFormat CxIgnore

OutputQueue CxIgnore

ResponseTimeout CxIgnore

TimeoutFatal CxIgnore

As shown in you can define an additional property, InputQueue, in a
dynamic child meta-object. This property contains the name of the queue from
which a given message has been retrieved. If this property is not defined in the
child meta-object, it will not be populated.

Example scenario:

e The connector retrieves a message with the format ORDER_IN from the queue
WebSphere MQ queue.
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* The connector converts this message to an order business object and checks the
application-specific text to determine if a meta-object is defined.

* If so, the connector creates an instance of this meta-object and populates the
InputQueue and InputFormat properties accordingly, then publishes the business
object to available processes.

MO_DataHandler Healthcare

The following meta-object is used to configure all heathcare data handlers.

Table 21. Where IK=Is key, FK=Foreign key, IR=Is required, C=Cardinality, ML=Maximum
length, and Def=Default

Attribute
Name Type IK FK |IR C ML Def Comment
HL7 MO_ No No 1 N/A Attribute
DataHandler name
_HL7 designates a
name for the
MIME type
of HL7
messages
Dummy String Yes |[No |Yes 1 1
Key

MO_DataHandler HL7

The following meta-object contains configuration properties for the HL7 data
handler. BO_Prefix, Default Verb, and ClassName are used in the invocation of the
data handler by the connector.

Table 22. Where IK=Is key, FK=Foreign key, IR=Is required, C=Cardinality, ML=Maximum
length, and Def=Default

Attribute Name Type |IK |FK |[IR |C |ML |Def Comment
BOPrefix String | Yes [No |Yes |1 |4 HL7 BO’s prefix
Default Verb String [No [No |No |1 |7 |Create Verb set in BO
Class Name String [No |[No |No |1 [255 |com.ibm Java class name
.adapters of the HL7 data
.datahandlers |handler
.h17
.HL7DataHandle
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Table 22. Where IK=Is key, FK=Foreign key, IR=Is required, C=Cardinality, ML=Maximum

length, and Def=Default (continued)

Attribute Name

Type

IK

FK

IR

ML

Def

Comment

Representation

String

No

No

No

Simplified

Can be on of
the following:
"Simplified” or
"Native”
Simplified
signifies the
use of a
parsing method
which provides
find object
representation
to only the
message
header.

Native signifies
the user of a
parsing method
which provides
fine object
representation
to the whole
message

Field
delimiter

String

Default field
delimiter for all

types

Repetition
Delimiter

String

Default
repetition
delimiter for all
types

Component
Delimiter

String

Default
component
delimiter for all

types

Sub-
component
Delimiter

String

Default
subcomponent
delimiter for all

types

MTEventMap

String

255

file=...\
Healthcare\
dependencies\
HL7\ BIA_
HL7MTEvent
Map.cfg

This
configuration
contains a map
of (Message
type X Event
Type)-
>Message
Structure
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Table 22. Where IK=Is key, FK=Foreign key, IR=Is required, C=Cardinality, ML=Maximum

length, and Def=Default (continued)

Attribute Name Type |IK |FK |[IR |C |ML |Def Comment
I118N String [No [No |No |1 [255 [file=...\ Specifies the
Healthcare\ path name of
dependencies\ the BIA
HL7\ HL7I118N.cfg
BIA_HLILI8N.cfg | g0 This files
contains map
information on
ISO character
set, escape
secquence and
Java name
DummyKey String |Yes |No [No |1

Sample dynamic child meta-object

[BusinessObjectDefinition]
Name = MO_Sample_Config
Version = 1.0.0

[Attribute]

Name = QutputFormat

Type = String

MaxLength = 1

IsKey = true

IsForeignKey = false
IsRequired = false
DefaultValue = ORDER
IsRequiredServerBound = false
[End]

[Attribute]

Name = QutputQueue

Type = String

MaxLength =1

IsKey = false

IsForeignKey = false
IsRequired = false
DefaultValue = OUT
IsRequiredServerBound = false
[End]

[Attribute]

Name = ResponseTimeout

Type = String

MaxLength =1

IsKey = false

IsForeignKey = false
IsRequired = false
DefaultValue = -1
IsRequiredServerBound = false

[End]

[Attribute]

Name = TimeoutFatal
Type = String

MaxLength = 1

IsKey = false
IsForeignKey = false
IsRequired = false

DefaultValue = false
IsRequiredServerBound = false
[End]

[Attribute]
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Name = InputFormat
Type = String
MaxLength = 1

IsKey = true
IsForeignKey = false
IsRequired = false
IsRequiredServerBound
[End]

[Attribute]

Name = InputQueue
Type = String
MaxLength = 1

IsKey = false
IsForeignKey = false
IsRequired = false
IsRequiredServerBound
[End]

[Attribute]

Name = ObjectEventId
Type = String
MaxLength = 255

IsKey = false
IsForeignKey = false
IsRequired = false
IsRequiredServerBound = false
[End]

false

false

[Verb]
Name = Create
[End]

[Verb]
Name = Retrieve
[End]

[End]

[BusinessObjectDefinition]

Name = HL7_MTADT_A03

Version = 1.0.0

AppSpecificInfo = cw_mo_conn=MyConfig

[Attribute]

Name = FirstName
Type = String
MaxLength =1

IsKey = true
IsForeignKey = false
IsRequired = false
IsRequiredServerBound = false
[End]

[Attribute]

Name = LastName

Type = String
MaxLength =1

IsKey = true
IsForeignKey = false
IsRequired = false
IsRequiredServerBound = false
[End]

[Attribute]

Name = Telephone
Type = String
MaxLength = 1

IsKey = false
IsForeignKey = false
IsRequired = false
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IsRequiredServerBound = false
[End]

[Attribute]

Name = MyConfig

Type = MO_Sample_Config
ContainedObjectVersion = 1.0.0
Relationship = Containment
Cardinality =1

MaxLength =1

IsKey = false

IsForeignKey = false
IsRequired = false
IsRequiredServerBound = false
[End]

[Attribute]

Name = ObjectEventld
Type = String
MaxLength = 255
IsKey = false
IsForeignKey = false
IsRequired = false
IsRequiredServerBound
[End]

false

[Verb]
Name = Create
[End]

[Verb]
Name = Retrieve
[End]

[End]

JMS headers, HL7 message properties, and dynamic child
meta-object attributes

You can add attributes to a dynamic meta-object to gain more information about,
and more control over, the message transport. Adding such attributes allows you
to modify JMS properties, to control the ReplyToQueue on a per-request basis
(rather than using the default ReplyToQueue specified in the adapter properties),
and to re-target a message CorrelationID. This section describes these attributes
and how they affect event notification and request processing in both synchronous
and asynchronous modes.

The following attributes, which reflect JMS and HL7 header properties, are
recognized in the dynamic meta-object.

Table 23. Dynamic meta-object header attributes

Header attribute name Mode Corresponding JMS header
CorrelationID Read/Write JMSCorrelationID
ReplyToQueue Read/Write JMSReplyTo

DeliveryMode Read JMSDel1iveryMode

Priority Read JMSPriority

Destination Read JMSDestination

Expiration Read JMSExpiration

MessagelD Read JMSMessagelD

Redelivered Read JMSRedelivered

TimeStamp Read JMSTimeStamp
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Table 23. Dynamic meta-object header attributes (continued)

Header attribute name Mode Corresponding JMS header
Type Read JMSType

UserID Read JMSXUserID

AppID Read JMSXAppID

DeliveryCount Read JMSXDeliveryCount

GroupID Read JMSXGroupID

GroupSeq Read JMSXGroupSeq
JMSProperties Read/Write

Read-only attributes are read from a message header during event notification and
written to the dynamic meta-object. These properties also populate the dynamic
MO when a response message is issued during request processing. Read /write
attributes are set on message headers created during request processing. During
event notification, read/write attributes are read from message headers to populate
the dynamic meta-object.

The interpretation and use of these attributes are described in the sections below.

Note: None of the above attributes are required. You may add any attributes to the
dynamic meta-object that relate to your business process.

JMS Properties: Unlike other attributes in the dynamic meta-object,

JMSProperties must define a single-cardinality child object. Every attribute in this

child object must define a single property to be read/written in the variable

portion of the JMS message header as follows:

1. The name of the attribute has no semantic value.

2. The type of the attribute should always be String regardless of the JMS
property type.

3. The application-specific information of the attribute must contain two
name-value pairs defining the name and format of the JMS message property to
which the attribute maps.

The table below shows application-specific information properties that you must
define for attributes in the JMSProperties object.

Table 24. Application-specific information for JMS property attributes

Name Possible values Comments
Name Any valid JMS property This is the name of the JMS
name property. Some vendors

reserve certain properties to
provide extended
functionality. In general,
users should not define
custom properties that begin
with JMS unless they are
seeking access to these
vendor-specific features.
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Table 24. Application-specific information for JMS property attributes (continued)

Name Possible values Comments
Type String, Int, Boolean, Float, |This is the type of the JMS
Double, Long, Short property. The J]MS API

provides a number of
methods for setting values in
the JMS Message:
setIntProperty,
setLongProperty,
setStringProperty, etc. The
type of the JMS property
specified here dictates which
of these methods is used for
setting the property value in
the message.

The figure below shows attribute JMSProperties in the dynamic meta-object and
definitions for four properties in the J]MS message header: ID, GID, RESPONSE
and RESPONSE_PERSIST. The application-specific information of the attributes
defines the name and type of each. For example, attribute ID maps to J]MS
property ID of type String).

B MO_MOSeries_DynConfig 10| =|
General | Antibutes |

Pos j MName | Type Ky |Fleqd |l:an:| ! App Spec Info s
ik B JMSProperies| TeamCerter IS _Propedies [ [ | [0 | 1
ERE 1i] String rd F mame=ICtype=Sting
12 142 GID String 0| M name=CiD;type=Siring
13 |4 3 RESPONSE String I = name=RESPMOMSEype=Bonkan
T4 |14 | RESP_PERSST St r|F name=RESPONSE_PERSIST;type=Boolesn
15 |15 | objectEversa  swing |
2_ 2 .Olﬂn.anrrnni Strinn ) [ m

Figure 3. JMS properties attribute in a dynamic meta-object

Asynchronous event notification: If a dynamic meta-object with header attributes
is present in the event business object, the connector performs the following steps
(in addition to populating the meta-object with transport-related data):

1. Populates the CorrelationId attribute of the meta-object with the value
specified in the JMSCorrelationID header field of the message.

2. Populates the ReplyToQueue attribute of the meta-object with the queue
specified in the JMSReplyTo header field of the message. Since this header field
is represented by a Java object in the message, the attribute is populated with
the name of the queue (often a URI).

3. Populates the DeliveryMode attribute of the meta-object with the value
specified in the JMSDeliveryMode header field of the message.

4. Populates the Priority attribute of the meta-object with the JMSPriority
header field of the message.

5. Populates the Destination attribute of the meta-object with the name of the
JMSDestination header field of the message. Since the Destination is
represented by an object, the attribute is populated with the name of the
Destination object.

6. Populates the Expiration attribute of the meta-object with the value of the
JMSExpiration header field of the message.

7. Populates the MessagelID attribute of the meta-object with the value of the
JMSMessagelD header field of the message.
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10.

11.

12.

13.

14.

15.

16.

Populates the Redelivered attribute of the meta-object with the value of the
JMSRedelivered header field of the message.

Populates the TimeStamp attribute of the meta-object with the value of the
JMSTimeStamp header field of the message.

Populates the Type attribute of the meta-object with the value of the JMSType
header field of the message.

Populates the UserID attribute of the meta-object with the value of the
JMSXUserID property field of the message.

Populates the AppID attribute of the meta-object with the value of the
JMSXAppID property field of the message.

Populates the DeliveryCount attribute of the meta-object with the value of the
JMSXDeliveryCount property field of the message.

Populates the GroupID attribute of the meta-object with the value of the
JMSXGroupID property field of the message.

Populates the GroupSeq attribute of the meta-object with the value of the
JMSXGroupSeq property field of the message.

Examines the object defined for the JMSProperties attribute of the meta-object.
The adapter populates each attribute of this object with the value of the
corresponding property in the message. If a specific property is undefined in
the message, the adapter sets the value of the attribute to CxBlank.

Synchronous event notification: For synchronous event processing, the adapter
posts an event and waits for a response from the integration broker before sending
a response message back to the application. Any changes to the business data are
reflected in the response message returned. Before posting the event, the adapter
populates the dynamic meta-object just as described for asynchronous event
notification. The values set in the dynamic meta-object are reflected in the
response-issued header as described below (all other read-only header attributes in
the dynamic meta-object are ignored.):

* CorrelationID If the dynamic meta-object includes the attribute Correlationld,
you must set it to the value expected by the originating application. The
application uses the CorrelationID to match a message returned from the
connector to the original request. Unexpected or invalid values for a
CorrelationID will cause problems. It is helpful to determine how the
application handles correlating request and response messages before using this
attribute. You have four options for populating the CorrelationID in a
synchronous request.

1.

Leave the value unchanged. The CorrelationID of the response message will
be the same as the CorrelationID of the request message. This is equivalent
to the WebSphere MQ option MQRO_PASS_CORREL_ID.

Change the value to CxIgnore. The connector by default copies the message
ID of the request to the CorrelationID of the response. This is equivalent to
the WebSphere MQ option MQRO_COPY_MSG_ID_TO_CORREL_ID.

Change the value to CxBlank. The connector will not set the CorrelationID
on the response message.

Change the value to a custom value. This requires that the application
processing the response recognize the custom value.

If you do not define attribute CorrelationID in the meta-object, the connector
handles the CorrelationID automatically.

* ReplyToQueue If you update the dynamic meta-object by specifying a different
queue for attribute ReplyToQueue, the connector sends the response message to
the queue you specify. This is not recommended. Having the connector send
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response messages to different queues may interfere with communication
because an application that sets a specific reply queue in a request message is
assumed to be waiting for a response on that queue.

* JMS properties The values set for the JMS Properties attribute in the dynamic
meta-object when the updated business object is returned to the connector are
set in the response message.

Asynchronous request processing: The connector uses the dynamic meta-object,
if present, to populate the request message prior to issuing it. The connector
performs the following steps before sending a request message:

1. If attribute CorrelationID is present in the dynamic meta-object, the connector
sets the CorrelationID of the outbound request message to this value.

2. If attribute ReplyToQueue is specified in the dynamic meta-object, the connector
passes this queue via the request message and waits on this queue for a
response. This allows you to override the ReplyToQueuevalue specified in the
connector configuration properties. If you additionally specify a negative
ResponseTimeout (meaning that the connector should not wait for a response),
theReplyToQueue is set in the response message, even though the connector
does not actually wait for a response.

3. If attribute JMSProperties is specified in the dynamic meta-object, the
corresponding JMS properties specified in the child dynamic meta-object are set
in the outbound message sent by the connector.

Note: If header attributes in the dynamic meta-object are undefined or specify
CxIgnore, the connector follows its default settings.

Synchronous request processing: The connector uses the dynamic meta-object, if
present, to populate the request message prior to issuing it. If the dynamic
meta-object contains header attributes, the connector populates it with
corresponding new values found in the response message. The connector performs
the following steps (in addition to populating the meta-object with
transport-related data) after receiving a response message:

1. If attribute CorrelationID is present in the dynamic meta-object, the adapter
updates this attribute with the JUSCorrelationID specified in the response
message.

2. If attribute ReplyToQueue is defined in the dynamic meta-object, the adapter
updates this attribute with the name of the JMSReplyTo specified in the
response message.

3. If attribute DeliveryMode is present in the dynamic meta-object, the adapter
updates this attribute with the value of the JMSDeTiveryMode header field of
the message.

4. If attribute Priority is present in the dynamic meta-object, the adapter
updates this attribute with the value of the JMSPriority header field of the
message.

5. If attribute Destination is defined in the dynamic meta-object, the adapter
updates this attribute with the name of the JMSDestination specified in the
response message.

6. If attribute Expiration is present in the dynamic meta-object, the adapter
updates this attribute with the value of the JMSExpiration header field of the
message.

7. 1If attribute MessagelD is present in the dynamic meta-object, the adapter
updates this attribute with the value of the JMSMessagelID header field of the
message.
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8. If attribute Redelivered is present in the dynamic meta-object, the adapter
updates this attribute with the value of the JMSRedelivered header field of the
message.

9. If attribute TimeStamp is present in the dynamic meta-object, the adapter
updates this attribute with the value of the JMSTimeStamp header field of the
message.

10. If attribute Type is present in the dynamic meta-object, the adapter updates
this attribute with the value of the JMSType header field of the message.

11. If attribute UserID is present in the dynamic meta-object, the adapter updates
this attribute with the value of the JMSXUserID header field of the message.

12. If attribute AppID is present in the dynamic meta-object, the adapter updates
this attribute with the value of the JMSXAppID property field of the message.

13. If attribute DeliveryCount is present in the dynamic meta-object, the adapter
updates this attribute with the value of the JMSXDeliveryCount header field of
the message.

14. If attribute GroupID is present in the dynamic meta-object, the adapter updates
this attribute with the value of the JMSXGroupID header field of the message.

15. If attribute GroupSeq is present in the dynamic meta-object, the adapter
updates this attribute with the value of the JMSXGroupSeq header field of the
message.

16. If attribute JMSProperties is defined in the dynamic meta-object, the adapter
updates any properties defined in the child object with the values found in
the response message. If a property defined in the child object does not exist
in the message, the value is set to CxBlank.

Note: Using the dynamic meta-object to change the CorrelationID set in the
request message does not affect the way the adapter identifies the response
message—the adapter by default expects that the CorrelationID of any
response message equals the message ID of the request sent by the adapter.

Error handling: If a J]MS property cannot be read from or written to a message,
the connector logs an error and the request or event fails. If a user-specified
ReplyToQueue does not exist or cannot be accessed, the connector logs an error and
the request fails. If a CorrelationID is invalid or cannot be set, the connector logs
an error and the request fails. In all cases, the message logged is from the
connector message file.

Startup file configuration

Before you start the connector for HL7, you must configure the startup file with
the path information for the MQ Java client libraries. If the MQ Java client libraries
are not listed in the startup file, use the instructions in the sections below to
configure these files for Windows, Linux, or i5/0S. systems.

Windows

To complete the configuration of the connector for Windows platforms, the
healthcare connector gets the path of the MQ Java Client Library from the
environment variable MQ_LIB_RUNTIME:

1. Open the start_Healthcare.bat file.

2. Scroll to the section beginning with “Set the directory containing your MQ
Java client libraries,” and specify the location of your MQ Java client
libraries.
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Linux

To complete the configuration, the installer for InterChange Server Express
automatically sets the variables related to MQ Java Client Library.

Note: If you still want to add the MQ path into the startup scripts, you can
append the MQ path to CLASSPATH (JCLASSES) constructed in this startup
script: start_Healthcare.sh.

i5/0S

To complete the configuration, the installer for InterChange Server Express
automatically set the variables related to MQ Java Client Library.

Note: If you still want to add the MQ path into the startup script, you can append
the MQ path to CLASSPATH (JCLASSES) constructed in this startup script:
start_Healthcare.sh.

Creating multiple instances of connectors on one server

Creating multiple instances of a connector is in many ways the same as creating a
custom connector. You can set your system up to create and run multiple instances
of a connector by following the steps below. You must:

* Create a new directory for the connector instance
* Make sure you have the requisite business object definitions
¢ Create a new connector definition file

* Create a new start-up script

Create a new directory

* For Windows Platforms:
ProductDir\ connectors\ connectorInstance

If the connector has any connector-specific meta-objects, you must create a
meta-object for the connector instance. If you save the meta-object as a file,
create this directory and store the file here:

ProductDir\repository\connectorInstance
where connectorInstance uniquely identifies the connector instance.
You can specify the InterChange Server Express server name as a parameter of
startup.bat; an example is: start_healthcare.bat connName serverName.

* For i5/0S Platforms:
/QIBM/UserData/WBIServerd4/WebShereICSName/connectors/connectorInstance
where connectorInstance uniquely identifies the connector instance and where

WebSphereICSName is the name of the Interchange Server Express instance with
which the connector runs.

If the connector has any connector-specific meta-objects, you must create a
meta-object for the connector instance. If you save the meta-object as a file,
create this directory and store the file here:

/QIBM/UserData/WBIServer44/WebSphereICSName/repository
/connectorInstance where WebSphereI[CSName is the name of the Interchange
Server Express

instance with which the connector runs.

* For Linux Platforms:
ProductDir/connectors /connectorInstance where connectorInstance uniquely
identifies the connector instance. If the connector has any connector-specific
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meta-objects, you must create a meta-object for the connector instance. if you
save the meta-object as a file, create this directory and store the file here:
ProductDir/repository/connectorInstance.You can specify the InterChange
Server Express servername as a parameter of connector_manager; an example is
connector_manager -start connName WebSphereICSName [-cConfigFile].

Create business object definitions

If the business object definitions for each connector instance do not already exist
within the project, you must create them.

1.

If you need to modify business object definitions that are associated with the
initial connector, copy the appropriate files and use Business Object Designer
Express to import them. You can copy any of the files for the initial connector.
Just rename them if you make changes to them.

Files for the initial connector should reside in the following directory:
ProductDir\repository\initialConnectorInstance

Any additional files you create should be in the appropriate connectorInstance
subdirectory of ProductDir\repository.

Create a connector definition

Use the following steps to create a configuration file (connector definition) for the
connector instance in Connector Configurator Express.

1.

3.

Copy the initial connector’s configuration file (connector definition) and rename
it.

Make sure each connector instance correctly lists its supported business objects
(and any associated meta-objects).

Customize any connector properties as appropriate.

Create a start-up script
To create a startup script:

1.

Copy the initial connector’s startup script and name it to include the name of
the connector directory:

dirname

Put this startup script in the connector directory you created in
[pusiness object definitions.”|

(For Windows only.) Create a startup script shortcut.

(For Windows only.) Copy the initial connector’s shortcut text and change the
name of the initial connector (in the command line) to match the name of the
new connector instance.

(For i5/0S only.) Create a job description for the connector using the
information below:

CRTDUPOBJ(QWBIISRSC) FROMLIB(QWBISVR44)OBJTYPE(*JOBD)TOLIB
(QWBISVR44) NEWOBJ(newemailname) where newemailname is a 10-character
name that you use for the job description for your new connector.

(For i5/0S only.) Add the new connector to the WebSphere Business
Integration Server Express Console. For information about the WebSphere
Business Integration Server Express console, refer to the online help provided
with the Console.
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Starting the connector

A connector must be explicitly started using its connector start-up script. On
Windows systems the startup script should reside in the connector’s runtime
directory:ProductDir\connectors\healthcare.

On Linux systems the startup script should reside in the ProductDir/bin directory.

On i5/0S systems the startup script should reside in
/QIBM/UserData/WBIServerd4/WebSphereICSName/connectors /Healthcare

The name of the startup script depends on the operating system platform, as

shows.

Table 25. Startup scripts for a connector

Operating system Startup script

Linux connector_manager
i5/0S start_healthcare.sh
Windows start_healthcare.bat

When the startup script runs, it expects by default to find the configuration file in
the ProductDir (see the commands below). This is where you place your
configuration file.

 Starting the connector on a Windows system:

— From the Start menu, select Programs>IBM WebSphere Business Integration
Express>Adapters>Connectors. By default, the program name is “IBM
WebSphere Business Integration Server Express.” However, it can be
customized. Alternatively, you can create a desktop shortcut to your
connector.

— From the Windows command line: start_connName connName brokerName
{-cconfigFile}.

— On Windows systems, you can configure the connector to start as a Windows
service. In this case, the connector starts when the Windows system boots (for
an Auto service) or when you start the service through the Windows Services
window (for a Manual service).

* Starting the connector on a Linux system:

— From the command line type:

connector_manager -start connName brokerName [-cconfigFile ]

where connName is the name of the connector and brokerName identifies the
integration broker.

— For InterChange Server Express, specify for brokerName the name of the
InterChange Server Express instance.

* Starting the connector on an i5/0OS system:

— From the Windows system where the WebSphere Business Integrations Server
Express Console is installed, select IBM WebSphere Business Integration
Server Express>Toolset Express>
Administrative>Console. Then specify the i5/0S system name or IP address
and a user profile and password that has *JOBCTL special authority. Select
the connector from the list of connectors, and click Start

— To automatically start the adapter using the Console, use the
submit_adapter.sh script. You can also set the adapter agent from the Console
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to start automatically. To set the option, right-click on the adapter agent and
click to enable the Autostart check box.

— In Batch mode, from the i5/0S command line, you need to run the CL
command QSH and from the QSHELL environment. Run
/QIBM/ProdData/WBIServer44/bin/submit_adapter.sh connName
WebSphereICSName pathToConnNameStartScript jobDescriptionName, where
connName is the connector name, WebSphereICSName is the Interchange Server
Express server name (default is QWBIDFT44), pathToConnNameStartScript is
the full path to the connector start script, jobDescriptionName is the name of
the job description to use in the QWBISVR44 library.

— In interactive mode, you need to run the CL command QSH and from the
QSHELL environment.
Run /QIBM/UserData/WBIServer44/WebSphereICSName/connectors
/Healthcare/start_Healthcare.sh Healthcare WebSphereICSName
[-cConfigFile]

For more information on how to start a connector, including the command-line

startup options, refer to the System Administration Guide.

Tasks performed during connector startup
When the connector is started, it performs the following tasks:

Retrieves configuration information

Retrieves the supported internal business object definitions
Returns the connector version

Returns a pointer to the internal business object handler

Retrieves a pointer to the data handler

Stopping the connector

The way to stop a connector depends on the way the connector was started.

Windows:

— You can invoke the startup script which creates a separate “console” window
“"__rm

for the connector. In this window, type “q” and press Enter to stop the
connector.

— You can configure the connector to start as a Windows service. In this case,
the connector stops when the Windows system shuts down.

i5/0S:

— If you started the connector using the Console, or using the
"submit_adapter.sh” script in QSHELL, then you can use one of two methods
to stop the connector:

— From the Windows system where the WebSphere Business Integration Server
Express Console is installed, select IBM WebSphere Business Integration
Express> Toolset Express>Administrative>Console. Then specify the i5/0S
system name or IP address and a user profile and password that has *JOBCTL
special authority. Select the Healthcare adapter from the list and select the
Stop button. Use the CL Command WRKACTJOB SBS (QWBISVR44) to
display the jobs to the Server Express product. Scroll the list to find the job
with the jobname that matches the job description for the connector. Use the
CL Command WRKSMBJOB to display the jobs; the job name is QWBIISRSC.
Select Option 4 on this job, and press F4 to get the prompt for the ENDJOB
command. Then specify *IMMED for the Option parameter and press enter.

Note: The connector will end when the QWBISVR44 subsystem has ended.
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— If you used the start_connName.sh script to start the adapter from QSHELL,
press F3 to
end the connector. You can also stop the agent, by using a script named
stop_adapter.sh
located in the /QIBM/ProdData/WBIServer44 /bin directory.

* Linux:

Connectors run in the background so they have no separate window. Instead,
run the following command to stop the connector:

connector_manager -stop connName

where connName is the name of the connector.
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Chapter 3. Business objects

+ [“Connector business object requirements” on page 49|

* [“Overview of the HL7 message structure” on page 52|

* [“Overview of business objects for HL7” on page 53|

The connector for health care data protocols is a metadata-driven connector. In
WebSphere business objects, metadata is data about the application’s data, which is
stored in a business object definition and which helps the connector interact with
an application. A metadata-driven connector handles each business object that it
supports based on metadata encoded in the business object definition rather than
on instructions hard-coded in the connector.

Business object metadata includes the structure of a business object, the settings of
its attribute properties, and the content of its application-specific text. Because the
connector is metadatametadata-driven, it can handle new or modified business
objects without requiring modifications to the connector code. However, the
connector’s configured data handler makes assumptions about the structure of its
business objects, object cardinality, the format of the application-specific text, and
the database representation of the business object. Therefore, when you create or
modify a business object for health care data protocols, your modifications must
conform to the rules the connector is designed to follow, or the connector cannot
process new or modified business objects correctly.

This chapter describes how the connector processes business objects and describes
the assumptions the connector makes. You can use this information as a guide to
implementing new business objects.

Connector business object requirements

The business object requirements for the connector reflect the way the health care
data handler converts:

¢ an HL7 message into a WebSphere business object, and vice versa
* a NCPDP message into a WebSphere business object, and vice versa

The sections below discuss the requirements for WebSphere business objects as
well as the HL7 and NCPDP message structure.

A review of the following WebSphere documents is strongly recommended:
 System Implementation Guide
* Business Object Development Guide

Business object hierarchy

WebSphere business objects can be flat or hierarchical. All the attributes of a flat
business object are simple (that is, each attribute represents a single value, such as
a String or Integer or Date).

In addition to containing simple attributes, a hierarchical business object has
attributes that represent a child business object, an array of child business objects,
or a combination of both. In turn, each child business object can contain a child
business object or an array of business objects, and so on.
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Important: A business object array can contain data whose type is a business
object. It cannot contain data of any other type, such as String or
Integer.

There are two types of relationships between parent and child business objects:

* Single-cardinality—When an attribute in a parent business object represents a
single child business object. The attribute is of the same type as the child
business object.

* Multiple-cardinality—When an attribute in the parent business object represents
an array of child business objects. The attribute is an array of the same type as
the child business objects.

WebSphere uses the following terms when describing business objects:

* hierarchical—Refers to a complete business object, including the top-level
business object and its the child business objects at any level.

¢ parent—Refers to a business object that contains at least one child business
object. A top-level business object is also a parent.

* individual—Refers to a single business object, independent of any child business
objects it might contain or that contain it.

* top-level—Refers to the individual business object at the top of the hierarchy,
which does not itself have a parent business object.

* wrapper—Refers to a top-level business object that contains information used to
process its child business objects. For example, the healthcare connector requires
the wrapper business object to contain information that determines the format of
its child data business objects and routes the children.

Business object attribute properties

Business object architecture defines various properties that apply to attributes. This
section describes how the connector interprets several of these properties. For
further information on these properties, see Business Object Attributes and
Attribute Properties in Chapter 2 of the Business Object Development Guide.

Name property
Each business object attribute must have a unique name within the business object.
The name should describe the data that the attribute contains.

For an application-specific business object, check the Data Handler Guide for specific
naming requirements.

The name can be up to 80 alphanumeric characters and underscores. It cannot
contain spaces, punctuation, or special characters.

Type property
The Type property defines the data type of the attribute:

* For a simple attribute, the supported types are Boolean, Integer, Float, DoubTe,
String, Date, and LongText.

e If the attribute represents a child business object, specify the type as the name of
the child business object definition (for example, Type = MT502A) and specify the
cardinality as 1.

e If the attribute represents an array of child business objects, specify the type as
the name of the child business object definition and specify the cardinality as n.
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Note: All attributes that represent child business objects also have a
ContainedObjectVersion property (which specifies the child’s version
number) and a Relationship property (which specifies the value
Containment).

Cardinality property

Each simple attribute has cardinality 1. Each business object attribute that
represents a child or array of child business objects has cardinality 1 or n,
respectively.

Note: When specified for a required attribute, cardinality 1 indicates a child
business object must exist, and cardinality n indicates zero to many instances
of a child business object.

Key property
At least one attribute in each business object must be specified as the key. To
define an attribute as a key, set this property to true.

When you specify as key an attribute that represents a child business object, the
key is the concatenation of the keys in the child business object. When you specify
as key an attribute that represents an array of child business objects, the key is the
concatenation of the keys in the child business object at location 0 in the array.

Foreign key property

The Foreign Key property is typically used in application-specific business objects
to specify that the value of an attribute holds the primary key of another business
object, serving as a means of linking the two business objects. The attribute that
holds the primary key of another business object is called a foreign key. Define the
Foreign Key property as true for each attribute that represents a foreign key.

You can also use the Foreign Key property for other processing instructions. For
example, this property can be used to specify what kind of foreign key lookup the
connector performs. In this case, you might set Foreign Key to true to indicate that
the connector checks for the existence of the entity in the database and creates the
relationship only if the record for the entity exists.

Required property

The Required property specifies whether an attribute must contain a value. If a
particular attribute in the business object that you are creating must contain a
value, set the Required property for the attribute to true.

For information on enforcing the Required property for attributes, see the section
on initAndValidateAttributes() in Connector Reference: C++ Class Library and
Connector Reference: Java Class Library.

AppSpecificinfo
The AppSpecificInfo property is a String no longer than 255 characters that is
specified primarily for an application-specific business object.

Max length property

The Max Length property is set to the number of bytes that a String-type attribute
can contain. Although this value is not enforced by the WebSphere system, specific
connectors or data handlers may use this value. Check the guide for the connector
or data handler that will process the business object to determine minimum and
maximum allowed lengths.
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Note: The Max Length property is very important when you use a fixed width
data handler. Attribute length is not available in the collaboration mapping
process (relevant only when InterChange Server Express is the integration
broker).

Default value property
The Default Value property can specify a default value for an attribute.

If this property is specified for an application-specific business object, and the
UseDefaults connector configuration property is set to true, the connector can use
the default values specified in the business object definition to provide values for
attributes that have no values at runtime.

For more information on how the Default Value property is used, see the section
on initAndValidateAttributes() in Connector Reference: C++ Class Library and
Connector Reference: Java Class Library.

Comments property

The Comments property allows you to specify a human-readable comment for an
attribute. Unlike the AppSpecificInfo property, which is used to process a business
object, the Comments property provides only documentation information.

Special attribute value

Simple attributes in business object can have the special value, CxIgnore. When it
receives a business object from the integration broker, the connector ignores all
attributes with a value of CxIgnore. It is as if those attributes were invisible to the
connector.

If no value is required, the connector sets the value of that attribute to CxIgnore by
default.

Overview of the HL7 message structure

HL7 standard supports primarily two modes of operations: Batch and Interactive.
Data exchanged between systems can roughly be classified into two groups:
individual and bulk to suit the two modes of operations.

By definition, bulk message is a collection of individual messages. It consists of
header, sequentially listed individual message, and trailer. The embedded
individual message retains its structure, just as it were in the interactive operation
mode. There is no structural difference between individual messages operating in
two different modes of operation. But because the nature of batch operation does
not allow dialog messages, certain categories of individual message are only suited
for the interactive operation mode.

Structurally all individual message contains a header. Some contains body and
others don’t. An Individual message is, according to the standard, an “atomic unit
of data transferred between systems”. However the very same standard also allows
the notion of logical message, whose data is physically broken down to more than
one individual messages and correlated together using a logical message id in
message headers. The breakup of a message into individual messages is driven
primarily by message length negotiated between parties engaging in message
exchanges.

For more information about the HL7 message structure and HL7 message
components see
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Overview of business objects for HL7

HL7 provides two ways by which to offer message representation:

* Sampled object representation
The HL7 message body offers object representation to just the header. The
message body is treated as a blob. One business object, to represent all message
types.

* Native object representation
This level of object representation of HL7 message offers object representation to
both message header and message body. A corresponding business object
represents virtually every HL7 data element, including every message structure
or query.

The following sections describe rules to follow when constructing business objects
to represent HL7 data elements.

Supported native message
When creating, configuring or modifying supported native messages:
* All message types and queries, except examples, defined by version 2.4 of HL7
message standard specification

* Industry specific business objects (ISBO) that correspond to the template used in
the standard specification are provided for reference only. Not all data elements
are fully solidified, thus no support is provided to these business objects.

* Earlier versions of the HL7 standard permited users to create their own custom
made (CM) data type. Since CM data types are not specified in the standard,
they are not included in the published collection of industry specific business
objects (ISBOs). However, the metadata model employed in the published ISBOs
offers users a way to create their ASBO representation to these CM data types.

Mapping the primitive data type
Use the following table to map the primitive data type:
Table 26. Mapping the Primitive data type

HL7 data elements Business object attribute data type
SI String

ID String

NM Float

DT String

IS String

ST String

FT String

X String
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Mapping repeating data elements

Use the following table to map repeating data elements:

Table 27. Mapping repeating data elements

Repeating HL7 data |BO attribute data

element type Cardinality ASI

SI, ID, DT, IS, ST, FT, | CW_Array_String N DataTypelD=HL7
TX data type ID

NM CW_Array_Float N DataTypelD=NM

ISBO definitions

Documenting all of the business objects needed to represent the complete HL7 data
element catalog is prohibitive. The following section explains how the business
objects are constructed, along with noting several the special treatment required for
several HL7 data elements hat do not follow traditional BO construction rules

Business object construction follows the HL7 data element structure very closely,
except for the HL7_DTEncodedText, HL7_DTMA, HL7_DTNA, HL7_DTQIP, and
HL7_DTUnionALL.

Note: The rules of constructing BO from HL7 data elements are detailed in the
following subsections. The naming convention adopts [] to signify
optionality and <> to signify the explanation of content enclosed by the
angle brackets which is not part of the required characters in the naming
convention. Each business object must contain the ObjectEventID BO. For
this reason, the following business objects do not specifically list that
business object.

BO Name

Message BO
Construct the Message BO using the following parameters:

* Corresponding HL7 data element
Message structure identified by a pair of HL7 message type and event/query
IDs
* Naming convention
HLT MT<message type> <Event code/query id>
where event code with smallest lexigraphical value is applicable to the message
type/query
* Marking convention
N/A
e Grammar
N/A
* Example:
HL7_MTADT_AO1 for ADT message type with ACK event with event code A01,
A04, A0S, and A13
HL7_MTQBP_Q21 for Query statement ID Q21 and Q24.

Group BO

The Group BO construct is summarized as follows:
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¢ Corresponding HL7 data element
Any segment group with two or more segments.
* Naming convention
HLT MT<message type> <Event code/query id> GP<group index>
where event code with the smallest lexical value is applicable to the message
type/query and index is unique in the scope of the message structure.
* Marking convention
N/A
* Grammar
N/A

¢ Example:
HL7_MTADT_AO3 has a group name HL7_MTADT_AG3_GP1

Table 28. Naming conventions for segment group

ADT~A03"ADT_A03 ADT Message

MSH Message header

EVN Event type

PID Patient identification

[ PD1 ] Additional demographics

[{ ROL } ] Role

[PV2] Patient visit - Additional information

[{ ROL }] Role

[{ DB1 }] Disability information

[{ DG1 }] Diagnosis information

[ DRG ] Diagnosis related group

[t

PR1 Procedures

[{ ROL }] Role

1

[{ OBX }] Observation/Result

[ PDA } Patient death/autopsy
Segment BO

The construction of the Segment BO is summarized as follows:

* Corresponding HL7 data element
HL7 segment and the segment definition of QPD, QED, RCP, QAK segments
with their parameter tables of a conformance statement

* Naming convention
HL7 SG<segment ID> [<Query ID>]
where Segment ID is the segment ID defined by HL7 and Query ID is the query
ID defined by HL7 or user. Only QPD, QED, RCP, QAK segments require query
ID.

* Marking convention
N/A

¢ Grammar
N/A
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* Example:

The segment BO for MSH is named HL7_SGMSHThe segment BO for QBD segment
in QBP_Q21 is named HL7_SGQBD_Q21

Complex data type BO

The construction of a complex data type BO is summarized as follows:

¢ Corresponding HL7 data element

Complex HL7 data type except MA, NA, and QIP data types

* Naming convention
HL7_DT<data type>

where Data Type is the data type ID defined by HL7 for complex HL7 data

types.

To the CE data type the following convention is used: HL7_DT<Data Type>_<Table

Number>

where table number is the id of table for the segment field of CE data type,
which is defined in a segment definition

The polymorphic nature of CM data type warrants separate treatment. Each
instance of CM data type is specified in the following table. The data structure
name is specified in the table of Data Structures in the HL7 Message Standard

Access Database.

Table 29. List of all business objects for complex data types for CM data

DT BO Data structure name Description

HL7_DTAUI AUI Authorization information
HL7_DTCCD CCD Charge time

HL7_DTCCP cCp Channel calibration parameters
HL7_DTCSU CSu Channel sensitivity /units
HL7_DDI DDI Daily deductible

HL7_DIN DIN Activation code

HL7_DLD DLD Discharge location

HL7_DLT DLT Delta check

HL7_DTN DTN Day, type and number
HL7_DEIP EIP Parent order

HL7_DTELD ELD Error

HL7_DTLA1 LAl Location with address information (variant one)
HL7_DTLA2 LA2 Location with address information (variant two)
HL7_DMOC MOC Charge to practice

HL7_DMSG MSG Message type

HL7_DNDL NDL Observing practitioner
HL7_DNR NR Wertebereich

HL7_DOCD_ |OCD Occurence

HL7_DOSD OsD Order sequence

HL7_DOSP osp Occurence span

HL7_DPCF PCF Pre-certification

HL7_DPEN PEN Penalty

HL7_DTPI PI Personal identifier
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Table 29. List of all business objects for complex data types for CM data (continued)

DT BO Data structure name Description
HL7_DTPIP pPIP Privileges

HL7_DTPLN PLN Practitioner ID numbers
HL7_DTPRL PRL Parent result link
HL7_DTPTA PTA Policy type
HL7_DTRFR RFR Reference range
HL7_DTRMC |RMC Room coverage
HL7_DTSPD SPD Specialty

HL7_DTSPS SPS Specimen source
HL7_DTUVC |UVC Value code and amount
HL7 _DTVR VR Value qualifier
HL7_DTWVI WEFI Channel identifier
HL7_DTWVS |WVS Waveform source

¢ Marking convention

N/A

e Grammar
N/A

* Example:

The BO for CQ data type is named HL_DTCQ.

The 46th field of OBR segment, which is of CE data type, uses table 0411, as
shown the following excerpt. The BO name of this CE data type is

HL7 DTCE_0411.

Table 30. 46th field of the OBR segment

SEQ |LEN

DT |OPT

RP/#

TBL#

ITEM # |Element Name

46 250

CE |O

Y

0411

01474 Placer supplemental service

information

Data type union BO

The construct of the Data type union BO is summarized as follows:

* Corresponding HL7 data element

Varies according to data type

* Naming convention
HL7_DTUnionA11

¢ Marking convention

N/A

e Grammar
N/A

* Example:
N/A

BO AppSpecificinfo

The following details application specific properties for common business objects.
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Message BO
The construct of the Message BO for AppSpecificInfo is summarized as follows:

¢ Corresponding HL7 data element
Message structure identified by a pair of HL7 message type and event /query
ID
* Naming convention
N/A
* Marking convention
N/A
e Grammar
N/A

* Example:
N/A

Group BO

The construct of the Group BO for AppSpecificInfo is summarized as follows:

e Corresponding HL7 data element
Any segment group with two or more segments.

* Naming convention
N/A

* Marking convention
N/A

* Grammar

StructType=Group
The values of StructType ASI property is defined in the following table:

Table 31. StructType value definition table

StructType value |Description

Group To signify that the BO is for a segment group

Segment To signify that the BO is for a segment

DataType To signify that the BO is for an HL7 data type

Union To signify that the BO is a union BO, which represents the

polymorphic data type. Attributes of union BO represent data types
permitted in the variant range of data types. Only one of the attributes
in a union BO is populated at runtime. The context into how to choose
valued attributed is indicated by Type Context ASI property

Array To signify that the BO is for a component array container

* Example:
N/A

Segment BO

The construct of the Segment BO for AppSpecificInfo is summarized as follows:

* Corresponding HL7 data element
HL7 segment and the segment definition of QPD, QED, RCP, QAK segments
with their parameter tables of a conformance statement.

* Naming convention
N/A

* Marking convention
N/A
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Grammar
StructType=Segment;SegID=<segment ID>
where segment ID is the HL7 segment ID

Example:
N/A

BO of a Complex data type
The construct of the BO for a complex data type for BO AppSpecificInfo is
summarized as follows:

Corresponding HL7 data element
Complex HL7 data type except MA, NA and QIP data type

Naming convention
N/A

Marking convention
N/A

Grammar

N/A

Example:

N/A

Data type Union BO
The construct of the data type Union BO for BO AppSpecificInfo is summarized as
follows:

Corresponding HL7 data element
Varies according to data type

Naming convention
N/A

Marking convention
N/A

Grammar

N/A

Example:
N/A

BO attribute structure

The following section details the attribute structure for several common business
objects.

Message BO

The construct of the data type Message BO for BO Attribute Structure is
summarized as follows:

Corresponding HL7 data element
Attribute of the types of segment BO or segment group BO. The actual list of
attributes is specified by the HL7 message structure definition

Naming convention
N/A

Marking convention
N/A

Grammar
N/A
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* Example:
The message structure for message type ADT and event type A61 has the
following attribute types:

Table 32. Attribute types for each attribute of HL7_MTADT_A61 and HL7 counter parts

Attribute type Attribute type HL7 Counterpart
1 HL7_SGMSH MSH
2 HL7_SGEVN EVN
3 HL7_SGPID PID
4 HL7_SGPD1 [PD1]
5 HL7_SGV1 PVl
6 HL7_SGROL [ {ROL}]
7 HL7_SGPV2 [PV2}
Group BO
The construct of the data type Group BO for BO Attribute Structure is summarized
as follows:

* Corresponding HL7 data element
Any segment group with two or more segments

* Naming convention
N/A

* Marking convention
N/A

* Grammar
N/A

* Example:
BO HL7_MTADT_A03_GP1 with HL7 counter parts depicted in the following table
with its HL7 counter part.

Table 33. Attribute sequence for each attribute of HL7_MTADT_A03_GP1 and their HL7

counter parts

Attribute sequence Attribute type HL7 counterpart

1 HL7_SGPR1 PR1

2 HL7_SGROL [{ROL}]
Segment BO

The construct of the data type Segment BO for BO AttributeStructure is
summarized as follows:

¢ HL7 segment and the segment definition of QPD, RDT segments with their
parameter tables of a conformance statement.

¢ Naming convention
N/A

* Marking convention
N/A

¢ Grammar
N/A
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* Example:

BO HL7_SGQBD_Q21 with HL7 message standard specification definition for query

Q21.

Table 34. Attribute sequence for query definition Q21 in BO HL7_SGQBD_Q21

Attribute sequence Attribute type HL7 counterpart

1 HL7_DTCE MessageQueryName (CE)

2 HL7_DTENDCODEDTEXT QueryTag (ST)

3 HL7_DTCX Personldentifier (CX)

4 HL7_DTCX WhatDomainsReturned (CSX)

BO of complex data type

The construct of the complex data structure for BO AttributeStructure is
summarized as follows:

* Corresponding HL7 data element

Any segment group with two or more segments
* Naming convention

N/A

e Marking convention

N/A

e Grammar
N/A

* Example:

BO HL7_MTADT_A03_GP1 with HL7 counter parts depicted in the following table

with its HL7 counter part.

Table 35. Attribute sequence for each attribute of HL7_MTADT_A03_GP1 and their HL7

counter parts

Attribute sequence

Attribute type

HL7 counterpart

1

HL7_SGPR1

PR1

2

HL7_SGROL

[{ROL}]

Data type Union BO

The Union BO represents the total aggregate of all data types defined by the

standard specification.

Note: The Union BO must not recursively contain another Union BO.

The construct of the Union BO is summarized as follows:

* Corresponding HL7 data element
— HL7 data type except CM and Varies
— CM values from [Table 29 on page 56|

* Naming convention

N/A

¢ Marking convention

N/A

Chapter 3. Business objects

61



¢ Grammar
N/A

* Example:
N/A

BO Attribute Property Name

The following details the attribute property names for common business objects

Message BO

The property name attributes of the Message BO are summarized as follows:

e Corresponding HL7 data element
Attributes in segment groups or segments that make up the HL7 message
structure definition or query structure definition.

* Naming convention
<concantenation of words in description>
where the concatenation follows the following rules:

Table 36. Concatenation rules

Rule name

Rule description

Word selection

All words except the following punctuations and auxiliary words,
regardless of their letter capitalization, in the description are

included in the concatenation: "a”, "an”, "the”, "in”, "of”, "for”,
”With”, NatH/ U/U/ H\N, N_H, N(H, N)H,H[U, U]U, U/H/ SpaCe, tab

Data type

Some descriptions contain parenthesis enclosing a data type id.
These data types are stripped out along with the parenthesis.

Word capitalization

First letter of each remaining words is capitalized, and the remaining
letters of the each remaining word are all suppressed to lower case.

Note: HL7 standard specification uses tables to convey the message structure or
query message structure. However, even though each column contains
brief descriptive words, none of the table columns bears the name
“description” in the column title. That is to what “attribute description”
refers. In the follow example, “ADT message” column is equivalent to the
description column

* Marking convention

N/A

¢ Grammar
N/A

e Example:

The following example uses BO HL7_MTADT_A61.

Table 37. Attribute names of BO HL7_MTADT_A61, constructed from the message structure
of ADT_A61. ADT message column is the description of each attribute in the message

structure definition

HL7 message structure

ADT~A61"ADT”A61 ADT message Message BO attribute name
MSH Message handler Message Header

EVN Event type Phenotype

PID Patient identification Patient Identification
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Table 37. Attribute names of BO HL7_MTADT_A61, constructed from the message structure
of ADT_A61. ADT message column is the description of each attribute in the message
structure definition (continued)

HL7 message structure

ADT"A61"ADT A61 ADT message Message BO attribute name

[PD1] Additional Additional Demographics
demographics

PV1 Patient visit Potentialities

[{ROL}] Role Role

[PV2} Patient visit -- additional | Patient Visit Additional Info
information

Group BO

The property name attributes of the Group BO are summarized as follows:

Corresponding HL7 data element
Segments or segment subgroup of a given segment group with two or more
segments

Naming convention

HLT MT<message type> <Event code/query id> GP<group index>

where event code with the smallest lexigraphical value is applicable to the
message type/query and group index is unique in the scope of the message
structure. That is, the attribute name of Group BO is the same as its type

Marking convention
N/A

Grammar
N/A

Example:

The attribute name for the only group in BO HL_MTADT_AO3 is HL_MTADT_A03. See

the table under the heading Complex data types for more information.

Segment BO

The property name attributes of the Segment BO are summarized as follows:

Corresponding HL7 data element

— The field names, or element name, of the regular HL7 segment

— The parameter names of QPD, RDT segments of a conformance statement
Naming convention

<concatenation of words in the element name of regular segment or the
parameter name in the parameter table>

where event code with the smallest lexigraphical value is applicable to the
message type/query and group index is unique in the scope of the message
structure. That is, the attribute name of Group BO is the same as its type

Marking convention
N/A

Grammar
N/A

Example:
Using BO HL_SGQBD_Q21:
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Table 38. The attribute names of HL7_SGQBD_QZ21 and their HL7 counter parts

Attribute | Segment BO BO segment attribute

sequence attribute name type HL7 counter part

1 MessageQueryName |HL7_DTCE MessageQueryName (CE)

2 QueryTag HL7_DTENDCODEDTEXT QueryTag (ST)

3 Personldentifier HL7_DTCX Personldentifier

4 WhatDomains HL7_DTCX WhatDomainsReturned
Returned

The segmented for MSH contains these values:

Table 39.

SEQ MSH segment attribute name Element name

1 Field separator Field separator

2 Encoding characters Encoding characters
3 Sending application Sending application
4 Sending facility Sending facility

BO of complex data type

The property name attributes of the complex data type BO are summarized as
follows:

Corresponding HL7 data element
HL7 components in the definition data type except CM and Varies

* Naming convention
<concatenation of words in the component name ordinary data type or the
description column of regular segment or the parameter name in the
parameter table>
where the concatenation follows the rules listed in [Table 36 on page 62|
Additionally, the parenthesis at the end of the component, which used to
indicate the component data type, are filtered out

* Marking convention
N/A

e Grammar
N/A

* Example:
Using BO HL7_DTCP, which corresponds to the CP data type with the following
description:
<price (MO)> ~ <price type (ID)> ~ <from value (NM)> ~ <to value (NM)> ~
<range units (CE)> ~ <range type (ID)>

Table 40. Attribute names of BO complex data type HL7_DTCP as derived from the
component names of the CP data type

Attribute name of HL7_DTCP Component name of CP data type
Price Price

PriceType Price type

FromValue From value

ToValue To value

RangeUnits Range units
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Table 40. Attribute names of BO complex data type HL7 _DTCP as derived from the

component names of the CP data type (continued)

Attribute name of HL7_DTCP Component name of CP data type

RangeType Range type

Data type Union BO

The property name attributes of the Union BO are summarized as follows:

Corresponding to the HL7 data element

HL7 data type except CM and Varies
Data structure as listed in [Table 29 on page 56|

Primitive data type

Naming convention

<Name of complex data type>
Marking convention

N/A

Grammar

N/A

Example:
The name of attribute of type HL7_DTCP is HL7_DTCP , the name of attribute NM is
NM.

BO attribute property type

The following details the attribute property types for common business objects.

Message BO

The property type attributes of the Message BO are summarized as follows:

Corresponding to the HL7 data element
Attributes in segment groups or segments that make up the HL7 message
structure definition or query structure definition.

Naming convention
<BO names of corresponding segment group or segment>
Please see [“Message BO” on page 58| for details on how BOs are named.

Marking convention
N/A

Grammar
N/A

Example:
See BO HL7_MTADT_A61, [Table 37 on page 62| for the names of the attribute types.

Group BO

The property type attributes of the Group BO are summarized as follows:

Corresponding to the HL7 data element
Segments or segment subgroup of a given segment group with two or more
segments

Naming convention
<Name of segment BO in a segment group>
see [“Message BO” on page 54for a complete list of
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Marking convention
N/A

Grammar
N/A

Example:
See BO HL7_MTADT A61, [Table 37 on page 62|

Segment BO

The property type attributes of the Segment BO are summarized as follows:

Corresponding to the HL7 data element
— The fields of regular HL7 segment
— The parameter names of QPD, RDT segments of a conformance statement

Naming convention

<Name of BO of complex data type or the appropriate primitive data type >
Marking convention

N/A

Grammar

N/A

Example:
See [Table 38 on page 64}

BO of complex data type

The property type attributes of the complex data type are summarized as follows:

Corresponding to the HL7 data element
— The fields of regular HL7 segment

— Components of data structures listed in [Table 29 on page 56| of this document
for CM type

Naming convention
<Name of BO of complex data type that corresponds to the subconponent or
the appropriate primitive data type >

Marking convention
N/A

Grammar
N/A

Example:
See [Table 32 on page 60}

Data type Union BO

The property type attributes of the Union BO data type are summarized as follows:

Corresponding to the HL7 data element
— HL7 data type except CM and Varies

— Components of data structures listed in [Table 29 on page 56| of this document
for CM type

— Primitive data types

Naming convention
<Name of BO of complex data type that corresponds to the subconponent or
the appropriate primitive data type >

Marking convention
N/A
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Grammar
N/A
Example:

The name of attribute of typeHL7_DTCP is HL7_DTCP; the name of attribute of type
NM is NM

BO attribute property Iskey

The following details the attribute property Iskey for common business objects.

Message BO

Key attributes in the message BO bear no significance.

Corresponding to the HL7 data element
Attributes in segment groups or segments that make up the HL7 message
structure definition or query structure definition.

Naming convention

N/A

Marking convention

Set key to true for the first attribute of the message BO.

Example:
N/A

Group BO

Key attributes in the group BO bear no significance.

Corresponding to the HL7 data element
Segments or segment subgroup of a given segment group with two or more
segments

Naming convention

N/A

Marking convention

Set key to true for the first attribute of the group BO.

Example:
N/A

Segment BO

Key attributes in Segment BO are derived from ordinary segments and do not bear
any significance. Their presence is only to fulfill the architecture’s system
requirements, but are crucial to parameters in the QPD, RDT segments

Corresponding to the HL7 data element
The fields of regular HL7 segment
The parameter names of QPD, RDT segments of a conformance statement

Naming convention
N/A

Marking convention

— For all segment BO except segments of type QPD, RDT, set the first attribute
key to true

— For segments of type QPD, RDT, set key to true for attributes whose
corresponding parameter is marked as “Key”

Grammar
N/A
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Example:
N/A

BO of complex data type

Key attributes in BO of Complex Data Type do not bear any significance.

Corresponding to the HL7 data element
— HL7 components in the definition data type except CM and Varies

— Components of data structures listed in [Table 29 on page 56pf this document
for CM type

Naming convention
N/A

Marking convention

— All BO of complex data type, including those listed in [Table 29 on page 56and
primitive type attributes

— Set the IsKey property of the first attribute to true.

Grammar
N/A

Example:
N/A

BO attribute property IsForeignKey
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The following details the attribute property IsKey for common business objects.

Message BO

Key attributes in the message BO bear no significance.

Corresponding to the HL7 data element
Attributes in segment groups or segments that make up the HL7 message
structure definition or query structure definition.

Naming convention
N/A

Marking convention

Set IsForeignKey to false
Grammar

N/A

Example
N/A

Group BO

Corresponding to the HL7 data element
Segments or segment subgroup of a given segment group with two or more
segments

Naming convention
N/A

Marking convention

Set IsForeignKey to false

Example:
N/A
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Segment BO

Corresponding to the HL7 data element
— The fields of regular HL7 segment
— The parameter names of QPD, RDT segments of a conformance statement

Naming convention
N/A

Marking convention

Set IsForeignKey to false
Grammar

N/A

Example:

N/A

BO of complex data type

Key attributes in BO of Complex Data Type do not bear any significance.

Corresponding to the HL7 data element

— HL7 components in the definition data type except CM and Varies

— Components of data structures listed in [Table 29 on page 56pf this document
for CM type

Naming convention
N/A

Marking convention
Set IsForeignKey to false

Grammar
N/A
Example:
N/A

Data type Union BO

The property type attributes of the Union BO data type are summarized as follows:

Corresponding to the HL7 data element
— HL7 data type except CM and Varies

— Components of data structures listed in [Table 29 on page 56| of this document
for CM type

— Primitive data types

Naming convention
N/A

Marking convention

Set IsForeignKey to false
Grammar

N/A

Example:

N/A

BO attribute property Cardinality

The following details the attribute property Cardinality for common business
objects.
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Message BO

Key attributes in the message BO bear no significance.

¢ Corresponding to the HL7 data element
Attributes in segment groups or segments that make up the HL7 message
structure definition or query structure definition.

* Naming convention

N/A

* Marking convention
Segment group or segment that has {} brace: set cardinality to N else to 1

e Example:

The corresponding message BO for the ADT_A61 HL7 message structure for
message type ADT and event type A61 has following attributes:

Table 41. This example shows the attribute cardinality for each attribute of
HL7_MTADT_A61 and their HL7 counter parts

Attribute sequence | Attribute type HL7 counter part Cardinality
1 HL7_SGMSH MSH 1
2 HL7_SGEVN EVN 1
3 HL7_SGPID PID 1
4 HL7_SGPD1 [PD1] 1
5 HL7_SGV1 PVl 1
6 HL7_SGROL [{ROL}] N
7 HL7_SGPV2 [PV2] 1

Group BO

* Corresponding to the HL7 data element
Segments or segment subgroup of a given segment group with two or more
segments

* Naming convention
N/A

* Marking convention
Set IsForeignKey to false

e Example:
N/A

Segment BO
* Corresponding to the HL7 data element
— The fields of regular HL7 segment
— The parameter names of QPD, RDT segments of a conformance statement

* Naming convention
N/A

¢ Marking convention
Segment fields that have the RP# or RP column marked with "Y" or "y": set
cardinality to N else set to 1

¢ Grammar
N/A
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Example:
For BO HL7_SGQBD_Q21, the cardinality attribute for the HL7 message standard
specification for parameter definition for query Q21:

Table 42. This example shows the attribute cardinality for each attribute of
HL7_SGQBD_Q21 and their HL7 counter parts

Attribute sequence Sequence BO attribute name RP#/RP Cardinality
1 MessageQueryName 1
2 QueryTag 1
3 Personldentifier N 1
4 WhatDomainReturned Y N

BO of complex data type

Key attributes in BO of Complex Data Type do not bear any significance.

Corresponding to the HL7 data element
— HL7 components in the definition data type except CM and Varies

— Components of data structures listed in [Table 29 on page 56pf this document
for CM type

Naming convention
N/A

Marking convention
Set cardinality to 1

Grammar
N/A

Example
N/A

Data type Union BO

The property type attributes of the Union BO data type are summarized as follows:

Corresponding to the HL7 data element
— HL7 data type except CM and Varies

— Components of data structures listed in [Table 29 on page 56| of this document
for CM type

— Primitive data types

Naming convention
N/A

Marking convention
Set cardinality to 1
Grammar

N/A

Example:
N/A

BO attribute property MaxLength

The following details the attribute property MaxLength for common business
objects.
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Because the architecture BO does not have the notion of BO size, a characteristic
strongly exhibited in all HL7 data elements instead of just data element of
primitive type, the notion of Maximum Length can’t be conveyed in the traditional
manner through the MaxLength BO attributes property. This attribute property is
not used in BOs of all scopes of HL7 data element representation in order to
achieve uniformity in the representation of Maximum Length of HL7 data element.
Instead, the notion of Maximum Length of HL7 data element is conveyed through
the AppSpecificInfo. Since this version of the data handler does not support
validation, Maxlength as an AppSpecificInfo property does not take place in any
part of the BO of this release.

Because the MaxLength can be a decisive factor on whether BOs of certain size can
be stored in communication channels for certain brokers, it is still important to set

the correct value to this attribute property. If it is not mentioned, the default value

of this attribute property is 255 for all primitive attributes.

BO attribute property IsRequired
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The following details the attribute property IsRequired for common business
objects.

Message BO

* Corresponding to the HL7 data element
Attributes in segment groups or segments that make up the HL7 message
structure definition or query structure definition.

* Naming convention
N/A

* Marking convention
Set IsRequired to false if the HL7 message structure definition encloses the
segment or segment group with square bracket [], otherwise set the property to
true.

* Example:
The corresponding message BO for the ADT_A61 HL7 message structure for
message type ADT and event type A61 has following attributes:

Table 43. This example shows the attribute cardinality for each attribute of
HL7_MTADT_A61 and their HL7 counter parts

Attribute sequence | Attribute type HL7 counter part IsRequired
1 HL7_SGMSH MSH True
2 HL7_SGEVN EVN True
3 HL7_SGPID PID True
4 HL7_SGPD1 [PD1] False
5 HL7_SGV1 PV1 True
6 HL7_SGROL [{ROL} ] False
7 HL7_SGPV2 [PV2] False

Group BO

* Corresponding to the HL7 data element
Segments or segment subgroup of a given segment group with two or more
segments
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* Naming convention
N/A

* Marking convention
Segment group or segment BO that has [] brace: set IsRequired to false,
otherwise set to true

* Example:
N/A

Segment BO

* Corresponding to the HL7 data element
— The fields of regular HL7 segment
— The parameter names of QPD, RDT segments of a conformance statement

* Naming convention
N/A

* Marking convention
If the OPT column of segment field or query parameter is not set to O, then set
IsRequired property of corresponding attribute to false, otherwise set to true.

* Grammar
N/A

e Example:
For BO HL7_SGQBD_Q21, the IsRequired attribute for the HL7 message standard
specification for parameter definition for query Q21:

Table 44. This example shows the IsRequired attribute for HL7_SGQBD_Q21 and their HL7

counter parts

Attribute sequence Sequence BO attribute name OPT IsRequired
1 MessageQueryName R True

2 QueryTag R True

3 Personldentifier R True

4 WhatDomainReturned @) False

BO of complex data type
Key attributes in BO of Complex Data Type do not bear any significance.
* Corresponding to the HL7 data element
— HL7 components in the definition data type except CM and Varies

— Components of data structures listed in [Table 29 on page 56pf this document
for CM type

* Naming convention
N/A

¢ Marking convention
Set IsRequired to false

e Grammar
N/A

* Example:
N/A
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Data type Union BO
The property type attributes of the Union BO data type are summarized as follows:
¢ Corresponding to the HL7 data element
- HL7 data type except CM and Varies

— Components of data structures listed in [Table 29 on page 56| of this document
for CM type

— Primitive data types

* Naming convention
N/A

¢ Marking convention
Set IsRequired to false
* Grammar
N/A

* Example:
N/A

BO attribute property Relationship

The following details the attribute property Relationship for common business
objects.

Message BO

* Corresponding to the HL7 data element
Attributes in segment groups or segments that make up the HL7 message
structure definition or query structure definition.

* Naming convention
N/A

* Marking convention
Set Relationship to Containment

* Example:
N/A

Group BO

* Corresponding to the HL7 data element
Segments or segment subgroup of a given segment group with two or more
segments

* Naming convention
N/A

* Marking convention
Set Relationship to Containment

* Example:
N/A

Segment BO
* Corresponding to the HL7 data element
— The fields of regular HL7 segment
— The parameter names of QPD, RDT segments of a conformance statement

* Naming convention
N/A
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Marking convention
Set Relationship to Containment

Grammar
N/A

Example:
N/A

BO of complex data type

Key attributes in BO of Complex Data Type do not bear any significance.

Corresponding to the HL7 data element
— HL7 components in the definition data type except CM and Varies

— Components of data structures listed in [Table 29 on page 56pf this document
for CM type

Naming convention

N/A

Marking convention

If the attribute type is BO, set Relationship to Containment, otherwise take out
the attribute property when working with BO definition file

Grammar
N/A

Example:
N/A

Data type Union BO

The property type attributes of the Union BO data type are summarized as follows:

Corresponding to the HL7 data element
— HL7 data type except CM and Varies

— Components of data structures listed in [Table 29 on page 56| of this document
for CM type

— Primitive data types

Naming convention

N/A

Marking convention

If the attribute type is BO, set Relationship to Containment, otherwise take out
the attribute property when working with BO definition file

Grammar
N/A

Example:
N/A

BO attribute property AppSpecificinfo

The following details the attribute property Relationship for common business
objects.

Message BO

Corresponding to the HL7 data element
Attributes in segment groups or segments that make up the HL7 message
structure definition or query structure definition.
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* Naming convention
N/A

* Marking convention
N/A

* Example:
N/A

Group BO

* Corresponding to the HL7 data element
Segments or segment subgroup of a given segment group with two or more
segments

* Naming convention
N/A

* Marking convention
N/A

e Example:
N/A

Segment BO

* Corresponding to the HL7 data element
— The fields of regular HL7 segment
— The parameter names of QPD, RDT segments of a conformance statement

* Naming convention
N/A

¢ Marking Convention
N/A

e Grammar

— All data types other than CM: StructType=DataType;DataTypeID=<HL7 data
type ID>

— DT BO listed in [Table 29 on page 56| StructType=DataType;DataTypeID=CM
* Example:

— For attribute that corresponds to the ST data type, the AppSpecificInfo is
StructType=DataType;DataTypelID=ST; MaxLength=199

— For attribute whose type is HL7_DTMSG as defined in [Table 29 on page 56|
the AppSpecificInfo is StructType=DataType;DataTypelD=CM

BO of complex data type
Key attributes in BO of Complex Data Type do not bear any significance.
* Corresponding to the HL7 data element
— HL7 components in the definition data type except CM and Varies

— Components of data structures listed in [Table 29 on page 56| of this document
for CM type

* Naming convention
N/A

e Marking convention
If the attribute type is BO, set Relationship to Containment, otherwise take out
the attribute property when working with BO definition file

¢ Grammar
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— All data types other than CM, MA, NA, QIP and Varies
StructType=DataType;DataTypelD=<HL7 data type ID>

— DT BO listed in [Table 29 on page 56|, StructType=DataType;DataTypeID=CM
- MA, NA and QIP type BO

— Union BO for varies data type StructType=Union;TypeContext=<reference
path at where the data type is specified in the BO structure>

TypeContext is used to indicate where in the BO structure to retrieve the data
type announcer information such as the CM or NM for the data carrier.

The path can be relative or can also be absolute path where the root is the
top-most parent BO.

Since the RDT segment definition expects user to provide definition for each of
the columns and hence does not consist of column of varies data type, the need
to supporting absolute path is not warranted. This release only supports the
relative path.

In this release, the relative pathname is defined as BO attribute name of the one
of data type announcer

* Example:

Table 45. This example shows the attribute AppSpecificinfo for each attribute of HL7_DTCQ

and their HL7 counter parts

Attribute

sequence Attribute name Attribute type ASI

1 Quantity Float DataTypelD=NM
2 Units HL7_DTCE DataTypelD=CM

The ObservationValue attribute of BO HL7_SGOBX, which corresponds to the OBX-5
(varies) and is depended on the data type announcer located at OBX-2, has
AppSpecificInfo StructType=Union;TypeContext=ValueType

Here the path to the data type announcer is "ValueType”, which is just the attribute
name. Because both the "ValueType” and "ObservationValue” attributes are located
in the same BO, this path is a relative path.

Data type Union BO

The property type attributes of the Union BO data type are summarized as follows:

* Corresponding to the HL7 data element
— HL7 data type except CM and Varies

— Components of data structures listed in [Table 29 on page 56| of this document

for CM type

— Primitive data types

¢ Naming convention

N/A

* Marking convention

N/A

¢ Grammar

— All Data type other than CM StructType=DataType;DataTypeID=<HL7 data

type ID>

— CM type BO listed in [Table 29 on page
E6| StructType=DataType;DataTypeID=CM
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— MA, NA type BO listed in [Table 29 on page 56|
StructType=Array;DataTypeID=<MA or NA, whichever appropriate data type
ID>

* Example:

For attribute that corresponds to the ST data type, the AppSpecificInfo is
StructType=DataType;DataTypelD=STFor an attribute whose type is HL7_DTMSG
as defined in [Table 29 on page 56} the AppSpecificInfo is
StructType=DataType;DataTypelID=CM

HL7 Business Objects

The two included sample health care business objects are:
¢ BIA_MO_DataHandler_Healthcare.txt
* BIA_MO_DataHandler_HI7.txt

BIA_MO_DataHandler Healthcare.txt

The BIA_MO_DataHandler_Health.txt is located in the
WebSphereBl/connectors/Healthcare/samples/ folder.

[ReposCopy]
Version = 3.0.0
[End]

[BusinessObjectDefinition]
Name = BIA_MO_DataHandler_Healthcare
Version = 1.0.0

[Attribute]

Name = ncpdp

Type = BIA_MO_DataHandler NCPDP
ContainedObjectVersion = 3.0.0
ReTationship = Containment
Cardinality = 1

MaxLength =

IsKey = true

IsForeignKey = false
IsRequired = false
IsRequiredServerBound = false
[End]

[Attribute]

Name = h17

Type = BIA_MO_DataHandler HL7
ContainedObjectVersion = 3.0.0
Relationship = Containment
Cardinality =1

MaxLength =

IsKey = false

IsForeignKey = false
IsRequired = false
IsRequiredServerBound = false
[End]

[Attribute]

Name = ObjectEventId

Type = String

Cardinality =1

MaxLength = 255

IsKey = false

IsForeignkKey = false
IsRequired = false
IsRequiredServerBound = false
[End]
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[Verb]
Name = Create
[End]

[Verb]
Name = Delete
[End]

[Verb]
Name = Retrieve
[End]

[Verb]
Name = Update
[End]
[End]

BIA_MO_DataHandler HL7.txt

The BIA_MO_DataHandler_HL7.txt is located in the
WebSphereBl/connectors/Healthcare/samples/ folder.

[ReposCopy] Version = 3.0.0 [End] [BusinessObjectDefinition] Name =

BIA_MO DataHandler_HL7 Version = 3.0.0 [Attribute] Name = ClassName Type =
String Cardinality = 1 MaxLength = 255 IsKey = false IsForeignKey = false
IsRequired = false DefaultValue =
com.ibm.adapters.datahandlers.h17.HL7DataHandler IsRequiredServerBound =
false [End] [Attribute] Name = BOPrefix Type = String Cardinality = 1
MaxLength = 255 IsKey = false IsForeignkKey = false IsRequired = false
DefaultValue = HL7 IsRequiredServerBound = false [End] [Attribute] Name =
Representation Type = String Cardinality = 1 MaxLength = 255 IsKey = false
IsForeignKey = false IsRequired = false DefaultValue = simplified
IsRequiredServerBound = false [End] [Attribute] Name = FieldDelimiter Type
= String Cardinality = 1 MaxLength = 255 IsKey = false IsForeignKey = false
IsRequired = false DefaultValue = | IsRequiredServerBound = false [End]
[Attribute] Name = ComponentDelimiter Type = String Cardinality = 1
MaxLength = 255 IsKey = false IsForeignkKey = false IsRequired = false
DefaultValue = ~ IsRequiredServerBound = false [End] [Attribute] Name =
RepetitionDelimiter Type = String Cardinality = 1 MaxLength = 255 IsKey =
true IsForeignKey = false IsRequired = false DefaultValue = ©
IsRequiredServerBound = false [End] [Attribute] Name = EscapeDelimiter Type
= String Cardinality = 1 MaxLength = 255 IsKey = true IsForeignKey = false
IsRequired = false DefaultValue = \ IsRequiredServerBound = false [End]
[Attribute] Name = SubcomponentDelimiter Type = String Cardinality = 1
MaxLength = 255 IsKey = false IsForeignKey = false IsRequired = false
DefaultValue = & IsRequiredServerBound = false [End] [Attribute] Name =
MTEventMap Type = String Cardinality = 1 MaxLength = 255 IsKey = false
IsForeignKey = false IsRequired = false DefaultValue =
file=C:\x\WebSphereAdapters\connectors\Healthcare\dependencies\

h17\BIA HL7MTEventMap.cfg IsRequiredServerBound = false [End] [Attribute]
Name = I18N Type = String Cardinality = 1 MaxLength = 255 IsKey = false
IsForeignKey = false IsRequired = false DefaultValue =
file=C:\x\WebSphereAdapters\connectors\Healthcare\dependencies\
h17\BIA_HL7I18N.cfg IsRequiredServerBound = false [End] [Attribute] Name =
DummyKey Type = String Cardinality = 1 MaxLength = 255 IsKey = false
IsForeignKey = false IsRequired = false DefaultValue = dummy
IsRequiredServerBound = false [End] [Attribute] Name = DefaultVerb Type =
String Cardinality = 1 MaxLength = 255 IsKey = false IsForeignKey = false
IsRequired = false DefaultValue = Create IsRequiredServerBound = false
[End] [Attribute] Name = EnableStackTrace Type = String Cardinality = 1
MaxLength = 255 IsKey = false IsForeignKey = false IsRequired = false
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DefaultValue = true IsRequiredServerBound = false [End] [Attribute] Name =
ObjectEventId Type = String Cardinality = 1 MaxLength = 255 IsKey = false
IsForeignKey = false IsRequired = false IsRequiredServerBound = false [End]
[Verb] Name = Create [End] [Verb] Name = Delete [End] [Verb] Name =
Retrieve [End] [Verb] Name = Update [End] [End]
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Chapter 4. Troubleshooting

This chapter describes problems that you may encounter when starting up or

running the connector.

Startup problems

Problem

The connector shuts down unexpectedly during
initialization and the following message is reported:
Exception in thread "main"
java.lang.NoClassDefFoundError:
javax/jms/JMSException...

The connector shuts down unexpectedly during
initialization and the following message is reported:
Exception in thread "main"
java.lang.NoClassDefFoundError:
com/ibm/mq/jms/MQConnectionFactory...

The connector shuts down unexpectedly during
initialization and the following message is reported:
Exception in thread "main"
java.lang.NoClassDefFoundError:
javax/naming/Referenceable...

The connector shuts down unexpectedly during
initialization and the following exception is reported:
java.lang.UnsatisfiedLinkError: no mqjbnd05 [Windows
2003]1in shared library path

The connector reports MQIMS2005: failed to create
MQQueueManager for ':'

Potential solution / explanation

Connector cannot find file jms.jar from the IBM
WebSphere MQ Java client libraries. Ensure that variable
MQSERIES_JAVA_LIB in start_connector.bat points to the
IBM WebSphere MQ Java client library folder.

Connector cannot find file com.ibm.mgjms.jar in the IBM
WebSphere MQ Java client libraries. Ensure that variable
MQSERIES_JAVA_LIB in start_connector.bat points to the
IBM WebSphere MQ Java client library folder.

Connector cannot find file jndi.jar from the IBM
WebSphere MQ Java client libraries. Ensure that variable
MQSERIES_JAVA_LIB in start_connector.bat points to the
IBM WebSphere MQ Java client library folder.

Connector cannot find a required runtime library for
mqjbnd05.d11 [Windows 2003]or Tibmgjbnd05.so [Linux])
from the IBM WebSphere MQ Java client libraries. Ensure
that your path includes the IBM WebSphere MQ Java
client library folder.

Explicitly set values for the following properties:
QueueManager, HostName, Channel, and Port.

Event processing

Problem

The connector delivers all messages with an MQRFH2
header.

The connector truncates all message formats to 8
characters upon delivery regardless of how the format
has been defined in the connector meta-object.

Potential solution / explanation

To deliver messages with only the MQMD WebSphere
MQ header, append ?targetClient=1 to the name of
output queue URI. For example, if you output messages
to queue queue://my.queue.manager/0UT, change the URI
to queue://my.queue.manager/0UT?targetClient=1. See
[Chapter 2, “Configuring the connector,” on page 15| for
more information.

This is a limitation of the WebSphere MQ MQMD
message header and not the connector.
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Appendix A. Standard configuration properties for connectors

This appendix describes the standard configuration properties for the connector
component of WebSphere Business Integration Server Express adapters. The
information covers InterChange Server Express.

For information about properties specific to this connector, see the relevant section
in this guide.

New properties

These standard properties have been added in this release:
* AdapterHelpName

* ControllerEventSequencing

* jms.ListenerConcurrency

* jms.TransportOptimized

¢ TivoliTransactionMonitorPerformance

Standard connector properties overview

Connectors have two types of configuration properties:
 Standard configuration properties, which are used by the framework

* Application, or connector-specific, configuration properties, which are used by
the agent

These properties determine the adapter framework and the agent run-time
behavior.

This section describes how to start Connector Configurator Express and describes
characteristics common to all properties. For information on configuration
properties specific to a connector, see its adapter user guide.

Starting Connector Configurator Express

You configure connector properties from Connector Configurator Express, which
you access from System Manager. For more information on using Connector
Configurator Express, refer to the sections on Connector Configurator Express in
this guide.

Connector Configurator Express and System Manager run only on the Windows
system. If you are running the connector on a Linux system, you must have a
Windows machine with these tools installed.

To set connector properties for a connector that runs on Linux, you must start up
System Manager on the Windows machine, connect to the Linux integration broker,
and bring up Connector Configurator Express for the connector.

Configuration property values overview
The connector uses the following order to determine a property’s value:
1. Default
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2. Repository for InterChange Server Express integration broker.
3. Local configuration file
4. Command line

The default length of a property field is 255 characters. There is no limit on the
length of a STRING property type. The length of an INTEGER type is determined
by the server on which the adapter is running.

A connector obtains its configuration values at startup. If you change the value of
one or more connector properties during a run-time session, the property’s update
method determines how the change takes effect.

The update characteristics of a property, that is, how and when a change to the
connector properties takes effect, depend on the nature of the property.

There are four update methods for standard connector properties:

* Dynamic
The new value takes effect immediately after the change is saved in System
Manager. However, if the connector is in stand-alone mode (independently of
System Manager).

* Agent restart (InterChange Server Express only)
The new value takes effect only after you stop and restart the connector agent.

* Component restart
The new value takes effect only after the connector is stopped and then restarted
in System Manager. You do not need to stop and restart the agent or the server
process.

* System restart
The new value takes effect only after you stop and restart the connector agent
and the server.

To determine how a specific property is updated, refer to the Update Method
column in the Connector Configurator Express window, or see the Update Method
column in [Table 46 on page 85|

There are three locations in which a standard property can reside. Some properties
can reside in more than one location.

* ReposController
The property resides in the connector controller and is effective only there. If
you change the value on the agent side, it does not affect the controller.

* ReposAgent
The property resides in the agent and is effective only there. A local
configuration can override this value, depending on the property.

* LocalConfig
The property resides in the configuration file for the connector and can act only
through the configuration file. The controller cannot change the value of the
property, and is not aware of changes made to the configuration file unless the
system is redeployed to update the controller explicitly.
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Standard properties quick-reference

provides a quick-reference to the standard connector configuration
properties. Not all connectors require all of these properties, and property settings

may differ. .

See the section following the table for a description of each property.

Note: In the Notes column in [Table 46} the phrase “RepositoryDirectory is set to
<REMOTE>" indicates that the broker is InterChange Server Express.

Table 46. Summary of standard configuration properties

Property name

Possible values

Default value

Update method

Notes

AdapterHelpName One of the valid Template name, if valid, |Component Supported regional
subdirectories in or blank field restart settings.
<ProductDir>\bin\Data\ Include chs_chn,
App\Help that has a valid cht_twn, deu_deu,
<Regional Setting> esn_esp, fra_fra,
directory ita_ita, jpn_jpn,

kor_kor, ptb_bra,
and enu_usa (default).

AdminInQueue Valid JMS queue name <CONNECTORNAME> Component This property is valid

/ADMININQUEUE restart only when the value
of DeliveryTransport
is JMS

AdminOutQueue Valid JMS queue name <CONNECTORNAME> Component This property is valid

/ADMINOUTQUEUE restart only when the value
of DeliveryTransport
is JMS

AgentConnections 1 through 4 1 Component This property is valid

restart only when the value
of DeliveryTransport
is MQ or IDL, the value
of Repository Directory
is set to <REMOTE>
and the value of
BrokerType is
InterChange
Server Express.
AgentTraceLevel 0 through 5 0 Dynamic
for InterChange
Server Express;
otherwise
Component
restart
ApplicationName Application name The value specified for Component
the connector restart
application name

BrokerType InterChange Server InterChange Server Component
Express Express restart

CharacterEncoding Any supported code. ascii7 Component This property is valid
The list shows this subset: restart only for C++
ascii7, ascii8, SJIS, connectors.

Cp949, GBK, Bigs,
Cp297, Cp273, Cp280,
Cp284, Cp037, Cp437

CommonEventInfrastruc true or false false Component

ture restart

CommonEventInfrastruc A URL string, for No default value. Component This property is valid

tureURL example, restart only if the value of
corbaloc:iiop: CommonEvent
host:2809. Infrastructure is true.
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Table 46. Summary of standard configuration properties (continued)

Property name

Possible values

Default value

Update method

Notes

ConcurrentEventTrig
geredFlows

1 through 32,767

1

Component
restart

This property is valid
only if the value of
RepositoryDirectory
is set to <REMOTE>
and the value of
BrokerType is
InterChange

Server Express.

ContainerManagedEvents

Blank or JMS

Blank

Component
restart

This property is valid
only when the value
of Delivery Transport
is JMS.

ControllerEventSequenc
ing

true or false

true

Dynamic

This property is valid
only if the value of
Repository Directory
is set to <REMOTE>
and the value of
BrokerType is
InterChange

Server Express.

ControllerStoreAndFor
wardMode

true or false

true

Dynamic

This property is valid
only if the value of
Repository Directory
is set to <REMOTE>
and the value of
BrokerType is
InterChange

Server Express.

ControllerTraceLevel

0 through 5

Dynamic

This property is valid
only if the value of
RepositoryDirectory
is set to <REMOTE>
and the value of
BrokerType is
InterChange

Server Express.

DeliveryQueue

Any valid JMS
queue name

<CONNECTORNAME>
/DELIVERYQUEUE

Component
restart

This property is valid
only when the value
of Delivery Transport
is JMS.

DeliveryTransport

IDL or JMS

IDL when the value of
RepositoryDirectory is
<REMOTE>, otherwise
JMS

Component
restart

If the value of
RepositoryDirectory is
not <REMOTE>,

the only valid value for
this property is JMS.

DuplicateEventElimina
tion

true or false

false

Component
restart

This property is valid
only if the value of
DeliveryTransport is
Jms.

EnableOidForFlowMoni
toring

true or false

false

Component
restart

This property is valid
only if the value of
BrokerType is
InterChange

Server Express.

FaultQueue

Any valid queue name.

<CONNECTORNAME>
/FAULTQUEUE

Component
restart

This property is

valid only if the value
of DeliveryTransport
is JMS.

jms.FactoryClassName

CxCommon.Messaging.jms
. IBMMQSeriesFactory,
CxCommon.Messaging
.jms.SonicMQFactory,
or any Java class name

CxCommon.Messaging.
jms.IBMMQSeriesFactory

Component
restart

This property is

valid only if the value
of DeliveryTransport
is JMS.

jms.ListenerConcurrency

1 through 32767

Component
restart

This property is

valid only if the value of
jms.TransportOptimized
is true.
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Table 46. Summary of standard configuration properties (continued)

Property name

Possible values

Default value

Update method

Notes

jms.MessageBrokerName

If the value of
jms.FactoryClassName
is IBM, use
crossworlds.queue.
manager.

crossworlds.queue.
manager

Component
restart

This property is valid
only if the value of
DeliveryTransport

is JMS

jms.NumConcurrent
Requests

Positive integer

10

Component
restart

This property is valid
only if the value of
DeliveryTransport

is JMS

jms.Password

Any valid password

Component
restart

This property is valid
only if the value of
DeliveryTransport

is JMS

jms.TransportOptimized

true or false

false

Component
restart

This property is valid
only if the value of
DeliveryTransport

is JMS and the value of
BrokerType is
InterChange

Server Express.

jms.UserName

Any valid name

Component
restart

This property is valid
only if the value of
Delivery Transport

is JMS.

JvmMaxHeapSize

Heap size in megabytes

128m

Component
restart

This property is valid
only if the value of
Repository Directory
is set to <REMOTE>
and the value of
BrokerType is
InterChange

Server Express.

JvmMaxNativeStackSize

Size of stack in kilobytes

128k

Component
restart

This property is valid
only if the value of
Repository Directory
is set to <REMOTE>
and the value of
BrokerType is
InterChange

Server Express.

JvmMinHeapSize

Heap size in megabytes

Im

Component
restart

This property is valid
only if the value of
Repository Directory
is set to <REMOTE>
and the value of
BrokerType is
InterChange

Server Express.

ListenerConcurrency

1 through 100

Component
restart

This property is valid
only if the value

of DeliveryTransport
is MQ.

Locale

This is a subset of the
supported locales:
en_US, ja_JP, ko KR,
zh_CN, zh_TW, fr_FR,
de DE, it_IT,

es_ES, pt_BR

en_US

Component
restart

LogAtInterchangeEnd

true or false

false

Component
restart

This property is valid
only if the value of
Repository Directory
is set to <REMOTE>
and the value of
BrokerType is
InterChange

Server Express.
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Table 46. Summary of standard configuration properties (continued)

Property name

Possible values

Default value

Update method

Notes

MaxEventCapacity 1 through 2147483647 2147483647 Dynamic This property is valid
only if the value of
Repository Directory
is set to <REMOTE>
and the value of
BrokerType is
InterChang
Server Express.
MessageFileName Valid file name InterchangeSystem.txt Component
restart
MonitorQueue Any valid queue name <CONNECTORNAME> Component This property is valid
/MONITORQUEUE restart only if the value of
DuplicateEvent
Elimination
is true and
ContainerManaged
Events
has no value.
OADAutoRestartAgent true or false false Dynamic This property is valid
only if the value of
Repository Directory
is set to <REMOTE>
and the value of
BrokerType is
InterChange
Server Express.
OADMaxNumRetry A positive integer 1000 Dynamic This property is valid
only if the value of
Repository Directory
is set to <REMOTE>
and the value of
BrokerType is
InterChange
Server Express.
OADRetryTimeInterval A positive integer 10 Dynamic This property is valid
in minutes only if the value of
Repository Directory
is set to <REMOTE>
and the value of
BrokerType is
InterChange
Server Express.
PollEndTime HH = 0 through 23 HH:MM Component
MM = 0 through 59 restart
PollFrequency A positive integer 10000 Dynamic
(in milliseconds) if broker is
InterChange
Server Express;
otherwise
Component
restart
PollQuantity 1 through 500 1 Agent restart This property is valid
only if the value of
ContainerManagedEvents
is JMS.
PollStartTime HH = 0 through 23 HH:MM Component
MM = 0 through 59 restart
RepositoryDirectory <REMOTE> if the broker For InterChange Agent restart
is InterChange Server Express, the
Server Express; value is set
otherwise any to <REMOTE>
valid local
directory.
RequestQueue Valid JMS queue name <CONNECTORNAME> Component This property is valid
/REQUESTQUEUE restart only if the value of

DeliveryTransport
is JMS
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Table 46. Summary of standard configuration properties (continued)

Property name

Possible values

Default value

Update method

Notes

ResponseQueue Valid JMS queue name <CONNECTORNAME> Component This property is valid
/RESPONSEQUEUE restart only if the value of
DeliveryTransport is JMS.
RestartRetryCount 0 through 99 3 Dynamic
if InterChange
Server Express;
otherwise
Component
restart
RestartRetryInterval A value in minutes 1 Dynamic
from 1 through if InterChange
2147483647 Server Express;
otherwise
Component
restart
RHF2MessageDomain mrm or xml mrm Component This property is valid
restart only if the value
of DeliveryTransport
is JMS and the value of
WireFormat is Cwe.
SourceQueue Any valid WebSphere <CONNECTORNAME> Agent restart This property is valid
MQ queue name /SOURCEQUEUE only if the value of
ContainerManagedEvents
is JMS.
SynchronousRequest Any valid queue name. <CONNECTORNAME> Component This property is valid
Queue /SYNCHRONOUSREQUEST restart only if the value
QUEUE of DeliveryTransport
is JMS.
SynchronousRequest 0 to any number 0 Component This property is valid
Timeout (milliseconds) restart only if the value
of DeliveryTransport
is JMS.
SynchronousResponse Any valid queue name <CONNECTORNAME> Component This property is valid
Queue /SYNCHRONOUSRESPONSE restart only if the value
QUEUE of DeliveryTransport
is JMS.
TivoliMonitorTransaction true or false false Component
Performance restart
WireFormat CwXML or CwBO CwXML Agent restart The value of this
property must be CwXML
if the value
of RepositoryDirectory
is not set to
<REMOTE>.
The value must
be CwBO if the value of
RepositoryDirectory
is set to
<REMOTE>.
WsifSynchronousRequest 0 to any number 0 Component This property is
Timeout (milliseconds) restart not valid if the
value of
BrokerType is
InterChange
Server Express.
XMLNameSpaceFormat short or Tong short Agent restart This property is

not valid

if the value

of BrokerType
is InterChange
Server Express.

Standard properties

This section describes the standard connector configuration properties.
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AdapterHelpName

The AdapterHelpName property is the name of a directory in which
connector-specific extended help files are located. The directory must be located in
<ProductDir>\bin\Data\ App\Help and must contain at least the language
directory enu_usa. It may contain other directories according to locale.

The default value is the template name if it is valid, or it is blank.

AdmininQueue

The AdminInQueue property specifies the queue that is used by the integration
broker to send administrative messages to the connector.

The default value is <CONNECTORNAME>/ADMININQUEUE

AdminOutQueue

The AdminOutQueue property specifies the queue that is used by the connector to
send administrative messages to the integration broker.

The default value is <CONNECTORNAME>/ADMINOUTQUEUE

AgentConnections

The AgentConnections property controls the number of ORB (Object Request
Broker) connections opened when the ORB initializes.

The default value of this property is 1.

AgentTraceLevel

The AgentTraceLevel property sets the level of trace messages for the
application-specific component. The connector delivers all trace messages
applicable at the tracing level set and lower.

The default value is 0.

ApplicationName

The ApplicationName property uniquely identifies the name of the connector
application. This name is used by the system administrator to monitor the
integration environment. This property must have a value before you can run the
connector.

The default is the name of the connector.

BrokerType

The BrokerType property identifies the integration broker type that you are using.
The value is ICS for InterChange Server Express.

CharacterEncoding

The CharacterEncoding property specifies the character code set used to map from
a character (such as a letter of the alphabet, a numeric representation, or a
punctuation mark) to a numeric value.

Note: Java-based connectors do not use this property. C++ connectors use the
value ascii7 for this property.
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By default, only a subset of supported character encodings is displayed. To add
other supported values to the list, you must manually modify the
\Data\Std\stdConnProps.xml file in the product directory (<ProductDir>). For
more information, see the Connector Configurator Express appendix in this guide.

ConcurrentEventTriggeredFlows

The ConcurrentEventTriggeredFlows property determines how many business
objects can be concurrently processed by the connector for event delivery. You set
the value of this attribute to the number of business objects that are mapped and
delivered concurrently. For example, if you set the value of this property to 5, five
business objects are processed concurrently.

Setting this property to a value greater than 1 allows a connector for a source
application to map multiple event business objects at the same time and deliver
them to multiple collaboration instances simultaneously. This speeds delivery of
business objects to the integration broker, particularly if the business objects use
complex maps. Increasing the arrival rate of business objects to collaborations can
improve overall performance in the system.

To implement concurrent processing for an entire flow (from a source application
to a destination application), the following properties must configured:

* The collaboration must be configured to use multiple threads by setting its
Maximum number of concurrent events property high enough to use multiple
threads.

* The destination application’s application-specific component must be configured
to process requests concurrently.

The ConcurrentEventTriggeredFlows property has no effect on connector polling,
which is single-threaded and is performed serially.

This property is valid only if the value of the RepositoryDirectory property is set
to <REMOTE>.

The default value is 1.

ContainerManagedEvents

The ContainerManagedEvents property allows a JMS-enabled connector with a
JMS event store to provide guaranteed event delivery, in which an event is
removed from the source queue and placed on the destination queue as one JMS
transaction.

When this property is set to JMS, the following properties must also be set to
enable guaranteed event delivery:

* PollQuantity = 1 to 500
* SourceQueue = /SOURCEQUEUE

You must also configure a data handler with the MimeType and DHClass (data
handler class) properties. You can also add DataHandlerConfigMOName (the
meta-object name, which is optional). To set those values, use the Data Handler
tab in Connector Configurator Express.

Although these properties are adapter-specific, here are some example values:
* MimeType = text\xml
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e DHClass = com.crossworlds.DataHandlers.text.xml
* DataHandlerConfigMOName = MO_DataHandler_Default

The fields for these values in the Data Handler tab are displayed only if you have
set the ContainerManagedEvents property to the value JMS.

Note: When ContainerManagedEvents is set to JMS, the connector does not call its
pollForEvents() method, thereby disabling that method’s functionality.

The ContainerManagedEvents property is valid only if the value of the
DeliveryTransport property is set to JMS.

There is no default value.

ControllerEventSequencing

The ControllerEventSequencing property enables event sequencing in the connector
controller.

This property is valid only if the value of the RepositoryDirectory property is set
to set to <REMOTE> (BrokerType is InterChange Server Express).

The default value is true.

ControllerStoreAndForwardMode

The ControllerStoreAndForwardMode property sets the behavior of the connector
controller after it detects that the destination application-specific component is
unavailable.

If this property is set to true and the destination application-specific component is
unavailable when an event reaches InterChange Server Express, the connector
controller blocks the request to the application-specific component. When the
application-specific component becomes operational, the controller forwards the
request to it.

However, if the destination application’s application-specific component becomes
unavailable after the connector controller forwards a service call request to it, the
connector controller fails the request.

If this property is set to false, the connector controller begins failing all service
call requests as soon as it detects that the destination application-specific
component is unavailable.

This property is valid only if the value of the RepositoryDirectory property is set
to <REMOTE> (the value of the BrokerType property is InterChange Server
Express).

The default value is true.

ControllerTraceLevel

The ControllerTraceLevel property sets the level of trace messages for the
connector controller.

This property is valid only if the value of the RepositoryDirectory property is set
to set to <REMOTE>.
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The default value is 0.

DeliveryQueue

The DeliveryQueue property defines the queue that is used by the connector to
send business objects to the integration broker.

This property is valid only if the value of the DeliveryTransport property is set to
JMS.

The default value is <CONNECTORNAME>/DELIVERYQUEUE.

DeliveryTransport

The DeliveryTransport property specifies the transport mechanism for the delivery
of events. For Java Messaging Service, the value is JMS.

e If the value of the RepositoryDirectory property is set to <REMOTE>, the value
of the DeliveryTransport property can be IDL or JMS, and the default is IDL.

* If the value of the RepositoryDirectory property is a local directory, the value
can be only JMS.

The connector sends service-call requests and administrative messages over
CORBA 1IIOP if the value of the RepositoryDirectory property is IDL.

The default value is JMS.
JMS

The JMS transport mechanism enables communication between the connector and
client connector framework using Java Messaging Service (JMS).

If you select JMS as the delivery transport, additional JMS properties such as

jms .MessageBrokerName, jms.FactoryClassName, jms.Password, and jms.UserName
are listed in Connector Configurator Express. The properties
Jjms.MessageBrokerName and jms.FactoryClassName are required for this transport.

There may be a memory limitation if you use the JMS transport mechanism for a
connector in the following environment when InterChange Server Express is the
integration broker.

In this environment, you may experience difficulty starting both the connector
controller (on the server side) and the connector (on the client side) due to memory
use within the WebSphere MQ client. If your installation uses less than 768MB of
process heap size, set the following variable and property:

* Set the LDR_CNTRL environment variable in the CWSharedEnv.sh script.
This script is located in the \bin directory below the product directory

(<ProductDir>). Using a text editor, add the following line as the first line in the
CWSharedEnv.sh script:

export LDR_CNTRL=MAXDATA=0x30000000

This line restricts heap memory usage to a maximum of 768 MB (3 segments *
256 MB). If the process memory grows larger than this limit, page swapping can
occur, which can adversely affect the performance of your system.

* Set the value of the IPCCBaseAddress property to 11 or 12. For more
information on this property, see the WebSphere Business Integration Server Express
Installation Guide for Windows, for Linux, or for i5/OS.
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DuplicateEventElimination

When the value of this property is true, a JMS-enabled connector can ensure that
duplicate events are not delivered to the delivery queue. To use this feature, during
connector development, the connector must have a unique event identifier set as
the business object ObjectEventld attribute in the application-specific code.

Note: When the value of this property is true, the MonitorQueue property must
be enabled to provide guaranteed event delivery.

The default value is false.

EnableOidForFlowMonitoring

When the value of this property is true, the adapter runtime will mark the
incoming ObjectEventID as a foreign key for flow monitoring.

This property is only valid if the BrokerType property is set to ICS for InterChange
Server Express.

The default value is false.

FaultQueue

If the connector experiences an error while processing a message, it moves the
message (and a status indicator and description of the problem) to the queue
specified in the FaultQueue property.

The default value is <CONNECTORNAME>/FAULTQUEUE.

jms.FactoryClassName

The jms.FactoryClassName property specifies the class name to instantiate for a
JMS provider. This property must be set if the value of the DeliveryTransport
property is JMS.

The default is CxCommon.Messaging.jms.IBMMQSeriesFactory.

jms.ListenerConcurrency

The jms.ListenerConcurrency property specifies the number of concurrent listeners
for the JMS controller. It specifies the number of threads that fetch and process
messages concurrently within a controller.

This property is valid only if the value of the jms.OptimizedTransport property is
true.

The default value is 1.

jms.MessageBrokerName

The jms.MessageBrokerName specifies the broker name to use for the J]MS
provider. You must set this connector property if you specify JMS as the delivery
transport mechanism (in the DeliveryTransport property).

When you connect to a remote message broker, this property requires the following
values:

QueueMgrName : Channel :Hos tName : PortNumber

where:
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QueueMgrName is the name of the queue manager.

Channel is the channel used by the client.

HostName is the name of the machine where the queue manager is to reside.
PortNumberis the port number used by the queue manager for listening

For example:
jms.MessageBrokerName = WBIMB.Queue.Manager:CHANNEL1:RemoteMachine:1456

The default value is crossworlds.queue.manager. Use the default when connecting
to a local message broker.

jms.NumConcurrentRequests

The jms.NumConcurrentRequests property specifies the maximum number of
concurrent service call requests that can be sent to a connector at the same time.
Once that maximum is reached, new service calls are blocked and must wait for
another request to complete before proceeding.

The default value is 10.

jms.Password

The jms.Password property specifies the password for the J]MS provider. A value
for this property is optional.

There is no default value.

jms.TransportOptimized

The jms.TransportOptimized property determines if the WIP (work in progress) is
optimized. You must have a WebSphere MQ provider to optimize the WIP. For
optimized WIP to operate, the messaging provider must be able to:

1. Read a message without taking it off the queue

2. Delete a message with a specific ID without transferring the entire message to
the receiver’s memory space

3. Read a message by using a specific ID (needed for recovery purposes)

4. Track the point at which events that have not been read appear.

The JMS APIs cannot be used for optimized WIP because they do not meet
conditions 2 and 4 above, but the MQ Java APIs meet all four conditions, and

hence are required for optimized WIP.

This property is valid only if the value of DeliveryTransport is JMS and the value of
BrokerType is InterChange Server Express.

The default value is false.

jms.UserName

the jms.UserName property specifies the user name for the J]MS provider. A value
for this property is optional.

There is no default value.
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JvmMaxHeapSize

The JvmMaxHeapSize property specifies the maximum heap size for the agent (in
megabytes).

This property is valid only if the value for the RepositoryDirectory property is set
to <REMOTE>.

The default value is 128m.

JvmMaxNativeStackSize

The JvmMaxNativeStackSize property specifies the maximum native stack size for
the agent (in kilobytes).

This property is valid only if the value for the RepositoryDirectory property is set
to <REMOTE>.

The default value is 128k.

JvmMinHeapSize

The JvmMinHeapSize property specifies the minimum heap size for the agent (in
megabytes).

This property is valid only if the value for the RepositoryDirectory property is set
to <REMOTE>.

The default value is 1m.

ListenerConcurrency

The ListenerConcurrency property supports multithreading in WebSphere MQ
Listener when InterChange Server Express is the integration broker. It enables
batch writing of multiple events to the database, thereby improving system
performance.

This property valid only with connectors that use MQ transport. The value of the
DeliveryTransport property must be MQ.

The default value is 1.

Locale

The Locale property specifies the language code, country or territory, and,
optionally, the associated character code set. The value of this property determines
cultural conventions such as collation and sort order of data, date and time
formats, and the symbols used in monetary specifications.

A locale name has the following format:
Ul TT.codeset

where:

Il is a two-character language code (in lowercase letters)

TT is a two-letter country or territory code (in uppercase letters)

codeset is the name of the associated character code set (may be optional).
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By default, only a subset of supported locales are listed. To add other supported
values to the list, you modify the \Data\Std\stdConnProps.xml file in the
<ProductDir>\bin directory. For more information, refer to the Connector
Configurator Express appendix in this guide.

If the connector has not been internationalized, the only valid value for this
property is en_US. To determine whether a specific connector has been globalized,
refer to the user guide for that adapter.

The default value is en_US.

LogAtinterchangeEnd

The LogAtInterchangeEnd property specifies whether to log errors to the log
destination of the integration broker.

Logging to the log destination also turns on e-mail notification, which generates
e-mail messages for the recipient specified as the value of MESSAGE_RECIPIENT
in the InterchangeSystem.cfg file when errors or fatal errors occur. For example,
when a connector loses its connection to the application, if the value of
LogAtInterChangeEnd is true, an e-mail message is sent to the specified message
recipient.

This property is valid only if the value of the RespositoryDirectory property is set
to <REMOTE> (the value of BrokerType is InterChange Server Express).

The default value is false.

MaxEventCapacity

The MaxEventCapacity property specifies maximum number of events in the
controller buffer. This property is used by the flow control feature.

This property is valid only if the value of the RespositoryDirectory property is set
to <REMOTE> (the value of BrokerType is InterChange Server Express).

The value can be a positive integer between 1 and 2147483647.

The default value is 2147483647.

MessageFileName

The MessageFileName property specifies the name of the connector message file.
The standard location for the message file is \connectors\messages in the product
directory. Specify the message file name in an absolute path if the message file is
not located in the standard location.

If a connector message file does not exist, the connector uses
InterchangeSystem.txt as the message file. This file is located in the product

directory.

Note: To determine whether a connector has its own message file, see the
individual adapter user guide.

The default value is InterchangeSystem.txt.

Appendix A. Standard configuration properties for connectors 97



MonitorQueue

The MonitorQueue property specifies the logical queue that the connector uses to
monitor duplicate events.

It is valid only if the value of the DeliveryTransport property is JMS and the value
of the DuplicateEventElimination is true.

The default value is <CONNECTORNAME>/MONITORQUEUE

OADAutoRestartAgent

the OADAutoRestartAgent property specifies whether the connector uses the
automatic and remote restart feature. This feature uses the WebSphere
MQ-triggered Object Activation Daemon (OAD) to restart the connector after an
abnormal shutdown, or to start a remote connector from System Monitor.

This property must be set to true to enable the automatic and remote restart
feature. For information on how to configure the WebSphere MQ-triggered OAD
feature. see the WebSphere Business Integration Server Express Installation Guide for
Windows, for Linux or for i5/OS.

This property is valid only if the value of the RespositoryDirectory property is set
to <REMOTE> (the value of BrokerType is InterChange Server Express).

The default value is false.

OADMaxNumRetry

The OADMaxNumRetry property specifies the maximum number of times that the
WebSphere MQ-triggered Object Activation Daemon (OAD) automatically attempts
to restart the connector after an abnormal shutdown. The OADAutoRestartAgent
property must be set to true for this property to take effect.

This property is valid only if the value of the RespositoryDirectory property is set
to <REMOTE> (the value of BrokerType is InterChange Server Express).

The default value is 1000.

OADRetryTimelnterval

The OADRetryTimelnterval property specifies the number of minutes in the
retry-time interval for the WebSphere MQ-triggered Object Activation Daemon
(OAD). If the connector agent does not restart within this retry-time interval, the
connector controller asks the OAD to restart the connector agent again. The OAD
repeats this retry process as many times as specified by the OADMaxNumRetry
property. The OADAutoRestartAgent property must be set to true for this
property to take effect.

This property is valid only if the value of the RespositoryDirectory property is set
to <REMOTE> (the value of BrokerType is InterChange Server Express).

The default value is 10.
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PollEndTime

The PollEndTime property specifies the time to stop polling the event queue. The
format is HH: MM, where HH is 0 through 23 hours, and MY represents 0 through 59
minutes.

You must provide a valid value for this property. The default value is HH:MM
without a value, and it must be changed.

If the adapter runtime detects:
e PollStartTime set and PollEndTime not set, or
e PollEndTime set and PollStartTime not set

it will poll using the value configured for the PollFrequency property.

PollFrequency

The PollFrequency property specifies the amount of time (in milliseconds) between
the end of one polling action and the start of the next polling action. This is not
the interval between polling actions. Rather, the logic is as follows:

* DPoll to obtain the number of objects specified by the value of the PollQuantity
property.

* Process these objects. For some connectors, this may be partly done on separate
threads, which execute asynchronously to the next polling action.

* Delay for the interval specified by the PollFrequency property.
* Repeat the cycle.

The following values are valid for this property:
* The number of milliseconds between polling actions (a positive integer).

e The word no, which causes the connector not to poll. Enter the word in
lowercase.

e The word key, which causes the connector to poll only when you type the letter
p in the connector Command Prompt window. Enter the word in lowercase.

The default is 10000.

Important: Some connectors have restrictions on the use of this property. Where
they exist, these restrictions are documented in the chapter on
installing and configuring the adapter.

PollQuantity

The PollQuantity property designates the number of items from the application
that the connector polls for. If the adapter has a connector-specific property for
setting the poll quantity, the value set in the connector-specific property overrides
the standard property value.

This property is valid only if the value of the DeliveryTransport property is JMS,
and the ContainerManagedEvents property has a value.

An e-mail message is also considered an event. The connector actions are as

follows when it is polled for e-mail.

¢ When it is polled once, the connector detects the body of the message, which it
reads as an attachment. Since no data handler was specified for this mime type,
it will then ignore the message.
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* The connector processes the first BO attachment. The data handler is available
for this MIME type, so it sends the business object to Visual Test Connector.

* When it is polled for the second time, the connector processes the second BO
attachment. The data handler is available for this MIME type, so it sends the
business object to Visual Test Connector.

* Once it is accepted, the third BO attachment should be transmitted.

PollStartTime

The PollStartTime property specifies the time to start polling the event queue. The
format is HH:MM, where HH is O through 23 hours, and MY represents 0 through 59
minutes.

You must provide a valid value for this property. The default value is HH:MM
without a value, and it must be changed.

If the adapter runtime detects:
e PollStartTime set and PollEndTime not set, or
¢ PollEndTime set and PollStartTime not set

it will poll using the value configured for the PollFrequency property.

RepositoryDirectory

The RepositoryDirectory property is the location of the repository from which the
connector reads the XML schema documents that store the metadata for business
object definitions.

Because the integration broker is InterChange Server Express, this value must be
set to set to <KREMOTE> because the connector obtains this information from the
InterChange Server Express repository.

RequestQueue

The RequestQueue property specifies the queue that is used by the integration
broker to send business objects to the connector.

This property is valid only if the value of the DeliveryTransport property is JMS.

The default value is <CONNECTORNAME>/REQUESTQUEUE.

ResponseQueue

The ResponseQueue property specifies the J]MS response queue, which delivers a
response message from the connector framework to the integration broker. When
the integration broker is InterChange Server Express, the server sends the request
and waits for a response message in the JMS response queue.

This property is valid only if the value of the DeliveryTransport property is JMS.

The default value is <CONNECTORNAME>/RESPONSEQUEUE.

RestartRetryCount

The RestartRetryCount property specifies the number of times the connector
attempts to restart itself. When this property is used for a connector that is
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connected in parallel, it specifies the number of times the master connector
application-specific component attempts to restart the client connector
application-specific component.

The default value is 3.

RestartRetryinterval

The RestartRetryInterval property specifies the interval in minutes at which the
connector attempts to restart itself. When this property is used for a connector that
is linked in parallel, it specifies the interval at which the master connector
application-specific component attempts to restart the client connector
application-specific component.

Possible values for the property range from 1 through 2147483647.

The default value is 1.

RHF2MessageDomain

The RHF2MessageDomain property allows you to configure the value of the field
domain name in the J]MS header. When data is sent to a WebSphere message
broker over JMS transport, the adapter framework writes JMS header information,
with a domain name and a fixed value of mrm. A configurable domain name lets
you track how the WebSphere message broker processes the message data.

This is an example header:

<mcd><Msd>mrm</Msd><Set>3</Set><Type>
Retek_POPhyDesc</Type><Fmt>CwXML</Fmt></mcd>

This property is not valid if the value of BrokerType is InterChange Server Express.
Also, it is valid only if the value of the DeliveryTransport property is JMS, and the
value of the WireFormat property is CwXML.

Possible values are mrm and xml. The default value is mrm.

SourceQueue

The SourceQueue property designates the JMS source queue for the connector
framework in support of guaranteed event delivery for []MS-enabled connectors

that use a JMS event store. For further information, see [“ContainerManagedEvents”|
i

This property is valid only if the value of DeliveryTransport is JMS, and a value for
ContainerManagedEvents is specified.

The default value is <CONNECTORNAME>/SOURCEQUEUE.

SynchronousRequestQueue

The SynchronousRequestQueue property delivers request messages that require a
synchronous response from the connector framework to the broker. This queue is
necessary only if the connector uses synchronous execution. With synchronous
execution, the connector framework sends a message to the synchronous request
queue and waits for a response from the broker on the synchronous response
queue. The response message sent to the connector has a correlation ID that
matches the ID of the original message.
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This property is valid only if the value of DeliveryTransport is JMS.

The default value is <CONNECTORNAME>/SYNCHRONOUSREQUESTQUEUE

SynchronousRequestTimeout

The SynchronousRequestTimeout property specifies the time in milliseconds that
the connector waits for a response to a synchronous request. If the response is not
received within the specified time, the connector moves the original synchronous
request message (and error message) to the fault queue.

This property is valid only if the value of DeliveryTransport is JMS.

The default value is 0.

SynchronousResponseQueue

The SynchronousResponseQueue property delivers response messages in reply to a
synchronous request from the broker to the connector framework. This queue is
necessary only if the connector uses synchronous execution.

This property is valid only if the value of DeliveryTransport is JMS.

The default is <CONNECTORNAME>/SYNCHRONOUSRESPONSEQUEUE

TivoliMonitorTransactionPerformance

The TivoliMonitorTransactionPerformance property specifies whether IBM Tivoli
Monitoring for Transaction Performance (ITMTP) is invoked at run time.

The default value is false.

WireFormat
The WireFormat property specifies the message format on the transport:

e If the value of the RepositoryDirectory property is a local directory, the value is
CwXML.

* If the value of the RepositoryDirectory property is a remote directory, the value
is CwBO.
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Appendix B. Connector Configurator Express

This appendix describes how to use Connector Configurator Express to set
configuration property values for your adapter.

You use Connector Configurator Express to:

* Create a connector-specific property template for configuring your connector
* Create a configuration file

* Set properties in a configuration file

The topics covered in this appendix are:

+ [“Overview of Connector Configurator Express”]

+ [“Creating a connector-specific property template” on page 105|

* [“Creating a new configuration file” on page 107]

* |“Setting the configuration file properties” on page 110|

Overview of Connector Configurator Express

Connector Configurator Express allows you to configure the connector component
of your adapter for use with the InterChange Server Express integration broker.

You use Connector Configurator Express to:
* Create a connector-specific property template for configuring your connector.

* Create a connector configuration file; you must create one configuration file for
each connector you install.

* Set properties in a configuration file.
You may need to modify the default values that are set for properties in the
connector templates. You must also designate supported business object
definitions and, with InterChange Server Express, maps for use with
collaborations as well as specify messaging, logging and tracing, and data
handler parameters, as required.

Connector configuration properties include both standard configuration properties
(the properties that all connectors have) and connector-specific properties
(properties that are needed by the connector for a specific application or
technology).

Because standard properties are used by all connectors, you do not need to define
those properties from scratch; Connector Configurator Express incorporates them
into your configuration file as soon as you create the file. However, you do need to
set the value of each standard property in Connector Configurator Express.

The range of standard properties may not be the same for all brokers and all
configurations. Some properties are available only if other properties are given a
specific value. The Standard Properties window in Connector Configurator Express
will show the properties available for your particular configuration.

For connector-specific properties, however, you need first to define the properties

and then set their values. You do this by creating a connector-specific property
template for your particular adapter. There may already be a template set up in
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your system, in which case, you simply use that. If not, follow the steps in
[‘Creating a new template” on page 105|to set up a new one.

Running connectors on Linux

Connector Configurator Express runs only in a Windows environment. If you are
running the connector in a Linux environment, use Connector Configurator
Express in Windows to modify the configuration file and then copy the file to your
Linux environment.

Some properties in the Connector Configurator Express use directory paths, which
default to the Windows convention for directory paths. If you use the
configuration file in a Linux environment, revise the directory paths to match the
Linux convention for these paths. Select the target operating system in the toolbar
drop-list so that the correct operating system rules are used for extended
validation.

Starting Connector Configurator Express

You can start and run Connector Configurator Express in either of two modes:
* Independently, in stand-alone mode
* From System Manager

Running Configurator in stand-alone mode

You can run Connector Configurator Express without running System Manager
and work with connector configuration files, irrespective of your broker.

To do so:

* Start>All Programs, click IBM WebSphere Business Integration
Express>Toolset Express>Development>Connector Configurator Express.

* Select File>New>Connector Configuration.

* When you click the pull-down menu next to System Connectivity Integration
Broker, you can select InterChange Server Express.

You may choose to run Connector Configurator Express independently to generate
the file, and then connect to System Manager to save it in a System Manager
project (see [“Completing a configuration file” on page 110})

Running Configurator from System Manager

You can run Connector Configurator Express from System Manager.

To run Connector Configurator Express:
1. Open System Manager.

2. In the System Manager window, expand the Integration Component Libraries
icon and highlight Connectors.

3. From the System Manager menu bar, click Tools>Connector Configurator
Express. The Connector Configurator Express window opens and displays a
New Connector dialog box.

4. When you click the pull-down menu next to System Connectivity Integration
Broker, you can select InterChange Server Express.

To edit an existing configuration file:

104 Adapter for Healthcare Data Protocols User Guide



* In the System Manager window, select any of the configuration files listed in the
Connector folder and right-click on it. Connector Configurator Express opens
and displays the configuration file with the integration broker type and file
name at the top.

* From Connector Configurator Express, select File>Open. Select the name of the

connector configuration file from a project or from the directory in which it is
stored.

¢ Click the Standard Properties tab to see which properties are included in this
configuration file.

Creating a connector-specific property template

To create a configuration file for your connector, you need a connector-specific
property template as well as the system-supplied standard properties.

You can create a brand-new template for the connector-specific properties of your
connector, or you can use an existing connector definition as the template.

* To create a new template, see [“Creating a new template” on page 105

* To use an existing file, simply modify an existing template and save it under the
new name. You can find existing templates in your \ProductDir\bin\Data\App
directory.

Creating a new template

This section describes how you create properties in the template, define general
characteristics and values for those properties, and specify any dependencies
between the properties. Then you save the template and use it as the base for
creating a new connector configuration file.

To create a template in Connector Configurator Express:
1. Click File>New>Connector-Specific Property Template.
2. The Connector-Specific Property Template dialog box appears.

¢ Enter a name for the new template in the Name field below Input a New
Template Name. You will see this name again when you open the dialog box
for creating a new configuration file from a template.

* To see the connector-specific property definitions in any template, select that
template’s name in the Template Name display. A list of the property
definitions contained in that template appears in the Template Preview
display.

3. You can use an existing template whose property definitions are similar to
those required by your connector as a starting point for your template. If you
do not see any template that displays the connector-specific properties used by
your connector, you will need to create one.

* If you are planning to modify an existing template, select the name of the
template from the list in the Template Name table below Select the Existing
Template to Modify: Find Template.

* This table displays the names of all currently available templates. You can
also search for a template.

Specifying general characteristics

When you click Next to select a template, the Properties - Connector-Specific
Property Template dialog box appears. The dialog box has tabs for General
characteristics of the defined properties and for Value restrictions. The General
display has the following fields:
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* General:
Property Type
Property Subtype
Updated Method
Description

* Flags
Standard flags

¢ Custom Flag
Flag

The Property Subtype can be selected when Property Type is a String. It is an
optional value which provides syntax checking when you save the configuration
file. The default is a blank space, and means that the property has not been
subtyped.

After you have made selections for the general characteristics of the property, click
the Value tab.

Specifying values

The Value tab enables you to set the maximum length, the maximum multiple
values, a default value, or a value range for the property. It also allows editable
values. To do so:

1. Click the Value tab. The display panel for Value replaces the display panel for
General.

2. Select the name of the property in the Edit properties display.
3. In the fields for Max Length and Max Multiple Values, enter your values.

To create a new property value:
1. Right-click on the square to the left of the Value column heading.

2. From the pop-up menu, select Add to display the Property Value dialog box.
Depending on the property type, the dialog box allows you to enter either a
value, or both a value and a range.

3. Enter the new property value and click OK. The value appears in the Value
panel on the right.

The Value panel displays a table with three columns:

The Value column shows the value that you entered in the Property Value dialog
box, and any previous values that you created.

The Default Value column allows you to designate any of the values as the
default.

The Value Range shows the range that you entered in the Property Value dialog
box.

After a value has been created and appears in the grid, it can be edited from
within the table display.

To make a change in an existing value in the table, select an entire row by clicking
on the row number. Then right-click in the Value field and click Edit Value.
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Setting dependencies
When you have made your changes to the General and Value tabs, click Next. The
Dependencies - Connector-Specific Property Template dialog box appears.

A dependent property is a property that is included in the template and used in
the configuration file only if the value of another property meets a specific
condition. For example, Pol1Quantity appears in the template only if JMS is the
transport mechanism and DuplicateEventETimination is set to True.

To designate a property as dependent and to set the condition upon which it
depends, do this:

1. In the Available Properties display, select the property that will be made
dependent.

2. In the Select Property field, use the drop-down menu to select the property
that will hold the conditional value.

3. In the Condition Operator field, select one of the following:
== (equal to)
!= (not equal to)
> (greater than)
< (less than)
>= (greater than or equal to)
<=(less than or equal to)

4. In the Conditional Value field, enter the value that is required in order for the
dependent property to be included in the template.

5. With the dependent property highlighted in the Available Properties display,
click an arrow to move it to the Dependent Property display.

6. Click Finish. Connector Configurator Express stores the information you have
entered as an XML document, under \data\app in the \bin directory where you
have installed Connector Configurator Express.

Setting pathnames

Some general rules for setting pathnames are:

¢ The maximum length of a filename in Windows, Linux, and i5/0S is 255
characters.

* In Windows, the absolute pathname must follow the format
[Drive:][Directory]\filename: for example,
C:\IBM\WebSphereServer\Data\Std \StdConnProps.xml
In Linux and i5/0S, the first character should be /.

* Queue names may not have leading or embedded spaces.

Creating a new configuration file

When you create a new configuration file, you must name it and select an
integration broker.

You also select an operating system for extended validation on the file. The toolbar
has a droplist called Target System that allows you to select the target operating
system for extended validation of the properties. The available options are:
Windows, Linux, and i5/0S, Other (if not Windows or Linux), and None-no
extended validation (switches off extended validation). The default on startup is
Windows.

To start Connector Configurator Express:

Appendix B. Connector Configurator Express 107



* In the System Manager window, select Connector Configurator Express from
the Tools menu. Connector Configurator Express opens.

¢ In stand-alone mode, launch Connector Configurator Express.

To set the operating system for extended validation of the configuration file:
* Pull down the Target System: droplist on the menu bar.
* Select the operating system you are running on.

Then select File>New>Connector Configuration. In the New Connector window,
enter the name of the new connector.

You also need to select an integration broker. The broker you select determines the
properties that will appear in the configuration file. To select a broker:

* In the Integration Broker field, select InterChange Server Express.

e Complete the remaining fields in the New Connector window, as described later
in this chapter.

Creating a configuration file from a connector-specific
template

Once a connector-specific template has been created, you can use it to create a
configuration file:

1. Set the operating system for extended validation of the configuration file using
the Target System: droplist on the menu bar (see “Creating a new configuration
file” above).

2. Click File>New>Connector Configuration.
3. The New Connector dialog box appears, with the following fields:
¢ Name
Enter the name of the connector. Names are case-sensitive. The name you

enter must be unique, and must be consistent with the file name for a
connector that is installed on the system.

Note: Connector Configurator Express does not check the spelling of the
name that you enter. You must ensure that the name is correct.

* System Connectivity
Click InterChange Server Express.
* Select Connector-Specific Property Template

Type the name of the template that has been designed for your connector.
The available templates are shown in the Template Name display. When you
select a name in the Template Name display, the Property Template Preview
display shows the connector-specific properties that have been defined in
that template.

Select the template you want to use and click OK.

4. A configuration screen appears for the connector that you are configuring. The
title bar shows the integration broker and connector name. You can fill in all
the field values to complete the definition now, or you can save the file and
complete the fields later.

5. To save the file, click File>Save>To File or File>Save>To Project. To save to a
project, System Manager must be running. If you save as a file, the Save File
Connector dialog box appears. Choose *.cfg as the file type, verify in the File
Name field that the name is spelled correctly and has the correct case, navigate
to the directory where you want to locate the file, and click Save. The status
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display in the message panel of Connector Configurator Express indicates that
the configuration file was successfully created.

Important: The directory path and name that you establish here must match
the connector configuration file path and name that you supply in
the startup file for the connector.

6. To complete the connector definition, enter values in the fields for each of the
tabs of the Connector Configurator Express window, as described later in this
chapter.

Using an existing file

You may have an existing file available in one or more of the following formats:

* A connector definition file.This is a text file that lists properties and applicable
default values for a specific connector. Some connectors include such a file in a
\repository directory in their delivery package (the file typically has the
extension .txt; for example, CN_healthcare.txt for the healthcare connector).

* An InterChange Server Express repository file. Definitions used in a previous
InterChange Server Express implementation of the connector may be available to
you in a repository file that was used in the configuration of that connector.
Such a file typically has the extension .1in or .out.

* A previous configuration file for the connector.
Such a file typically has the extension *.cfg.

Although any of these file sources may contain most or all of the connector-specific
properties for your connector, the connector configuration file will not be complete
until you have opened the file and set properties, as described later in this chapter.

To use an existing file to configure a connector, you must open the file in
Connector Configurator Express, revise the configuration, and then resave the file.

Follow these steps to open a *.txt, *.cfg, or *.in file from a directory:
1. In Connector Configurator Express, click File>Open>From File.

2. In the Open File Connector dialog box, select one of the following file types to
see the available files:

* Configuration (*.cfg)
* InterChange Server Express Repository (*.1in, *.out)

Choose this option if a repository file was used to configure the connector in
an InterChange Server Express environment. A repository file may include

multiple connector definitions, all of which will appear when you open the
file.

 All files (*.¥)
Choose this option if a *.txt file was delivered in the adapter package for
the connector, or if a definition file is available under another extension.

3. In the directory display, navigate to the appropriate connector definition file,
select it, and click Open.

Follow these steps to open a connector configuration from a System Manager

project:

1. Start System Manager. A configuration can be opened from or saved to System
Manager only if System Manager has been started.

2. Start Connector Configurator Express.
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3. Click File>Open>From Project.

Completing a configuration file

When you open a configuration file or a connector from a project, the Connector
Configurator Express window displays the configuration screen, with the current
attributes and values.

The title of the configuration screen displays the integration broker and connector
name as specified in the file. Make sure you have the correct broker. If not, change
the broker value before you configure the connector. To do so:

1.

Under the Standard Properties tab, select the value field for the BrokerType
property. In the drop-down menu, select the value InterChange Server
Express.

The Standard Properties tab will display the connector properties associated
with the selected broker. The table shows Property name, Value, Type, Subtype
(if the Type is a string), Description, and Update Method.

You can save the file now or complete the remaining configuration fields, as
described in [“Specifying supported business object definitions” on page 113|.

When you have finished your configuration, click File>Save>To Project or
File>Save>To File.

If you are saving to file, select *.cfg as the extension, select the correct location
for the file and click Save.

If multiple connector configurations are open, click Save All to File to save all
of the configurations to file, or click Save All to Project to save all connector
configurations to a System Manager project.

Before you created the configuration file, you used the Target System droplist
that allows you to select the target operating system for extended validation of
the properties.

Before it saves the file, Connector Configurator Express checks that values have
been set for all required standard properties. If a required standard property is
missing a value, Connector Configurator Express displays a message that the
validation failed. You must supply a value for the property in order to save the
configuration file.

If you have elected to use the extended validation feature by selecting a value
of Windows, Linux, and i5/0S, or Other from the Target System droplist, the
system will validate the property subtype s well as the type, and it displays a
warning message if the validation fails.

Setting the configuration file properties

When you create and name a new connector configuration file, or when you open
an existing connector configuration file, Connector Configurator Express displays a
configuration screen with tabs for the categories of required configuration values.

Connector Configurator Express requires values for properties in these categories
for connectors running on all brokers:

Standard Properties
Connector-specific Properties
Supported Business Objects

Trace/Log File values
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* Data Handler (applicable for connectors that use J]MS messaging with
guaranteed event delivery)

Note: For connectors that use JMS messaging, an additional category may display,
for configuration of data handlers that convert the data to business objects.

For connectors running on InterChange Server Express, values for these properties
are also required:

* Associated Maps
* Security

Important: Connector Configurator Express accepts property values in either
English or non-English character sets. However, the names of both
standard and connector-specific properties, and the names of supported
business objects, must use the English character set only.

Standard properties differ from connector-specific properties as follows:

* Standard properties of a connector are shared by both the application-specific
component of a connector and its broker component. All connectors have the
same set of standard properties. These properties are described in Appendix A of
each adapter guide. You can change some but not all of these values.

* Application-specific properties apply only to the application-specific component
of a connector, that is, the component that interacts directly with the application.
Each connector has application-specific properties that are unique to its
application. Some of these properties provide default values and some do not;
you can modify some of the default values. The installation and configuration
chapters of each adapter guide describe the application-specific properties and
the recommended values.

The fields for Standard Properties and Connector-Specific Properties are
color-coded to show which are configurable:

+ A field with a grey background indicates a standard property. You can change
the value but cannot change the name or remove the property.

+ A field with a white background indicates an application-specific property. These
properties vary according to the specific needs of the application or connector.
You can change the value and delete these properties.

* Value fields are configurable.

e The Update Method field is displayed for each property. It indicates whether a
component or agent restart is necessary to activate changed values. You cannot
configure this setting.

Setting standard connector properties
To change the value of a standard property:
1. Click in the field whose value you want to set.
2. Either enter a value, or select one from the drop-down menu if it appears.

Note: If the property has a Type of String, it may have a subtype value in the
Subtype column. This subtype is used for extended validation of the
property.

3. After entering all the values for the standard properties, you can do one of the
following:
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* To discard the changes, preserve the original values, and exit Connector
Configurator Express, click File>Exit (or close the window), and click No
when prompted to save changes.

* To enter values for other categories in Connector Configurator Express, select
the tab for the category. The values you enter for Standard Properties (or
any other category) are retained when you move to the next category. When
you close the window, you are prompted to either save or discard the values
that you entered in all the categories as a whole.

» To save the revised values, click File>Exit (or close the window) and click
Yes when prompted to save changes. Alternatively, click Save>To File from
either the File menu or the toolbar.

To get more information on a particular standard property, left-click the entry in
the Description column for that property in the Standard Properties tabbed sheet.
If you have Extended Help installed, an arrow button will appear on the right.
When you click on the button, a Help window will open and display details of the
standard property.

Note: If the hot button does not appear, no Extended Help was found for that
property.

If installed, the Extended Help files are located in
<ProductDir>\bin\Data\Std\Help\ <RegionalSetting>\.

Setting connector-specific configuration properties

For connector-specific configuration properties, you can add or change property

names, configure values, delete a property, and encrypt a property. The default

property length is 255 characters.

1. Right-click in the top left portion of the grid. A pop-up menu bar will appear.
Click Add to add a property. To add a child property, right-click on the parent
row number and click Add child.

2. Enter a value for the property or child property.

Note: If the property has a Type of String, you can select a subtype from the
Subtype droplist. This subtype is used for extended validation of the
property.

3. To encrypt a property, select the Encrypt box.

4. To get more information on a particular property, left-click the entry in the
Description column for that property. If you have Extended Help installed, a
hot button will appear. When you click on the hot button, a Help window will
open and display details of the standard property.

Note: If the hot button does not appear, no Extended Help was found for that
property.
5. Choose to save or discard changes, as described for [“Setting standard connector|
[properties” on page 111

If the Extended Help files are installed and the AdapterHelpName property is
blank, Connector Configurator Express will point to the adapter-specific Extended
Help files located in <ProductDir>\bin\Data\ App\Help\<RegionalSetting>\.
Otherwise, Connector Configurator Express will point to the adapter-specific
Extended Help files located in
<ProductDir>\bin\Data\ App \Help \ <AdapterHelpName>\<RegionalSetting>\. See
the AdapterHelpName property described in the Standard Properties appendix.
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The Update Method displayed for each property indicates whether a component or
agent restart is necessary to activate changed values.

Important: Changing a preset application-specific connector property name may
cause a connector to fail. Certain property names may be needed by
the connector to connect to an application or to run properly.

Encryption for connector properties

Application-specific properties can be encrypted by selecting the Encrypt check
box in the Connector-specific Properties window. To decrypt a value, click to clear
the Encrypt check box, enter the correct value in the Verification dialog box, and
click OK. If the entered value is correct, the value is decrypted and displays.

The adapter user guide for each connector contains a list and description of each
property and its default value.

If a property has multiple values, the Encrypt check box will appear for the first
value of the property. When you select Encrypt, all values of the property will be
encrypted. To decrypt multiple values of a property, click to clear the Encrypt
check box for the first value of the property, and then enter the new value in the
Verification dialog box. If the input value is a match, all multiple values will
decrypt.

Update method
Refer to the descriptions of update methods found in the Standard Properties

appendix, under "Standard connector properties overview'|Appendix A, “Standard]
[configuration properties for connectors,” on page 83

Specifying supported business object definitions

Use the Supported Business Objects tab in Connector Configurator Express to
specify the business objects that the connector will use. You must specify both
generic business objects and application-specific business objects, and you must
specify associations for the maps between the business objects.

Note: Some connectors require that certain business objects be specified as
supported in order to perform event notification or additional configuration
(using meta-objects) with their applications.

InterChange Server Express as your broker

To specify that a business object definition is supported by the connector, or to
change the support settings for an existing business object definition, click the
Supported Business Objects tab and use the following fields.

Business object name: To designate that a business object definition is supported

by the connector, with System Manager running:

1. Click an empty field in the Business Object Name list. A drop list displays,
showing all the business object definitions that exist in the System Manager
project.

2. Click on a business object to add it.

3. Set the Agent Support (described below) for the business object.

4. In the File menu of the Connector Configurator Express window, click Save to
Project. The revised connector definition, including designated support for the
added business object definition, is saved to an ICL (Integration Component
Library) project in System Manager.
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To delete a business object from the supported list:

1. To select a business object field, click the number to the left of the business
object.

2. From the Edit menu of the Connector Configurator Express window, click
Delete Row. The business object is removed from the list display.

3. From the File menu, click Save to Project.

Deleting a business object from the supported list changes the connector definition
and makes the deleted business object unavailable for use in this implementation
of this connector. It does not affect the connector code, nor does it remove the
business object definition itself from System Manager.

Agent support: If a business object has Agent Support, the system will attempt to
use that business object for delivering data to an application via the connector
agent.

Typically, application-specific business objects for a connector are supported by
that connector’s agent, but generic business objects are not.

To indicate that the business object is supported by the connector agent, check the
Agent Support box. The Connector Configurator Express window does not
validate your Agent Support selections.

Maximum transaction level: The maximum transaction level for a connector is
the highest transaction level that the connector supports.

For most connectors, Best Effort is the only possible choice.

You must restart the server for changes in transaction level to take effect.

Associated maps

Each connector supports a list of business object definitions and their associated
maps that are currently active in InterChange Server Express. This list appears
when you select the Associated Maps tab.

The list of business objects contains the application-specific business object which
the agent supports and the corresponding generic object that the controller sends
to the subscribing collaboration. The association of a map determines which map
will be used to transform the application-specific business object to the generic
business object or the generic business object to the application-specific business
object.

If you are using maps that are uniquely defined for specific source and destination
business objects, the maps will already be associated with their appropriate
business objects when you open the display, and you will not need (or be able) to
change them.

If more than one map is available for use by a supported business object, you will
need to explicitly bind the business object with the map that it should use.

The Associated Maps tab displays the following fields:
* Business Object Name

These are the business objects supported by this connector, as designated in the
Supported Business Objects tab. If you designate additional business objects
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under the Supported Business Objects tab, they will be reflected in this list after
you save the changes by choosing Save to Project from the File menu of the
Connector Configurator Express window.

* Associated Maps
The display shows all the maps that have been installed to the system for use
with the supported business objects of the connector. The source business object
for each map is shown to the left of the map name, in the Business Object
Name display.

* Explicit Binding
In some cases, you may need to explicitly bind an associated map.
Explicit binding is required only when more than one map exists for a particular
supported business object. When InterChange Server Express boots, it tries to
automatically bind a map to each supported business object for each connector.
If more than one map takes as its input the same business object, the server
attempts to locate and bind one map that is the superset of the others.
If there is no map that is the superset of the others, the server will not be able to
bind the business object to a single map, and you will need to set the binding
explicitly.
To explicitly bind a map:
1. In the Explicit column, place a check in the check box for the map you want

to bind.

2. Select the map that you intend to associate with the business object.

3. In the File menu of the Connector Configurator Express window, click Save
to Project.

4. Deploy the project to InterChange Server Express.
5. Reboot the server for the changes to take effect.

Security

You can use the Security tab in Connector Configurator Express to set various
privacy levels for a message. You can only use this feature when the
DeliveryTransport property is set to JMS.

By default, Privacy is turned off. Check the Privacy box to enable it.

The Keystore Target System Absolute Pathname is:

* For Windows:
<ProductDir>\connectors\security\<connectorname>.jks

* For Linux and i5/0S:
/ProductDir/connectors/security/<connectorname>. jks

This path and file should be on the system where you plan to start the connector,
that is, the target system.

You can use the Browse button at the right only if the target system is the one
currently running. It is greyed out unless Privacy is enabled and the Target System
in the menu bar is set to Windows.

The Message Privacy Level may be set as follows for the three messages categories
(All Messages, All Administrative Messages, and All Business Object Messages):

“rr,

. : is the default; used when no privacy levels for a message category have
been set.
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* none: Not the same as the default: use this to deliberately set a privacy level of
none for a message category.

* integrity

* privacy

* integrity_plus_privacy

The Key Maintenance feature lets you generate, import and export public keys for
the server and adapter.

* When you select Generate Keys, the Generate Keys dialog box appears with the
defaults for the keytool that will generate the keys.

* The keystore value defaults to the value you entered in Keystore Target System
Absolute Pathname on the Security tab.

* When you select OK, the entries are validated, the key certificate is generated
and the output is sent to the Connector Configurator Express log window.

Before you can import a certificate into the adapter keystore, you must export it
from the server keystore. When you select Export Adapter Public Key, the Export
Adapter Public Key dialog box appears.

* The export certificate defaults to the same value as the keystore, except that the
file extension is <filename>.cer.

When you select Import Server Public Key, the Import Server Public Key dialog
box appears.

e The import certificate defaults to <ProductDir>\bin\ics.cer (if the file exists on
the system).

* The import Certificate Association should be the server name. If a server is
registered, you can select it from the droplist.

The Adapter Access Control feature is enabled only when the value of
DeliveryTransport is IDL. By default, the adapter logs in with the guest identity. If
the Use guest identity box is not checked, the Adapter Identity and Adapter
Password fields are enabled.

Setting trace/log file values

When you open a connector configuration file or a connector definition file,
Connector Configurator Express uses the logging and tracing values of that file as
default values. You can change those values in Connector Configurator Express.

To change the logging and tracing values:
1. Click the Trace/Log Files tab.

2. For either logging or tracing, you can choose to write messages to one or both
of the following:

* To console (STDOUT): Writes logging or tracing messages to the STDOUT
display.

Note: You can only use the STDOUT option from the Trace/Log Files tab for
connectors running on the Windows platform.

* To File: Writes logging or tracing messages to a file that you specify. To
specify the file, click the directory button (ellipsis), navigate to the preferred
location, provide a file name, and click Save. Logging or tracing message are
written to the file and location that you specify.
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Note: Both logging and tracing files are simple text files. You can use the file
extension that you prefer when you set their file names. For tracing
files, however, it is advisable to use the extension .trace rather than
.trc, to avoid confusion with other files that might reside on the
system. For logging files, .1og and .txt are typical file extensions.

Data handlers

The data handlers section is available for configuration only if you have designated
a value of JMS for DeliveryTransport and a value of JMS for
ContainerManagedEvents. Not all adapters make use of data handlers.

See the descriptions under ContainerManagedEvents in Appendix A, Standard
Properties, for values to use for these properties.

Saving your configuration file

When you have finished configuring your connector, save the connector
configuration file. Connector Configurator Express saves the file in the broker
mode that you selected during configuration. The title bar of Connector
Configurator Express always displays the broker mode that InterChange Server
Express is currently using.

The file is saved as an XML document. You can save the XML document in three

ways:

¢ From System Manager, as a file with a *.con extension in an Integration
Component Library, or

¢ In a directory that you specify.

* In stand-alone mode, as a file with a *.cfg extension in a directory folder. By
default, the file is saved to \WebSphereAdapters\bin\Data\App.

For details about using projects in System Manager, and for further information
about deployment, see the System Implementation Guide.

Completing the configuration

After you have created a configuration file for a connector and modified it, make
sure that the connector can locate the configuration file when the connector starts

up.

To do so, open the startup file used for the connector, and verify that the location
and file name used for the connector configuration file match exactly the name you
have given the file and the directory or path where you have placed it.

Using Connector Configurator Express in a globalized environment

Connector Configurator Express is globalized and can handle character conversion
between the configuration file and the integration broker. Connector Configurator
Express uses native encoding. When it writes to the configuration file, it uses
UTE-8 encoding.

Connector Configurator Express supports non-English characters in:
 All value fields
* Log file and trace file path (specified in the Trace/Log files tab)
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The drop list for the CharacterEncoding and Locale standard configuration
properties displays only a subset of supported values. To add other values to the
drop list, you must manually modify the \Data\Std\stdConnProps.xml file in the
product directory.

For example, to add the locale en_GB to the list of values for the Locale property,
open the stdConnProps.xml file and add the line in boldface type below:

<Property name="Locale"

isRequired="true"

updateMethod="component restart">

<ValidType>String</ValidType>
<ValidValues>

<Value>ja_JP</Value>
<Value>ko KR</Value>
<Value>zh_CN</Value>
<Value>zh_TW</Value>
<Value>fr_FR</Value>
<Value>de_DE</Value>
<Value>it_IT</Value>
<Value>es_ES</Value>
<Value>pt_BR</Value>
<Value>en_US</Value>
<Value>en_GB</Value>

<DefaultValue>en_US</DefaultValue>
</ValidValues>
</Property>
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Appendix C. HL7 message structure
+ ["HL7 messages”]

* [“Message construction rules” on page 130

This appendix describes the HL7 healthcare message structure.

HL7 messages

An HL7 message consists of the following data elements.

Message type

An HL7 message type is a unique identifier for the business purpose of a message.
Every message must contain a message type id as way to announce the purpose of
the message. For example, ADT is a unique message ID to Patient Administration.

However, it is rather not a unique classification on the structure of a message. One
message type can have more than one message structure.

The message type is advertised in the message header segment

Message event

The message event, sometimes called a trigger, is a unique identifier to the context
in which message is generated. The message event consists of an upper case letter
and two digits. For example, A01 is for admission/visit notification and A61 is for
changing consulting doctor. Both A01 and A61 are used with ADT messages.

Event type is advertised in the message header segment.

Message structure

The message structure is a data structure used to express an association of a
message type with an event for a class of messages. Each message structure also
contains a unique ID.

It structurally consists of a well-defined list of HL7 segments. Segments can be
optional, and can repeat. There is no limit on how many times a segment can
repeat.

Segments can be aggregated together to form a segment group, which can repeat
as well. In the standard specification, segment group is indicated by {} or [], where
{} signifies repetition and [] signifies optionality.

Because message structure definition allows {} or [] to enclose single segment, it is
possible to interpret the segment group consisting of a single segments. But for
purpose of discussing the data handler and related ISBOs, we reserve the term
segment group to segment aggregation of two or more segments enclosed by {} or

[l

Relative position of segments in a message structure and segment groups is well
defined. At the message structure level, segment is the atomic data type.
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Message structures are defined by both message type and events. One message
type can associate with more than one event, but one event can only associate with
exactly one message type. Furthermore, some events with a given message type
associate with the same message structure. For example message type ADT with
both event A01 and event A04 uses message structure ADT_AQ1

Table 47. Message structure of ADT_A61

ADT*A61"ADT_A61 ADT Message

MSH Message header

EVN Event type

[ PD1 ] Additional demographics

[ {(ROL} ] Roll

[PV2] Patient visit--additional information
Segment

Segment is a well-defined list attributes, each of an HL7 data type. All segments
start with three upper case letter segment IDs. Segment attributes can be optional
and can repeat. The maximum number of how many times an attribute can repeat
is specified. Various tables define the validity of certain attribute values.

Note: The relative position of segment attribute is significant in how it is defined.

Every segment ends with a segment terminator, either the ASCII carriage return or
x0D.

HL7 calls the segment attribute Field. The standard designates a delimiter, whose
value is a defined by the user on per message instances basis, to separate fields.

When the fields repeat, the standard designates a user-defined delimiter, whose
value is defined on per message instance basis, to separate repeating fields.
Delimiters that separate repeating instances of a field are also defined by use, and
call repetition

Table 48. MSH segment specification

SEQ |LEN (DT |OPT |RP# |TBL ITEM |Element Name

1 1 ST R 00001 |Field separator

2 4 ST R 00002 | Encoding character

3 180 |HD |O 0361 00003 | Sending application
4 180 |HD |O 0362 00004 | Sending facility

5 180 |HD |O 0361 00005 | Receiving application
6 180 [(HD |O 0362 00006 | Receiving facility

7 26 TS R 00007 |Date/time of message
8 40 ST (@) 00008 | Security

9 13 CM |R 0076/0003 |00009 |Message type

10 20 ST R 00010 | Message control ID
11 3 PT R 00011 | Processing ID

12 60 VID [R 0104 00012 | Version ID

13 15 NM |O 00013 | Squence number
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Table 48. MSH segment specification (continued)

SEQ |LEN |DT |OPT |RP# |TBL ITEM |Element Name

14 180 |ST (@) 00014 |Continuation pointer

15 2ID |O 0155 00015 | Accept acknowledgement type

16 2 1D (@) 0155 00016 | Application acknowledgement
type

17 3 ID (@) 0399 0017  |Country code

18 16 1D (@) Y 0211 00018 | Character code

19 250 |CE |O 00692 |Principle language of message

20 20 1D (@) 0356 01317 | Alternate character set handling

21 10 ID (@) Y 0449 01598 | Conformance statement ID

Note: In[Table 48 on page 120[Len” stands for maximum length in number of
characters; "DT" stands for data type; "OPT" stands for optionality; "RP#"
stands for the maximum number of time the field can repeat; "TBL#" stands
the id of table, which contains the finite list of legitimate values for
validation; "ITEM#" stands of the unique id of the data element in the whole
standard; "Element Name” stands for brief descriptive name of the field.

The structures of many segments are statically defined and can be shared in many
message structures. There are also some segments that share the same segment ID
but have a different structure -- different attribute in name and data type. QPD,
QED, RCP, QAK belong to this category of segments

Data types

HL7 defines a long list of data types. Some are as defined as a primitive type,
while others are defined as a complex type, A complex datatype consists of more
than one attribute of teh primitive type. HL7 calls the attributes of a complex data
type acomponent

For example, the following HD data type uses three components, namespace 1D,
universal ID, and universal ID type.

<namespace ID (IS)>"<universal ID (ST)>"
<universal ID type )ID)>

The standard designates a delimiter, whose value is defined by the user on per
message instances basis, to separate components.

Other complex data type can further define a component of a given data type. HL7
calls the attribute of this complex data type subcomponent. The complex data type

must have all attributes be of primitive type.

The standard also designates a delimiter to separate subcomponents whose value
is defined by the user on per message instances basis.

The component delimiter of the data type that defines a component is then
demoted to subcomponent delimiter.

HL7 also designates an escape character for escapting characters that are identical
to various delimiters. These are defined by the user on per message instance basis.
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Most data types are well are statically specified as distinct data structures in the
standard. A few data types, notably the CM and * data type, exhibit dynamic
behavior, and warrant special attention.

Custom made data types

CM is also called a Composite data type. This data type is a custom construction
using previously defined data types for each unique situation, in a different
segment, or at different field of the same segment. There are number of data
structures associated with the CM data type.

The data structures for the CM types, which can differ widely from one another,
are solidified at time when segments they belong to are defined. The CM data type
is known at design time.

In earlier versions of the HL7 standard, CM is meant to be custom-made data type,
data type defined on local site of deployment. For this reason, CM data type
represents endless number of structures with different combination and
permutation of readily defined data types.

Version 2.4 of HL7 only has finite number of data structures that is labeled with
CM data type.

Polymorphic data type
This is the data type that is marked with * symbol or with "varies” data type label,
instead of the usual two or three capital letters.

This data type exhibits a common behavior that it can be any one of the already
defined data type and the data type is declare in some other place. For example,
OBX-2 declares the data type of OBX-5, which is actual data carrier of this
polymorphic data type. For ease of discussion, lets call the field that announce the
data type of polymorphic data type data Data Type Announcer, and call the field
that contains the actual data of the polymorphic data type Data Carrier.

The data type announcer and data carrier can coexist in the same segment; they
can also exist on different segments. For example, OBX segment has OBX-2 field
being the data type announcer and OBX-5 field being the data carrier. RDF
segment contains a field of RCD data type, of which each instance of the RCD field
acts as a data announcer for data carrier in the RDT segment. The relationship of
the RDF and RDT segment is in analogues to relationship database’s table
description metadata and rows of actual data.

In the case of both data type announcer and data carrier residing in the same
segment, the relative position of the announcer field and the data carrier field can
also vary. Data type announcer can precede data carrier, or the other way around.
Section 8.5.2.4, chapter 8, contains example that data type announcer MFE-5 trails
behind the data carrier MFE-4.

There is no fixed number of fields that sets data type announcer and data carrier
apart. Their relationship is shown in the following diagram.
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1 Data Type Announcer T Data Carrier

Figure 4. Data carrier and data type announcer relationship in polymorphic data type where
".... represents other fields in the segment.

The range of the variant data type is known and finite, even though it is
polymorphic.

Delimiter and enhaced data model

The delimiters for segment, field, component, and subcomponent are all
user-defined Delimiters are announced in the message header for each individual
message.

A segment delimiter is defined as an ASCII carriage return or X0A. When data
containing the characters identical to these delimiters, an escape sequence is used
to mark the character.

Component delimiters can be demoted to subcomponent delimiters when a data
type is used on anther data type’s components. The use of repetition delimiters in
most data elements is contextual depending the nature of its data elements, with
certain excpetions.

The repetition delimiter is used between repeating instances of data type element
segment fields. The common character used is "~". Components of data type
element are generally not expected to repeat, except for MA, NA, and QIP data

types.

NA is defined as component:

<valuel> ™ <value2> © <value3> ~ <value4> "~ ...

The data type of each of its component is NM. It is used to express an array of
numbers. The "..." signifies that NA can in theory contain infinitely many values.
So it represents a repetition of fields, and the repetition delimiter is the field
delimiter. It is illustrated in the following example

OBX | 3| NA| 58WAVAN99SVL| 1| 071724374757 6"7 8 T "6"5 43 2 110" -1~ -2~ -3 4" -5 -

Figure 5. The area in bold is an example of how NA is used in the OBX segment.

6-77-8||||||F|...<cr>

MA is defined as component:

<sample 1 from channel 1 (NM)> ~ <sample 1 from channel 2
(NM)> ~ <sample 1 from channel 3 (NM)> ...%<sample 2 from channel 1
(NM)> ~ <sample 2 from channel 2 (NM)> ~ <sample 2 from channel 3
(NM)> ...~ ...

The pattern in the structure is that a group of clustered components delineated by

component delimiter "A" repeats and the repetition is delineated by the segment
repetition delimiter "~".
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This definition example shows three channels per component cluster, with six
channels per component cluster. It is possible to have than more components,
depending on the implementation requirements.

Figure 6. The area in bold is an example of how MA is used in the OBX segment

0BX | 3| NA|5&WAVAN99SVL| 1|0717243747576"7 78 76”5 432 110 -1"-2-3"-4" -5~
6°-77-8~0"1"2"3 4 576 T 8 T 65 43 2N 1NN -1 -2 8 -3 -4 -5 - 6N -7 -
870717 273M4N5N67 T8N T N6 5NAN 3NN 1NN 11020 -3 -4 -5 -67-7-8 | | | | | | F] . . .<cr>

Unlike NA, the size of the component cluster is finite.

QIP is defined as component:<segment field name (ST) > ~ <valuel (ST) &
value2 (ST) & value3 (ST) ...>

The definition of this data type has two components, the first being a conventional
component, and the second having infinitely repeatable subcomponents.

Figure 7. The areas in bold are the repeating subcomponents of QIP

|@PID.5. 1~ EVANS&Param2&Param3 |

As show, there are three kinds of repetitions in data type elements. NA has
repeatable component; QIP has repeatable subcomponents; and MA has repeatable
custom defined component clusters. Each of these repetitions uses different
delimiters.

Assuming component can repeat with component delimiter, applying the
component delimiter demotion rule to the component repetition results in
reclassification of these repetitions; the subcomponent repetition can be further
considered as in the same category as component repetition.

In order to arrive to a unified data model of HL7 data elements, some expansion
has to be made to the traditional HL7 data mode. The enhanced data model allows
the repetition of component, where the older data model does not.

The enhanced model permits an addition data element called the component
cluster to the data type element. Furthermore both component and component

cluster data element are allowed to repeat.

The following diagram depeicts the hierarchy of the data element in this enhanced
data model.
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Message

Segment group

Segment

Data type

Compnent cluster

Component

Subcomponent

Figure 8. Data element hierarchy in the enhanced data model

The following table summarizes the delimiter for each data element.

Table 49. Delimiters for each data element

Data element in
ehanced data
model Repeatability Delimters Description
Data type Yes Segment field Segment field delimiter
delimiter delineates repeating instances of
(commonly ~ ) the data type element
Component Yes Segment field Segment field delimiter
Cluster delimiter delineates repeating instances of
(commonly ~) the data type element. Data
type, which contains the
component cluster, must not be
repeatable.
Component Yes Component Component delimiter delineates
delimiter repeating instances of the data
(commonly *) type element.
Subcomponent | Yes Subcomponent Subcomponent delimiter
delimiter delineates repeating instances of
(commonly &) the data type element.

Internationalization
HL& allows messages to be encoded using various characters adn encoding, on a
per message basis.

The following table details the supported character sets.
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Table 50. List of character set identifiers and cannonical names used in the adapter.

Corresponding Canonical
HL7 Character Name Supported by
Set Description BIA_Healthcare Adapter

ASCII The printable 7-bit ASCII character (Regular ASCII7)
set. (This is the default if this field is
omitted)

8859/1 The printable characters from the 1S0O8859_1
IDO 8859/1 character set.

8859/ The printable characters from the 1SO8859_2
IDO 8859/2 character set.

8859/3 The printable characters from the 1SO8859_3
IDO 8859/3 character set.

8859/4 The printable characters from the 1SO8859_4
IDO 8859/4 character set.

8859/5 The printable characters from the 1SO8859_5
IDO 8859/5 character set.

8859/6 The printable characters from the 1SO8859_6
IDO 8859/6 character set.

8859/7 The printable characters from the 1SO8859_7
IDO 8859/7 character set.

8859/8 The printable characters from the 1SO8859_8
IDO 8859/8 character set.

8859/9 The printable characters from the 1SO8859_9
IDO 8859/9 character set.

ISO IR14 Code for Information Exchange (one |JIS0201
byte)(JIS X 0201-1976). Note that the
code contains a space, i.e. "ISO IR14".

ISO IR87 Code for the Japanese graphic J1S0208
character set for information
exchange (JIS X 0208 1990)

ISO IR159 Code for the supplementary Japanese |]JISO212
graphic character set for information
exchange (JIS X 0212 1990).

UNICODE The world wide character standard UTF-8 (same as IDO1010646
from ISO/IEC 10646-1-1993

ISO-IR xxxx Other character sets naming
convention layed out in ISO 2375.
This is just a different representation
of th esame character set id listed
ablve.

HL7 defines the default character set as a single byte character set which should
always have ISO IR6 (ISO 646) or ISO IR14 (JIS X 0201 1976) in the GO area.

Escape sequence for multi-character set data

A message can be encoded using more than one character set and encoding
scheme. An escape sequence is used to flag a switch to a different character set, as
well as the return to the default character set. The following example shows the
data pattern when using escape sequence for data encoded in alternate character
set.
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<Escape sequence>
<encoded data using alternate character set>

Returning from the alternate character set to the default character set uses the
same technique using the escape set of the default character set.

<Escape sequence>
<encoded data using alternate character set> <Default escape sequence>

ISO 2002-1994 defines the technique on how the escape sequence is structured. by
the ISO 2002-1994 standard, the escape sequence is a sequence of bit patterns is
used to identify a character set. ISO 2002-1994 uses the decimal xx/yy notation
when expressing the escape sequences. This document expresses the bit sequence
of escape sequence in a sequence of bytes using hexadecimal notation. The
following quote is from the HL7 standard specification, describing where and
when to use the escape sequence.

Each repetition of a PN, XPN, XON, XCN, or XAD field is assumed to begin with the
default character set. If another character set is to be used, the HL7 defined
escape sequence used to announce that character set must be at the beginning of the
repetition, and the HL7 defined escape sequence used to start the default character
set must be at the end of the repetition. Note also that several character sets may
be intermixed within a single repetition as long as the repetition ends with a
return to the default character set.”

Modes of escape sequence for the multi-character set
HL7 provides two modes of specifying and handling escpae sequences:

* ISO 2002-1994 standard
* 2.3 (Described in HL7 v. 2.3

Both modes employ the sam ISO 2002-1994 technique for specifying the escape
sequence. They differ in how the escape character is represented in the escape
sequence.

ISO 2002 mode escape sequences

This mode uses ASCII escpae characters instead of the HL7 defined escape instead
of the previously mentioned characters. The following table provides the list of
escape sequences for character sets supported by HL?7.

Table 51.

Escape sequence |Character set used in HL7

ESC 2842 ISO-IR6 GO or ASCII (ISO 646 : ASCII))
ESC 2D41 ISO-IR100 (ISO 8859 : Latin Alphabet 1)
ESC 2D42 ISO-IR101 (ISO 8859 : Latin Alphabet 2)
ESC 2D43 ISO-IR109 (ISO 8859 : Latin Alphabet 3)
ESC 2D44 ISO-IR110 (ISO 8859 : Latin Alphabet 4))
ESC 2D4C ISO-IR144 or 8859/5 (ISO 8859: Cyrillic))
ESC 2D47 ISO-IR127 or 8859/6 (ISO 8859 : Arabic)
ESC 2D46 ISO-IR126 or 8859/7 (ISO 8859 : Greek)
ESC 2D48 ISO-IR138 or 8859/8 (ISO 8859 : Hebrew)
ESC 2D4D ISO-IR148 or 8859/9 (ISO 8859 : Latin Alphabet 5)
ESC 284A ISO-IR14 (JIS X 0201 -1976: Romaji)
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Table 51. (continued)

Escape sequence | Character set used in HL7

ESC 2949 ISO-IR13 (JIS X 0201 : Katakana)

ESC 2442 ISO-IR87 (JIS X 0208 : Kanji, hiragana and katakana)
ESC 242844 ISO-IR159 (JIS X 0212 : Supplementary Kanji)

Escape sequence in HL7 define mode

When another character set is to be used, the HL7 defined escape sequence must
be used at the beginning of the repetition, and the HL7 defined escape sequence
used to start the default character set must be at the end of the repetition.

The escape sequence consists of the escape character followed by an escape code
ID of one character, zero, or more data characters, and another occurrence of the
escape character where the escape character is defined by the user in the message.

The following table lists the escape sequence for each character set using "\" as the
HL7 defined escape character.

Table 52. List of escape sequences for HL7-supported character sets

Escape sequence Character set used in HL7

\C2842\ ISO-IR6 GO or ASCII (ISO 646 : ASCII))

\C2D41\ ISO-IR100 (ISO 8859 : Latin Alphabet 1)

\C2D42\ ISO-IR101 (ISO 8859 : Latin Alphabet 2)

\C2D43\ ISO-IR109 (ISO 8859 : Latin Alphabet 3)

\C2D44\ ISO-IR110 (ISO 8859 : Latin Alphabet 4))
\C2D4C\ ISO-IR144 or 8859/5 (ISO 8859: Cyrillic))
\C2D47\ ISO-IR127 or 8859/6 (ISO 8859 : Arabic)

\C2D46\ ISO-IR126 or 8859/7 (ISO 8859 : Greek)

\C2D48\ ISO-IR138 or 8859/8 (ISO 8859 : Hebrew)
\C2D4D\ ISO-IR148 or 8859/9 (ISO 8859 : Latin Alphabet 5)
\C284A\ ISO-IR14 (JIS X 0201 -1976: Romaji)

\C2949\ ISO-IR13 (JIS X 0201 : Katakana)

\M2442\ ISO-IR87 (JIS X 0208 : Kanji, hiragana and katakana)
\M242844\ ISO-IR159 (JIS X 0212 : Supplementary Kanji)

Hexadecimal escape sequences and local sequence

HL7 permits the transmission of binary data encoded in the form of \Xdddd. ..\,
where the dddd denotes s a pair of binary value represented using ASCII character
1-9 and A-F. This is the hexadecimal escape sequence.

Alternatively, up on mutual agreements between parties engaged in the HL7
communication, users can also encode their data using a custom escape sequence,
which has the form of \Zdddd. ..\, where the dddd are valid characters permitted in
TX data type.

Other encoding schemes

Beside character set encoding, there are still other encoding schemes used in the
HL7 message standard.
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Sometimes, messages make reference to data in other systems. HL7 provides the
user the ability to access that data in two ways, by reference and by value. When
passing data by reference, it uses the Reference Pointer (RP) data type for the
receiving system to track the referenced data, but without physically transferring
the data across the wire to the receiving system.

When it is necessary for the receiving system to obtain an actual copy of the data,
the data then needs transferred to the receiving system. Many times this data from
a third-party application and does not follow the HL7 message construction roles.
A special encoding scheme is required to fit for this kind of data into an HL7
message.

There are two ways to encode these special kinds of data: Hex and Base64.

* Hex encoding uses consecutive pairs of hexadecimal digits to represent
consecutive single octets of binary data

* Base64 encoding follows the MIME standard RFC 1521. This method uses four
consecutive ASCII characters to represent three consecutive octets of binary data
by way of direct value to character substitution

The following table is an exact copy of HL7 Table 0290 for the value to ASCII

lookup.

Table 53. HL7 table 0290 for the binary to ASCII value in base 64 MIME encoding scheme
Value Code Value Code Value Code Value Code
3 D 20 U 37 1 54 542
4 E 21 A% 38 m 55 553
5 F 22 W 39 n 56 56 4
6 G 23 X 40 0 57 575
7 H 24 Y 41 P 58 58 6
8 I 25 V4 42 q 59 597
9 J 26 a 43 r 60 60 8
10 K 27 b 44 s 61 619
1 L 28 C 45 t 62 62 +
12 M 29 d 46 u 63 63 /
13 N 30 e 47 \%

14 (@) 31 f 48 w (pad) =

15 P 32 g 49 X

16 Q 33 h 50 y

Presentation data

HL7 also allows the exchange of Formatted Text (FT) data intended for the
purpose of display rendering. It is often used in the transmission of reports legible
to human, rather than machine.

The presentation data contains embedded presentation instructions. Like HTML,
there is a group of predefined tags that serve as instruction to the receiving HL7
application on how to render the data. Although the presentation instructions are
well defined, the location at where the presentation instructions are embedded in
the FT string is completely driven by the design of reports and hence unknown
ahead of time.
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Message construction rules

Construct the segments in the order defined for the message. Each message is
contructed as follows:
1. The first three characters are the segment ID code
2. Each data field in the sequence is inserted in the segment in the following
manner:
a. A field separator is placed in the segment

b. If the value is not present, no further characters are required

nn

c. If the value is present, but null, the characters
quotation marks) are placed in the field

(two consecutive double

d. Otherwise, place the characters of the value in the segment. As many
characters can be included as the maximum defined for the data field. It is
not necessary, and is undesirable, to pad fields to fixed lengths. Padding to
fixed lengths is permitted

e. If the field definition calls for a field to be broken into components, the
following rules are used

1) If more than one component is included, htey are separated by the
component separator

2) Components that are present but null are represented by the characters

nmn

3) Components that are not present are treated by including no characters
in the component

4) Components that are not present at the end of a component need not be
represented by component separators. For example, the two data
components are equivalent:

| ABCADEF™| and |ABCDEF|
f. If the component definition calls for a subcomponent to be broken into
subcomponents, the following rules are used:

1) If more than one subcomponent is included, htey are separated by the
component separator

2) Subcomponents that are present but null are represented by the
characters "”

3) Subcomponents that are not present are treated by including no
characters in the component

4) Subcomponents that are not present at the end of a component need not
be represented by component separators. For example, the two data
components are equivalent:

AXXX&YYY&&™ and ~XXX&YYY~

g. If the field definition permits repetition of a field, the repetition separator is
used only if more than one occurrence is transmitted. In such a case, the
repetition separator is placed between occurrences. If three occurrences are
transmitted, two repetition separators are used.)

In the example below, two occurrences of telephone number are being sent:

|234-7120~599-1288B1234

Repeat Step 1b while there are any fields present to be sent. If all the data
fields remaining in the segment definitino are not present, there are no
requirements to include any more delimiters.

The following rules apply to receiving HL7 messages and converting their contents
to data values:
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Ignore segments, fields, components, subcomponents, and extra repetitions of a
field that are present but were not expected

Treat segments that were expected but are not present as consisting entirely of
fields that are not present

Treat fields and components that are expected but were not included in a
segment as not present
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Appendix D. Business object minimal extractor utility

The business object minimal extractor utility is a java-based batch tool that can be
used to extract a subset of business object definitions from a master file of
industry-specific business objects. It offers an alternative to using BO Designer. The
utility works only with name/value pair text files, and it can be run in any of the
following ways:

* To extract individual business object definitions. The utility may be run serially
against a master file so that after several runs, a small collection of business
object definitions has been extracted. Child objects are extracted each time they
are included within a parent object’s definition, which means that the same child
object definition may be extracted multiple times. This option is invoked by
using the -b argument.

* To extract a list of business objects defined in an identified input file. Used in
this way, the utility can extract a small collection of business object definitions
from one run. If multiple parent objects share the same child objects, the utility
will reduce the child object definitions to just one instance, thus reducing
redundancy. This option is invoked by using the -f argument.

If the utilty is run using the -f argument against the output of multiple runs that
used the -b argument, multiple copies of a child object definition will be reduced
to just one instance.

* To extract a minimal definition of a business object where dependancies of the
BO are defined across multiple input files. This option is invoked by using the -c
argument.

Example invocation

The following example shows invocation syntax and descriptions of valid
parameters.

java com.ibm.crossworlds.BusObjMinimalExtractor [-h]

[-i <InputBusObjFileName>] [-b <TargetBusObject>]

[-0 <BusObjectOutputFileName>]

[-d] [-w <OutputSortedFileName>] [-r <InputSortedFileName>]
[-f <BusObjListFile>] [-c <BusObjDefFileListFile>]

Table 54. Description of elements in sample invocation

Parameters Description

[-h] Output the invocation syntax

[-i <InputBusObjFileName>] Specifies the .in file that contains the
business object definition to be extracted

[-b <TargetBusObject>] Specifies the business object for which you
want to extract a definition

[-0 <BusObjectOutputFileName>] Specifies the .in file to which the extracted

definition should be written

[-d] An optional boolean parameter used to
indicate that child objects should be listed
before their parents. When not used, parent
objects are listed first.
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Table 54. Description of elements in sample invocation (continued)

Parameters

Description

[-w <OutputSortedFileName>]

Specifies the name of a topologically sorted
file to be created from the
<InputBusObjFileName> .in file that
contains the business object definitions to be
extracted.

[-r <InputSortedFileName>]

Specifies the name of a topologically sorted
file from which business object definitions
will be extracted.

[-f <BusObjListFile>]

A file that contains a list of business objects
for which definitions will be extracted. Each
business object name should be written on a
separate line.

[-c <BusObjDefFileListFile>]

Specifies the name of a file that contains a
list of files from which a BO definition will
be extracted.
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Appendix E. Notices

This information was developed for products and services offered in the U.S.A.
IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service. IBM may have patents or
pending patent applications covering subject matter described in this document.
The furnishing of this document does not grant you any license to these patents.
You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law: INTERNATIONAL
BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS”
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE. Some states do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you. This
information could include technical inaccuracies or typographical errors. Changes
are periodically made to the information herein; these changes will be incorporated
in new editions of the publication. IBM may make improvements and/or changes
in the product(s) and/or the program(s) described in this publication at any time
without notice. Any references in this information to non-IBM Web sites are
provided for convenience only and do not in any manner serve as an endorsement
of those Web sites. The materials at those Web sites are not part of the materials for
this IBM product and use of those Web sites is at your own risk. IBM may use or
distribute any of the information you supply in any way it believes appropriate
without incurring any obligation to you.Licensees of this program who wish to
have information about it for the purpose of enabling: (i) the exchange of
information between independently created programs and other programs
(including this one) and (ii) the mutual use of the information which has been
exchanged, should contact:
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IBM Corporation

577 Airport Blvd., Suite 800
Burlingame, CA 94010
Us.A

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee. The licensed program described in this
document and all licensed material available for it are provided by IBM under
terms of the IBM Customer Agreement, IBM International Program License
Agreement or any equivalent agreement between us. Any performance data
contained herein was determined in a controlled environment. Therefore, the
results obtained in other operating environments may vary significantly. Some
measurements may have been made on development-level systems and there is no
guarantee that these measurements will be the same on generally available
systems. Furthermore, some measurements may have been estimated through
extrapolation. Actual results may vary. Users of this document should verify the
applicable data for their specific environment. Information concerning non-IBM
products was obtained from the suppliers of those products, their published
announcements or other publicly available sources. IBM has not tested those
products and cannot confirm the accuracy of performance, compatibility or any
other claims related to non-IBM products. Questions on the capabilities of non-IBM
products should be addressed to the suppliers of those products. All statements
regarding IBM’s future direction or intent are subject to change or withdrawal
without notice, and represent goals and objectives only. This information contains
examples of data and reports used in daily business operations. To illustrate them
as completely as possible, the examples include the names of individuals,
companies, brands, and products. All of these names are fictitious and any
similarity to the names and addresses used by an actual business enterprise is
entirely coincidental. COPYRIGHT LICENSE: This information contains sample
application programs in source language, which illustrate programming techniques
on various operating platforms. You may copy, modify, and distribute these sample
programs in any form without payment to IBM, for the purposes of developing,
using, marketing or distributing application programs conforming to the
application programming interface for the operating platform for which the sample
programs are written. These examples have not been thoroughly tested under all
conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or
function of these programs. If you are viewing this information softcopy, the
photographs and color illustrations may not appear.

Programming interface information

Programming interface information, if provided, is intended to help you create
application software using this program. General-use programming interfaces
allow you to write application software that obtain the services of this program’s
tools. However, this information may also contain diagnosis, modification, and
tuning information. Diagnosis, modification and tuning information is provided to
help you debug your application software.

Warning: Do not use this diagnosis, modification, and tuning information as a
programming interface because it is subject to change.
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Trademarks and service marks

The following terms are trademarks or registered trademarks of International
Business Machines Corporation in the United States or other countries, or both:
i5/0S

IBM

the IBM logo

AIX

CICS

CrossWorlds

DB2

DB2 Universal Database

Domino

IMS

Informix

iSeries

Lotus

Lotus Notes

MQIntegrator

MQSeries

MVS

0S/400

Passport Advantage

SupportPac

WebSphere

z/0S

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both. MMX,
Pentium, and ProShare are trademarks or registered trademarks of Intel
Corporation in the United States, other countries, or both. Java and all Java-based
trademarks are trademarks of Sun Microsystems, Inc. in the United States, other
countries, or both. Linux is a trademark of Linus Torvalds in the United States,
other countries, or both. Other company, product or service names may be
trademarks or service marks of others.

WebSphere Business Integration Server Express and Express Plus include software
developed by the Eclipse Project (http://www.eclipse.org/).

e
JAVA,

WebSphere Business Integration Server Express, Version 4.4, and WebSphere
Business Integration Server Express Plus, Version 4.4
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